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ΠΕΡΙΛΗΨΗ
Στην  εργασία αυτή έγινε προσπάθεια να παραχθεί εκπαιδευτικό υλικό με  το σκεπτικό της
δημιουργίας ενός οδηγού  αναφοράς  που θα βοηθήσει  όποιον θελήσει να δημιουργήσει αρχεία
προσβάσιμα  στους μαθητές με  αναπηρίες. 
Το κείμενο της εργασίας εστιάστηκε  στις δυνατότητες των προγραμμάτων  MsWord  
MsPowerpoint  μέσω των αρχείων που δημιουργούν  και των εργαλείων που προσφέρουν. Έγινε
αναφορά στις πρόσφατες και στις προγενέστερες εκδόσεις  τους. Ασχοληθήκαμε και με  τις
εκδόσεις του Acrobat Professional  και  Acrobat  Χ που δημιουργούν αρχεία PDF με  δυνατότητες
μεταφερσιμότητας  από τα αρχεία των MsWord  και  MsPowerpoint. Δεν παραλείψαμε  να
αναφερθούμε και στον τρόπο δημιουργίας προσβάσιμων HTML αρχείων - διαφανειών. 
Επιπλέον  γίνεται αναλυτική αναφορά  σε  θέματα όπως  στις Ετικέτες δόμησης , στο εργαλείο
Φτιαξίματος Σειράς Ανάγνωσης , στη μετατροπή σαρωμένου κειμένου σε PDF, στο Γρήγορο και
Πλήρη Έλεγχο ,στο Συνθέτη Φωνής,  στην Οπτική διάταξη περιεχομένου, στο Εναλλακτικό κείμενο
των εικόνων και πινάκων , στα κουμπιά Δράσης και Πλοήγησης , στα Ευρετήρια , στις Λίστες , στα
αρχεία Βίντεο και Ήχου που δημιουργούν ένα περιβάλλον πολυμέσων και στις Υπερσυνδέσεις.
Αναφορές γίνονται και στους χρήστες των Mac όπου είναι δυνατόν. 
Για όλα αυτά υπάρχουν εικόνες με τα μενού των προγραμμάτων που αναφέραμε  δίνοντας
αναλυτικές οδηγίες χρήσης και πίνακες σύγκρισης των προγραμμάτων για τη σωστή επιλογή.

ΘΕΜΑΤΙΚΗ ΠΕΡΙΟΧΗ: Παραγωγή Προσβάσιμου Εκπαιδευτικού Υλικού για Μαθητές με Αναπηρία

ΛΕΞΕΙΣ ΚΛΕΙΔΙΑ: Ετικέτες, Οπτική Διάταξη περιεχομένου, Συνθέτης φωνής, Κουμπιά Δράσης,
Ε υ ρ ε τ ή ρ ι α
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ABSTRACT

In this paper we made an attempt to produce educational stuff on the basis of creating a
reference guide to help anyone who wants to create files accessible to students with
disabilities.
Our work is focused on the programs of MsWord and MsPowerpoint due to the files they can
create and the  tools they offer. We referred also to the previous and the recent versions. We
dealt with the versions of Acrobat  Professional and Acrobat X create PDF files with features
portability of MsWord and MsPowerpoint. It omitted to mention on how to create accessible
HTML files – slides.
Furthermore, a detailed report on issues such as Tags, Touchup Reading, Order, Conversion
scanned text to PDF, Full and Quick Check, Read out, Loud, Reflow, Alternative text to images
and Tables, Actions Buttons and Navigation, Indexes, Lists, Video and Sound files in
Multimedia Environment and Hyperlinks.We referred also to the Mac users too, where possible.

For all these application we provided a large amount of pictures and menus of those programs
and we give detailed instructions and comparing tables for a appropriate choice.
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1 Γνωρίζοντας  τις δυνατότητες προσβασιμότητας των εκδόσεων του
MS Word                                    

1.1 Εισαγωγή        
Το Ms Word της Microsoft  είναι σήμερα ο πιο γνωστός επεξεργαστής  κειμένου στην αγορά και αυτό
γιατί η κατάληξη . doc και λιγότερο  η  Docx έχει γίνει η «στάνταρ» μορφή των εγγράφων κειμένου .
Αρκετές φορές  το  Ms Word χρησιμοποιείται για τη δημιουργία εγγράφων  που καταλήγουν σε
αρχεία των  μορφών  PDF και HTML. Αυτή η παράγραφος  θα καλύψει αρκετά πράγματα που
μπορείτε να κάνετε για να γίνει το περιεχόμενο των ιστοσελίδων σας  πιο προσιτό εφόσον έχει
γραφτεί με τον επεξεργαστή κειμένου του  Ms Word.

1.2 Δημιουργία  εγγράφων Ms Word με προσβασιμότητα  

1.2.1 Επικεφαλίδες        

Στα περισσότερα έγγραφα του Ms Word το πιο σημαντικό θέμα για τη προσβασιμότητα είναι η καλή
δομή των επικεφαλίδων (heading structure). Για τους χρήστες που χρησιμοποιούν αναγνώστες
οθόνης  (screen reader) οι επικεφαλίδες θα τους επιτρέψουν να περιηγηθούν τη σελίδα ενός
εγγράφου εύκολα κάνοντας την  εύχρηστη. Πολλοί δεν χρησιμοποιούν τα σταθερά στυλ (true styles)
μορφοποίησης του Ms Word. Για παράδειγμα, όταν δημιουργούν μια επικεφαλίδα, αλλάζουν τον τύπο
της γραμματοσειράς, αυξάνουν το μέγεθος, την  κάνουν με έντονη γραφή (bold)  κ.λ.π. Έτσι το
έγγραφο χάνει  την πραγματική του δομή και γίνεται δυσδιάκριτο από το λογισμικό του αναγνώστη
οθόνης. Ο σωστός τρόπος για τη δημιουργία μιας δομής είναι να χρησιμοποιείτε τα στυλ
μορφοποίησης του Ms Word. Σ’ αυτή την  ενότητα θα  δούμε πως  προσθέτουμε και
επεξεργαζόμαστε τις επικεφαλίδες σε όλες τις γνωστές εκδόσεις του Ms Word. Μπορείτε να

προσθέσετε επικεφαλίδες 1ου , 2ου  ή 3ου  επίπεδου, χρησιμοποιώντας τον συνδυασμό των
πλήκτρων Ctrl + Alt + 1, 2  ή 3  αντίστοιχα (για το Mac  Cmd + Option).
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MS WORD 2000-2003

Οι πτυσσόμενες (drop-down) λίστες των στυλ μορφοποίησης σας επιτρέπουν να δημιουργήσετε
επικεφαλίδες σταθερού στυλ (true style)  καθώς και να  εφαρμόσετε  το στυλ που έχετε δημιουργήσει
προηγούμενα. 

Εικόνα 1. Πτυσσόμενη λίστα των Στυλ μορφοποίησης Ms Word 2000-2003
Υπάρχουν πλεονεκτήματα στα έγγραφα του Ms Word όταν χρησιμοποιούνται σταθερές δομές.
Πρώτον, το αρχείο διατηρεί τη δομή όταν εξάγεται σε μορφή HTML και έχει προσβασιμότητα από το
λογισμικό του αναγνώστη οθόνης. Η δομή του διατηρείται  και κατά την εξαγωγή σε PDF. Και στις
δύο περιπτώσεις, αυξάνεται η αναγνωσιμότητα του εγγράφου για τους αναγνώστες οθόνης.

MS WORD 2007 ΚΑΙ 2010

Στην έκδοση  Ms Word 2007 και στις  νεότερες του  ενθαρρύνεται η προσπάθεια  της χρήσης των
ορθών στυλ. Η  μισή   γραμμή των εργαλείων (default toolbar) είναι αφιερωμένη στα στυλ. Για να
αλλάξετε το στυλ  ενός μπλοκ κειμένου, επιλέξτε το κείμενο και κάντε κλικ στο  στυλ που επιθυμείτε.

Εικόνα 2. Γραμμή  εργαλείων των  Στυλ  Ms  Word 2007-2010
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MS WORD ΓΙΑ MAC

Στη παλέτα μορφοποίησης του Mac είναι διαθέσιμα τα στυλ του Ms Word. Η αναπτυσσόμενη
(dropdown) λίστα των στυλ είναι παρόμοια με την αντίστοιχη  του Ms Word 2000-2003 για Windows.

Εικόνα 3. Αναπτυσσόμενη  λίστα των Στυλ για Mac

1.2.2 Εναλλακτικό κείμενο σε  εικόνες     

Οι εικόνες μπορούν αποδοθούν με  κατάλληλη εναλλακτική μορφή κειμένου. Το εναλλακτικό κείμενο
θα διαβαστεί από το λογισμικό του αναγνώστη οθόνης και θα παραμείνει ανέπαφο κατά την εξαγωγή
του στις μορφές  HTML ή PDF.

Σημειώση
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 Οι ενσωματωμένες  γραφικές παραστάσεις θα πρέπει να αποδοθούν με περιγραφή κειμένου.
Τα δεδομένα της γραφικής παράστασης  πρέπει να έχουν προσβασιμότητα στο πρωτότυπο
αρχείο, θα είναι ένα απλό λογιστικό φύλλο, αλλά δεν θα συμπεριληφθούν στις  μορφές PDF  ή
HTML.

 Αν υπάρχει «Word art» τότε γίνεται εικόνα στο Office 2003-2007 και αποδίδεται με
εναλλακτικό κείμενο. Παραμένει κείμενο στο Office 2010.

 Δεν υπάρχει τρόπος  να προσθέσετε εναλλακτικό κείμενο στις εικόνες των Word 2004 ή 2008
για Mac. 

MS WORD 2000-2003

Για να προσθέσετε  εναλλακτικό κείμενο σε εικόνα , κάντε δεξί κλικ πάνω στην εικόνα και στη
συνέχεια επιλέξτε Μορφοποίηση εικόνας (Format Picture…).

Εικόνα 4. Μενού  επεξεργασίας  της  εικόνας  Wave Version 4.0  στο  Ms Word 2000-2003 
Ένα πλαίσιο διαλόγου θα εμφανιστεί. Επιλέξτε την  καρτέλα Web και προσθέστε το εναλλακτικό
κείμενο.
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Εικόνα 5. Παράθυρο διαλόγου Μορφοποίησης  Εικόνας με  ανοικτή τη καρτέλα Web για τη
προσθήκη  εναλλακτικού κείμενου  στο Ms Word 2000-2003

MS WORD 2007

Η προσθήκη εναλλακτικού κείμενου στις εικόνες είναι λιγότερο διαισθητική στο Ms Word 2007. Για
να προσθέσετε εναλλακτικό κείμενο, κάντε δεξί κλικ πάνω στην εικόνα και επιλέξτε Μέγεθος (Size)….
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Εικόνα 6. Μενού  επεξεργασίας  της  εικόνας  WebAim  στο  Ms Word 2007
Ένα πλαίσιο διαλόγου θα εμφανιστεί. Επιλέξτε την καρτέλα Alt Text  . Το όνομα του αρχείου της
εικόνας  εμφανίζεται ως προεπιλογή στο πεδίο Alt Text. Το όνομα του αρχείου  δεν είναι κατάλληλο
για εναλλακτικό κείμενο. Μπορεί να προκαλέσει τη κακή χρήση του Alt Text.
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Εικόνα 7. Παράθυρο διαλόγου  Μέγεθος εικόνας  με ανοικτή τη καρτέλα Alt Text  για  τη
προσθήκη  εναλλακτικού κειμένου στο  Ms Word 2007

Αντικαταστήστε το όνομα του αρχείου της εικόνας  με  κατάλληλο εναλλακτικό κείμενο. Για
παράδειγμα για την Εικόνα 6 θα γράφατε  κάτι σαν  "WebAIM - Web Accessibility in Mind".

MS WORD 2010

Στο Word 2010 το πεδίο κειμένου Alt Text μετακινήθηκε  προς τα πίσω  (intuitive place)
προκαλώντας  μεγαλύτερη σύγχυση λόγω της δημιουργίας των  δύο πεδίων του  Alt  κειμένου .
Για να προσθέσετε εναλλακτικό κείμενο σε εικόνα, χρησιμοποιείστε την επιλογή Μορφοποίηση
Εικόνας (Format  Picture).
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Εικόνα 8. Μενού  Μορφοποίησης  της  εικόνας  Windows Office 2010 Beta για τη προσθήκη
εναλλακτικού κείμενου  στο  Ms Word 2010 

Με ανοικτό το παράθυρο διαλόγου Μορφοποίησης Εικόνας, επιλέξτε Εναλλακτικό Κείμενο (Alt Text)
από τη πλευρική μπάρα (sidebar).  Τότε θα εμφανισθούν δύο πεδία. Το ένα πεδίο  είναι η
Επικεφαλίδα (Title) και το  άλλο η Περιγραφή (Description). Προσθέστε το κατάλληλο εναλλακτικό
κείμενο στο πεδίο Περιγραφή (Description) και όχι, στο πεδίο Επικεφαλίδα (Τitle).  Η πληροφορία
του πεδίου Επικεφαλίδα δεν θα αποθηκευτεί ως εναλλακτικό κείμενο, όταν το αρχείο μετατραπεί  σε
μορφή HTML.
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Εικόνα 9. Παράθυρο  διαλόγου Μορφοποίησης  Εικόνας με τη προσθήκη εναλλακτικού
κείμενου στο Ms Word 2010

Για να είστε  ασφαλής, μπορείτε να αντιγράψετε το εναλλακτικό κείμενο τόσο στο πεδίο Τίτλος   όσο
και στο πεδίο Περιγραφή.

1.2.3 Προσβασιμότητα στους Πίνακες δεδομένων    

Δεν υπάρχει τρόπος να εκχωρήσετε τις επικεφαλίδες πίνακα ή  στοιχεία <th> δημιουργώντας πίνακα
στο Ms Word. Μπορείτε να δηλώσετε ότι μια γραμμή θα επαναλαμβάνεται ως επικεφαλίδα στη
κορυφή κάθε  σελίδας από το μενού Ιδιότητες Πίνακα (Table Properties). Όταν τα κελιά της πρώτης
γραμμής αποθηκεύονται σε PDF, εντοπίζονται  ως επικεφαλίδες πίνακα. Οι επικεφαλίδες αυτές δεν
διατηρούνται όταν το αρχείο αποθηκευτεί σε μορφή HTML.  Αντί αυτού, τα κελιά  θα  περιέχονται στο
 στοιχείο <thead>. Τα <thead> , <tfoot> και <tbody> χρησιμοποιούνται για να χωρίζουν τους
πίνακες σε τρία μέρη στο πίνακα δεδομένων. Η εισαγωγή ενός στοιχείου <thead> δεν δημιουργεί
πρόβλημα και δεν υποκαθιστά τη χρήση των στοιχείων <th> για τις επικεφαλίδες του  πίνακα. Δεν
υπάρχει τρόπος να προσθέσετε επικεφαλίδες γραμμής  (κεφαλίδες κατά μήκος της  πλευράς ενός
πίνακα) στο Ms Word.

1.2.4 Σύνδεσμοι         

Συνήθως δημιουργούμε υπερσυνδέσεις στο Ms Word  επικολλώντας την πλήρη διεύθυνση URL σε μια
σελίδα (για παράδειγμα, http://webaim.org/techniques/word/)  χωρίς να εισάγουμε  διαστήματα,
Enter, ή κάποιο άλλο κλειδί του πληκτρολογίου. Μια διεύθυνση URL μπορεί να μην έχει νόημα για
κάποιο αναγνώστη. Για να αλλάξετε το κείμενο της υπερσύνδεσης, επιλέξτε την, κάντε δεξί κλικ και
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επιλέξτε Επεξεργασία υπερσύνδεσης (Edit Hyperlink) , ή πατήστε Ctrl + K (Cmd + K για Mac). Στο
πεδίο Να εμφανίζεται το κείμενο (Text to display) μπορείτε να γράψετε με περιγραφικό τρόπο  τη
διεύθυνση της URL.      

Εικόνα 10. Παράθυρο  διαλόγου Επεξεργασίας  Υπερσύνδεσης στο Ms Word 2010
 Αν έχετε σκοπό το έγγραφο  σας να τυπωθεί ή  να  αναγνωστεί ηλεκτρονικά θα ήταν προτιμότερο να
φαίνεται η URL και η περιγραφή  του συνδέσμου π.χ "WebAIM article on Creating accessible
documents in Ms Word (webaim.org/techniques/word)."

1.2.5 Άλλες αρχές         

Υπάρχουν  και μερικές άλλες αρχές προσβασιμότητας του διαδικτύου που  μπορούν να εφαρμοστούν
στα αρχεία μορφής Ms Word. Ακολουθεί μια λίστα με αυτές :

  Να χρησιμοποιείτε τις  λίστες  αρίθμησης και τις λίστες κουκκίδων (true numbered
and bulleted lists).

  Να εξασφαλίσετε ότι το μέγεθος της γραμματοσειράς είναι περίπου 12 (points)  ή
μεγαλύτερο.

 Να δώσετε επαρκή αντίθεση (contrast).

  Να μη χρησιμοποιείτε το χρώμα ως το μόνο τρόπο για  να αποδώσετε   περιεχόμενο.

  Να χρησιμοποιείτε τις σταθερές στήλες  (true columns) αντί  τους  πίνακες ή τις
στήλες  που έγιναν  χειροκίνητα με  το  πλήκτρο Tab  .
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  Να δημιουργήσετε  ένα πίνακα περιεχομένων. Είναι απαραίτητος στα μεγάλα
έγγραφα. Η δημιουργία ενός πίνακα περιεχομένων είναι εύκολη  αν έχετε μια καλή
δομή τίτλων,

  Να χρησιμοποιείτε  απλή γλώσσα.

1.3 Έλεγχος προσβασιμότητας στο Ms Word 2010     
Το Ms Word 2010 έχει  έναν Ελεγκτή Προσβασιμότητας (Accessibility Checker ) που κάνει  τον
εντοπισμό και την διόρθωση των  προβλημάτων προσβασιμότητας πολύ εύκολη  . Για να εκτελέσετε
τον Έλεγχο Προσβασιμότητας, επιλέξτε File> Info  > Check  for Issues > Check Accessibility.

Εικόνα 11.  Μενού  Αρχείο για την επιλογή  του  Ελεγκτή Προσβασιμότητας  στο Ms Word 2010

Με την  επιλογή αυτή θα ξεκινήσει ο Ελεγκτής  Προσβασιμότητας.
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Εικόνα 12. Καρτέλα Ελεγκτή Προσβασιμότητας  για τον εντοπισμών των λαθών
προσβασιμότητας στο  Ms Word 2010 

 Ο ελεγκτής εμφανίζει τα λάθη προσβασιμότητας όπως τις εικόνες που τους λείπει το  εναλλακτικό
κείμενο (images with no alt text) , τις προειδοποιήσεις των ασαφών συνδέσμων (warnings unclear
link text) , τις μεταπηδήσεις από επικεφαλίδα πρώτου επίπεδου σε επικεφαλίδα τρίτου επίπεδου
παραλείποντας την επικεφαλίδα δεύτερου επιπέδου. Επίσης έχει ανατροφοδότηση για τη
σημαντικότητα του κάθε στοιχείου, καθώς και συμβουλές (tips) για  την επιδιόρθωση του.
Επιλέγοντας ένα στοιχείο από την αναφορά (report) επιλέγετε και το αντίστοιχο στοιχείο του
εγγράφου.

1.4 Αρχεία μορφής  Docx        
Η μορφή «docx"  αφορά έγγραφα που δημιουργήθηκαν με το  Ms Word 2007 και τις νεότερες
εκδόσεις του. Η μορφή αυτή έχει το πλεονεκτήματα  ότι  το αρχείο έχει  μικρότερο μέγεθος και το
μειονέκτημα ότι  δεν υποστηρίζεται από την παλαιότερη μορφή "doc". Αν και υπάρχει δωρεάν
επιπρόσθετο πρόγραμμα (free download) που επιτρέπει στους χρήστες παλαιότερων εκδόσεων να
ανοίξουν τη νεότερη μορφή,  όμως κατά τη διαδικασία αυτής της μετατροπής θα χαθεί ένα μέρος
του περιεχομένου του κειμένου. Για περισσότερα δείτε το σύνδεσμο  some content will be lost in the
conversion process - external link  . Αν ένα  αρχείο Ms Word πρόκειται να καταλήξει στο διαδίκτυο ή
να αποσταλεί  σε κάποιον που δεν υποστηρίζεται  από τη νεότερη έκδοση  της μορφής αρχείων docx
τότε υπάρχει η δυνατότητα να κάνει την  αποθήκευση των  αρχείων σε μορφή Ms Word 97-2003
Document (*.doc) στο Office 2007 και 2010.

http://office.microsoft.com/en-us/word/ha100444731033.aspx
http://office.microsoft.com/en-us/word/ha100444731033.aspx
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1.5 Μετατροπή αρχείου μορφής Ms Word σε αρχείο μορφής HTML 

1.5.1 Αποθήκευση  εγγράφου Ms Word σε μορφή  HTML     

Κατά την αποθήκευση ενός εγγράφου Ms Word σε  HTML, η δομή και το εναλλακτικό κείμενο θα
πρέπει να διατηρούνται στο τελικό έγγραφο. Για να κάνετε την αποθήκευση ενός  εγγράφου σε
μορφή HTML, επιλέξτε File > Save as Web Page….(Αρχείο > Αποθήκευση ως…) . Για το Ms  Word
2007, επιλέξτε το λογότυπο του (Word logo ) που είναι στη πάνω δεξιά γωνία και στη συνέχεια
επιλέξτε Αποθήκευση ως (Save As).

Εικόνα 13. Μενού  Αρχείο με την επιλογή Αποθήκευση στο  Διαδίκτυο  ως  Ιστοσελίδα
Στο Office XP ή σε νεότερη έκδοση του, υπάρχουν δύο τρόποι για την εξαγωγή σε HTML:

 Η αποθήκευση σε μορφή  ιστοσελίδας

 Η αποθήκευση σε μορφή  φιλτραρισμένης  ιστοσελίδας
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Εικόνα 14. Μενού αποθήκευσης  εγγράφου με μορφή Φιλτραρισμένης  Ιστοσελίδας
Το πλεονέκτημα της επιλογής Ιστοσελίδας (Web Page) είναι ότι η σελίδα θα φαίνεται με τη μορφή
που θα εκτυπώνεται το έγγραφο. Το πλεονέκτημα της επιλογής Φιλτραρισμένης Ιστοσελίδας ( Web
Page, Filtered) είναι ότι ο κώδικας είναι πιο ακριβής, το μέγεθος του αρχείου είναι σημαντικά
μικρότερο, και τα περισσότερα, αν όχι όλα, από την αισθητική εμφάνιση του πρωτότυπου εγγράφου
διατηρούνται.
Όσον αφορά την προσβασιμότητα, και οι δύο επιλογές είναι αποδεκτές, εφόσον το αρχείο
προέλευσης δημιουργήθηκε με τη σωστή δομή, έχει  εναλλακτικό κείμενο στις εικόνες ,δεν περιέχει
πίνακες δεδομένων και έχουν εφαρμοστεί οι  αρχές προσβασιμότητας. Λόγω των περιορισμών της
εξειδικευμένης μεταγλώσσας  του  Internet Explorer (Internet Explorer-specific markup) , η χρήση
των φιλτραρισμένων  ιστοσελίδων (Filtered webpages) είναι πιθανόν  να υποστηρίζεται και να είναι
συμβατή από διαφορετικούς φυλλομετρητές  (web browsers).

1.5.2 "Ειδική επικόλληση" στο Dreamweaver    

Εάν χρησιμοποιείτε το Dreamweaver (http://webaim.org/techniques/dreamweaver/ )για να
συντάξετε το περιεχόμενο των ιστοσελίδων, μπορείτε να εισαγάγετε το περιεχόμενο του εγγράφου Ms
Word χρησιμοποιώντας την επιλογή Ειδική επικόλληση (Paste Special). Επιλέξτε όλο το περιεχόμενο
του εγγράφου Ms Word και αντιγράψτε το στο πρόχειρο (clipboard). Στη συνέχεια, ανοίξτε μια κενή
σελίδα στο Dreamweaver. Κάντε δεξί κλικ και επιλέξτε την Ειδική επικόλληση ..., ή Ctrl + Shift + V.

http://webaim.org/techniques/dreamweaver/
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Εικόνα 15. Παράθυρο διαλόγου   Ειδικής επικόλλησης στο Dreamweaver
Θα εμφανιστεί ένα παράθυρο διαλόγου με τέσσερις επιλογές:

 Ως κείμενο μόνο

 Κείμενο με δομή (παράγραφοι, λίστες, πίνακες, κ.λπ.)

 Κείμενο με δομή βασικής μορφοποίησης (έντονη γραφή, πλάγια γραφή),

 Κείμενο με δομή πλήρης μορφοποίησης (έντονη γραφή, πλάγια γραφή, στυλ).

Επίσης υπάρχουν επιλογές για τη διατήρηση των  αλλαγών γραμμής (Retain line breaks) (εάν
υπάρχουν) και για τον Καθαρισμό των κενών μιας παραγράφου (Clean up Word paragraph
spacing) . Χρησιμοποιώντας οποιοδήποτε από τις προηγούμενες επιλογές θα έχετε κάνει το έγγραφο
σας καθαρότερο για τη  μορφή  HTML  από το να το αποθηκεύατε με μορφή  HTML στο  Ms Word. Η
καλύτερη επιλογή είναι : Κείμενο με δομή ή Κείμενο με μορφοποίηση δομής συν βασική
μορφοποίηση (Text with structure or Text with structure plus basic formatting) .

1.5.3 Εργαλείο Προσβασιμότητας Virtual508.com     

Ένα έγγραφο Ms Word μπορεί  να μετατραπεί σε HTML και με το Εργαλείο Προσβασιμότητας
Virtual508.com (Virtual508.com Accessible Web Publishing Wizard ). Το εργαλείο αυτό είναι
διαθέσιμο μόνο για το λειτουργικό σύστημα των Windows και απαιτεί .NET. Συνεργάζεται με τα
Office 2000-2007. Ο Οδηγός (Wizard) δεν δίνεται  δωρεάν, αλλά υπάρχει μια έκδοση Παρουσίασης
(demonstration version) που επιτρέπει τη μετατροπή σε  περιορισμένο αριθμό σελίδων ή διαφανειών
. Είναι το καταλληλότερο για τις  παρουσιάσεις σε Ms Powerpoint. Υπάρχει και το εγχειρίδιο
πρακτικής με τίτλο  «Βασικές αρχές για Microsoft Word» – ( Best Practices for Microsoft Word ) που
θα σας ενημερώσει  για τη  ομαλότερη διαδικασία μετατροπής  του Ms Word σε HTML  .

http://www.virtual508.com/
http://www.virtual508.com/bp-word.html
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1.6 Μετατροπή εγγράφου του Ms Word σε έγγραφο μορφής  PDF (Portable
Document Format -  αρχείο μορφής  που «μεταφέρεται»)  

Πολλά έγγραφα του Ms Word καταλήγουν σε αρχεία PDF. Κατά τη μετατροπή αυτή είναι βολικό να
διατηρήσετε τη μορφοποίηση και την προσβασιμότητα των πληροφοριών. Διαβάστε  περισσότερα για
τη μετατροπή ενός εγγράφου  Ms Word σε μορφή PDF με προσβασιμότητα στη παράγραφο 
Προσβασιμότητα σε  αρχεία  PDF
Επιστροφή  Microsoft Word 
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2 Γνωρίζοντας  τις δυνατότητες προσβασιμότητας των εκδόσεων  του
Ms Powerpoint

2.1 Εισαγωγή       
Ένα από τα πιο δημοφιλή εργαλεία για τη δημιουργία των διαφανειών των παρουσιάσεων είναι το Ms
Powerpoint  της Microsoft  . Χρησιμοποιείται συχνά για να οργανωθεί το σκεπτικό  μιας συνάντησης ή
ενός  μαθήματος ή για να γίνει αναφορά των βασικών σημείων μιας ζωντανής παρουσίασης. Θα
περιγράψουμε τον τρόπο  με τον οποίον  κάνουμε τα αρχεία του Ms Powerpoint  πιο προσιτά στο
διαδίκτυο.

2.2 Δημιουργία αρχείων με προσβασιμότητα  στο Ms Powerpoint
Ανεξάρτητα από το αν το αρχείο σας  συνδέεται άμεσα με άλλο αρχείο του Ms Powerpoint (PPT) ή αν
η παρουσίασή σας εμφανίζεται σε άλλη μορφή όπως PDF, υπάρχουν αρκετά πράγματα που μπορείτε
να κάνετε για να έχει το αρχείο σας προσβασιμότητα.

2.2.1 Ms Powerpoint για Mac        

Όλες οι εκδόσεις του Ms Powerpoint για Mac μέχρι το 2008 έχουν σοβαρούς περιορισμούς
πρόσβασης. Για παράδειγμα, δεν μπορείτε να δώσετε  κατάλληλο εναλλακτικό κείμενο σε εικόνες και
να εξάγεται την παρουσίασης  σε  αρχείο PDF με προσβασιμότητα. Λόγω αυτών των περιορισμών
πρόσβασης, η παρούσα εργασία δεν περιλαμβάνει  κατευθυντήριες γραμμές του  Office για χρήστες
Mac.

2.2.2 Διατάξεις Διαφάνειας  (Slide layouts)   

Όλες οι εκδόσεις  του Ms Powerpoint  από το 2000 και μετά έχουν μια σειρά από εξαιρετικές
Διατάξεις Διαφάνειας με προσβασιμότητα  (highly - accessible slide layouts). 
Το Ms Powerpoint έχει σχεδιαστεί για να ενθαρρύνει  τη χρήση αυτών των Διατάξεων , ιδίως με τις
νεότερες εκδόσεις του. Χρησιμοποιώντας αυτά τα πρότυπα σωστά θα είναι εξασφαλισμένο  ότι τα
αρχεία σας θα έχουν δομημένες επικεφαλίδες και  λίστες, σειρά ανάγνωσης  κλπ. Η σωστή χρήση των
 Διατάξεων των διαφανειών (Slides  Layouts) είναι ίσως το πιο σημαντικό πράγμα που θα
εξασφαλίσει τη προσβασιμότητα στο περιεχόμενό τους .
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MS POWERPOINT 2000-2003       

Επιλέξτε Moρφή > Διάταξη διαφάνειας ... (Format > Slide Layout...) ή με τη χρήση της πλευρικής
μπάρας (sidebar)  τη Διάταξη διαφάνειας (Slide Layout).

Εικόνα 16. Μενού Εφαρμογής των Διατάξεων  διαφάνειας στο Ms Powerpoint 2000-2003

MS POWERPOINT 2007-2010

Επιλέξτε Εισαγωγή > Νέα διαφάνεια (Home > New Slide), ή επιλέξτε το κουμπί Νέα διαφάνεια
(New Slide)  για να  εμφανίσει όλους  τους τύπους παρουσίασης.
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Εικόνα 17. Καρτέλα Εισαγωγής  νέας διαφάνειας στο Ms Powerpoint 2007-2010

2.2.3 Εναλλακτικό κείμενο σε εικόνες

Συνήθως οι παρουσιάσεις του Ms Powerpoint περιλαμβάνουν εικόνες. Μερικές φορές οι εικόνες
αυτές είναι διακοσμητικές  και  έχουν περιεχόμενο που πρέπει να τους αποδοθεί  εναλλακτικό
κείμενο. Αυτό το εναλλακτικό κείμενο θα διαβαστεί από το πρόγραμμα ανάγνωσης οθόνης και θα
παραμείνει ανέπαφο κατά την εξαγωγή του κειμένου σε  HTML ή PDF μορφή. Για περισσότερες
πληροφορίες σχετικά με αυτό το θέμα, διαβάστε το άρθρο στη εξωτερική σύνδεση
http://webaim.org/techniques/alttext/ εναλλακτικό κείμενο  .

Σημειώσεις

 Δεν υπάρχει τρόπος να προσθέσετε κενό (empty / null)  εναλλακτικό κείμενο σε μια εικόνα
του Ms Powerpoint. Εάν η παρουσίασή σας έχει διακοσμητικές εικόνες χωρίς  περιεχόμενο
άξιο αναφοράς, το καλύτερο πράγμα που μπορείτε να κάνετε είναι το πεδίο του εναλλακτικού
 κειμένου να έχει κενό διάστημα. Μια εικόνα που δεν έχει εναλλακτικό κείμενο, θα
παραληφθεί τυπικά από το πρόγραμμα ανάγνωσης οθόνης (screen reader) .

  Ένα «Word Art"  μετατρέπεται  σε εικόνα στο Office 2003-2007 και θα πρέπει να του
αποδοθεί εναλλακτικό κείμενο. Στο Office 2010 παραμένει κείμενο.

 Θα πρέπει να αποδοθεί   εναλλακτικό κείμενο στα ενσωματωμένα γραφήματα. Μερικές φορές
το περιεχόμενο του γραφήματος μπορεί να είναι πολύ μεγάλο για εναλλακτικό κείμενο. Εάν η
παρουσίασή περιέχει πολλά γραφήματα ή γραφικές παραστάσεις πρέπει να εξεταστεί  η

http://webaim.org/techniques/alttext/
http://webaim.org/techniques/alttext/
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σύνδεση τους  με το πρωτότυπο αρχείο PPT. Τα δεδομένα που χρησιμοποιούνται για τη
δημιουργία του γραφήματος πρέπει να έχουν προσβασιμότητα από το  αρχικό αρχείο  αλλά
δεν θα συμπεριληφθούν στις εκδόσεις  των PDF  ή  HTML .

MS POWERPOINT 2000-2003

Για να δημιουργήσετε  εναλλακτικό κείμενο, κάντε δεξί κλικ στην εικόνα και επιλέξτε Μορφοποίηση
εικόνας …(Format Picture...) .
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Εικόνα 18. Μενού επεξεργασίας της  εικόνας Wave  στο Ms Powerpoint 2000-2003 
Στο παράθυρο διαλόγου που θα εμφανιστεί επιλέξτε τη καρτέλα Web για προσθέστε στο πλαίσιο
κειμένου της  εναλλακτικό κείμενο.

Εικόνα 19. Παράθυρο διαλόγου μορφοποίησης εικόνας με  ανοιγμένη τη καρτέλα  Web  για τη
προσθήκη εναλλακτικού κείμενου

MS POWERPOINT  2007
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Η  προσθήκη εναλλακτικού κειμένου στις εικόνες του  Ms Powerpoint 2007 είναι λιγότερο
διαισθητική. Για να προσθέσετε εναλλακτικό κείμενο, κάντε δεξί κλικ στην εικόνα και επιλέξτε
Μέγεθος και Θέση (Size and Position) .

Εικόνα 20. Μενού  επεξεργασίας της εικόνας  WebAim  στο Ms Powerpoint 2007
Στο παράθυρο διαλόγου που θα εμφανιστεί θα παρατηρήσετε ότι το όνομα της εικόνας είναι
εγγεγραμμένο στο πεδίο από προεπιλογή στη καρτέλα Alt Text . Αυτό  δεν αποτελεί εναλλακτικό
κείμενο και θα  προκαλέσει  τη κακή χρήση του χαρακτηριστικού Αlt.
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Εικόνα 21. Παράθυρο διαλόγου Μέγεθος και  Θέση  με ενεργή τη  καρτέλα Alt Text  για τη
προσθήκη εναλλακτικού κείμενου

Αντικαταστήστε το όνομα του αρχείου της εικόνας με εναλλακτικό κείμενο. Για την εικόνα αυτή, ως
εναλλακτικό κείμενο θα ήταν  το  "WebAIM - Web Accessibility in Mind". Αν μια εικόνα είναι
διακοσμητική, σβήστε το όνομα του αρχείου και  αφήστε το πεδίο κενό.

MS POWERPOINT 2010

Το πεδίο του εναλλακτικού κειμένου στο Ms Powerpoint 2010 μετακινήθηκε προς τα πίσω κάπως
διαισθητικά (intuitive place)  προκαλώντας  σύγχυση με τη δημιουργία δυο πεδίων. Για να
προσθέσετε εναλλακτικό κείμενο σε εικόνα, επιλέξτε Μορφοποίηση εικόνας… ( Format Picture... )
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Εικόνα 22. Καρτέλα επεξεργασίας  της εικόνας  Office 2010  Beta στο  Ms Powerpoint 2010 
Με ανοικτό το  παράθυρο της Μορφοποίησης Εικόνας (Format Picture ) επιλέξτε Alt Text . Στη
πλευρική μπάρα (sidebar) θα εμφανιστούν  δύο πεδία,  το ένα λέγεται Τίτλος (Title)  και  το άλλο
Περιγραφή (Description) . Καλύτερα να προσθέσετε  εναλλακτικό κείμενο στο πεδίο Περιγραφή
(Description ) και όχι  στο πεδίο Τίτλος (Title) . Οι πληροφορίες  του  πεδίου Τίτλος (Title) δεν
αποθηκεύονται  ως  εναλλακτικό κείμενο όταν το αρχείο γίνεται  HTML.

Εικόνα 23. Παράθυρο διαλόγου Μορφοποίησης Εικόνας με ενεργή την καρτέλα  Alt Text  για
την εισαγωγή εναλλακτικού κείμενου
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Πίνακες δεδομένων και θέματα προσβασιμότητας
Στην έκδοση  HTML, υπάρχουν τρόποι να εντοπιστούν οι κεφαλίδες γραμμής και στήλης στο πίνακα
δεδομένων χρησιμοποιώντας το <th> στοιχείο . Για περισσότερα επισκεφτείτε την σύνδεση 
http://webaim.org/techniques/tables/data - data table  Με το Ms Powerpoint μπορείτε να δώσετε
στυλ στις  γραμμές και  στις στήλες  για να εμφανίζονται σαν  πίνακες δεδομένων. Δεν μπορείτε να
προσθέσετε περιεχόμενο που θα διαβαστεί  από ένα πρόγραμμα ανάγνωσης οθόνης (screen reader).
Εάν η παρουσίασή σας δεν έχει απλούς πίνακες  και έχετε το Adobe Acrobat  τότε αποθηκεύεστε την
σε μορφή  PDF (saving your presentation to PDF) και προσθέστε τις επιπλέον πληροφορίες
πρόσβασης με το Acrobat Pro.  

2.2.4 Σύνδεσμοι

Στο  Ms Powerpoint  οι υπερσυνδέσεις  σε μια σελίδα δημιουργούνται με  την  επικόλληση της πλήρης
διεύθυνσης URL (π.χ., http://webaim.org/ techniques/Powerpoint/) χωρίς τη χρήση διαστημάτων,
Enter, ή κάποιου άλλου κλειδιού του πληκτρολογίου. Έτσι η σύνδεση δημιουργείται αυτόματα. Όμως
μια  διεύθυνση URL μπορεί να μην είναι κατανοητή από  κάποιο αναγνώστη. Για να αλλάξετε το
κείμενο μιας σύνδεσης, αρχικά επιλέξτε τη  σύνδεση, κάντε δεξί κλικ σ’ αυτήν και επιλέξτε
Επεξεργασία υπερσύνδεσης (Edit Hyperlink)  ή πατήστε Ctrl + Κ.  Μπορείτε να αλλάξετε τη
διεύθυνση του πεδίου URL μέσω του πεδίου Κείμενο προς εμφάνιση (Text to display)  γράφοντας
κάτι πιο περιγραφικό.                                                  

Εικόνα 24. Παράθυρο διαλόγου επεξεργασίας Υπερσύνδεσης
Όταν δημιουργείτε μια παρουσίαση που πρόκειται να αναγνωριστεί ηλεκτρονικά και να τυπωθεί  καλό
είναι  να φαίνεται η  URL μαζί με τη  περιγραφή του συνδέσμου. Για παράδειγμα " Άρθρο του  Web
AIM για προσβασιμότητα στο  Ms Powerpoint (webaim.org / τεχνικές / powerpoint /)".

2.2.5 Άλλες αρχές προσβασιμότητας       

http://webaim.org/techniques/tables/data
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  Εξασφαλίστε ότι το μέγεθος της γραμματοσειράς είναι επαρκές. Εάν η παρουσίαση
σας χρειαστεί να προβληθεί  με προβολέα (projector)  ίσως το μέγεθος της
γραμματοσειράς να είναι  μεγαλύτερο.

 Δώστε επαρκή αντίθεση (contrast). Μερικές φορές η αντίθεση πρέπει να είναι  πιο
έντονη για  παρουσίαση που  θα προβληθεί σε προβολέα (projector),  .

 Το χρώμα  από μόνο του   δεν είναι αρκετό για  την απόδοση του περιεχόμενου.

 Αποφύγετε τον αυτόματο τρόπο  εναλλαγής διαφανειών. 

 Χρησιμοποιήστε τον απλό τρόπο εναλλαγής  διαφανειών. Οι σύνθετες εναλλαγές
αποσπούν την προσοχή.

 Να γράφετε σε  απλή γλώσσα.

  Ελέγξτε τη  σειρά ανάγνωσης των πλαισίων κειμένου (text boxes) που δεν
αποτελούν μέρος της διάταξης των διαφανειών .Είναι το τελευταίο πράγμα που
διαβάζεται από έναν αναγνώστη οθόνης (screen reader).

 Εάν έχετε ενσωματωμένο βίντεο, βεβαιωθείτε ότι το βίντεο έχει λεζάντες και ότι οι
διακόπτες παιξίματος του  (players controls) έχουν προσβασιμότητα.

  Εάν έχετε ενσωματωμένο ήχο, εξασφαλίστε ότι  υπάρχει αντίγραφο. 

 Εάν οι διαφάνειες σας περιέχουν κινούμενα σχέδια, εξασφαλίστε ότι είναι σύντομα
και δεν θα αποσπούν την προσοχή από τα πιο σημαντικά περιεχόμενα της σελίδας.  

2.2.6 Πλαίσια Περιγράμματος  και Σημειώσεων

Το Ms Powerpoint περιέχει δύο πλαίσια, το πλαίσιο περιγράμματος (outline panel) και το πλαίσιο
σημειώσεων (notes panel) που μερικές φορές μπορούν να χρησιμοποιηθούν  για τη βελτίωση της
πρόσβασης.
Το πλαίσιο περιγράμματος (outline panel) περιέχει μια συνοπτική παρουσίαση του κειμένου που
εμφανίζεται στις διαφάνειες. Η εξέταση αυτού του πλαισίου (panel)  συμβάλει στη διασφάλιση ότι το
περιεχόμενο των διαφανειών  έχει λογική διαδοχή, ότι οι τίτλοι των διαφανειών είναι μοναδικοί και
έχουν  νόημα και ότι η σειρά ανάγνωσης είναι κατάλληλη. Το κείμενο του πλαισίου μπορεί να γίνει
σημείο εκκίνησης των σημειώσεων ενός ακροατηρίου ή για των εναλλακτικών HTML λύσεων των
διαφανειών (πιο κάτω). Τα εναλλακτικά κείμενα στις εικόνες και στα πλαίσια κειμένου (text boxes)
δεν θα συμπεριληφθούν στην προβολή διάρθρωσης αν δεν είναι μέρος της προεπιλεγμένης διάταξης
της διαφάνειας .
Το πλαίσιο σημειώσεων (notes panel) επιτρέπει στον ομιλητή  να προσθέσει σημειώσεις και
πληροφορίες που δεν εμφανίζονται στις διαφάνειες. Μπορεί να χρησιμοποιηθεί για να προστεθούν
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επιπλέον πληροφορίες στα έντυπα φυλλάδια. Πρέπει να αποφεύγεται να  τίθεται η περιγραφή της
εικόνας  ή του διαγράμματος (chart) στο πεδίο αυτό. Αυτή η πληροφορία δεν προσπελαύνετε    από
ένα πρόγραμμα ανάγνωσης οθόνης , ειδικότερα  αν η αποθήκευση της παρουσίασης γίνεται  σε
μορφή PDF ή σε κάποια άλλη μορφή.

2.3 Ελεγκτής  Προσβασιμότητας του Ms Powerpoint 2010   
Το Ms Powerpoint 2010 έχει ένα Ελεγκτή που  σας επιτρέψει να ελέγχετε τα προβλήματα
πρόσβασης. Ο Ελεγκτής Πρόσβασης καθιστά εύκολο  τον εντοπισμό και την διόρθωση των θεμάτων
προσβασιμότητας. Για να εκτελέσετε τον Έλεγχο Προσβασιμότητας, επιλέξτε Αρχείο > Πληροφορία >
Έλεγχος έκδοσης > Έλεγχος Προσβασιμότητας ( File > Info > Check for Issues > Check
Accessibility).

Εικόνα 25. Μενού Αρχείο με ενεργή τη καρτέλα Info για την  επιλογή του Ελεγκτή
Προσβασιμότητας στο Ms Powerpoint 2010
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Με αυτό το τρόπο  θα ξεκινήσει ο ελεγκτής

προσβασιμότητας.

Εικόνα 26. Η καρτέλα του  Ελεγκτή Προσβασιμότητας στο Ms Powerpoint 2010
Ο ελεγκτής παρουσιάζει τα λάθη προσβασιμότητας για τις εικόνες που δεν έχουν εναλλακτικό κείμενο
,τις  προειδοποιήσεις (warnings) για τους  συνδέσμους που έχουν  ασαφές  κείμενο, τις συμβουλές
(tips) για τη σειρά ανάγνωσης των διαφανειών κ.λ.π. Υπάρχει  ανατροφοδότηση για τη σημασία του
κάθε στοιχείου καθώς και  συμβουλές διόρθωσης. Επιλέγοντας ένα στοιχείο της έκθεσης (report)
επιλέγεται ταυτόχρονα και το αντίστοιχο στοιχείο του αρχείου .  

2.4 Αρχεία μορφής PPTX         
Η μορφή "pptx"  είναι η προεπιλεγμένη μορφή των αρχείων  που δημιουργούνται στο Ms Powerpoint
2007 και στις νεότερες εκδόσεις  του. Αυτή έχει κάποια  πλεονεκτήματα (όπως το μικρότερο μέγεθος
αρχείου)  αλλά δεν  υποστηρίζεται από  τη παλαιότερη μορφή "ppt". Αν και υπάρχει προσθήκη
δωρεάν που επιτρέπει στους χρήστες να ανοίξουν τις παλαιότερες εκδόσεις του Ms Powerpoint  με
τη νεότερη έκδοση ,βλέπετε «open the newer format in older versions of PowerPoint - εξωτερική 
σύνδεση  » ,  κάποια περιεχόμενα  του κειμένου θα χαθούν. Αν το αρχείο του Ms Powerpoint
πρόκειται να αποσταλεί στο διαδίκτυο ή σε κάποιον που δεν έχει τη  νεότερη έκδοση pptx υπάρχει η
δυνατότητα στο Office 2007 και 2010 να  γίνει η  αποθήκευση  αρχείων  σε μορφή Ms Powerpoint
97-2003 Presentation ( *. ppt)  .                                                                                                             

2.5 Μετατρέψτε τα αρχεία του Ms Powerpoint σε άλλες μορφές 
Το Ms Powerpoint προσφέρει μια μορφή (format) παρουσιάσεων που δεν είναι η καλύτερη για το
διαδίκτυο. Το αρχείο που δημιουργείται μπορεί να είναι μεγάλο  και απαιτείται οι χρήστες να έχουν το

http://office.microsoft.com/en-us/support/microsoft-office-compatibility-pack-for-word-excel-and-powerpoint-2007-file-formats-HA010168676.aspx
http://office.microsoft.com/en-us/support/microsoft-office-compatibility-pack-for-word-excel-and-powerpoint-2007-file-formats-HA010168676.aspx
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Microsoft Office ή ένα ειδικό πρόγραμμα (plugin) για να το  ανοίξουν. Ακολουθούν κάποιες άλλες
μορφές  που μπορεί να είναι  αποτελέσουν μια καλύτερη εναλλακτική λύση.

2.5.1 Εξαγωγή  PDF

Η μορφή του PDF είναι συχνά η καλύτερη μορφή για την εμφάνιση των παρουσιάσεων του Ms
Powerpoint στο διαδίκτυο. Το μέγεθος του αρχείου είναι σχετικά μικρό, οι εναλλαγές διαφανειών
διασπώνται (distracting slide transitions)  και μπορεί ο καθένας να έχει στη διάθεση του ένα
πρόγραμμα ανάγνωσης  PDF. Το σημαντικότερο είναι ότι η δομή  (heading structure ) και οι
πληροφορίες πρόσβασης παραμείνουν ανέπαφες . Αν έχετε μια παρουσίαση με πίνακες  και ξέρετε
να προσθέτετε πληροφορίες προσβασιμότητας με το Adobe Acrobat τότε μπορείτε  να
δημιουργήσετε ένα αρχείο PDF που είναι προσιτό από το αρχικό αρχείο PPT. Για περισσότερες
πληροφορίες σχετικά με τη δημιουργία των  αρχείων PDF από έγγραφα του Office θα βρείτε στο  
Δημιουργία Αρχείων PDF από αρχεία του Office  ή στο  Creating PDF files from Office documents-
εξωτερική σύνδεση  .

2.5.2 Δημιουργία διαφανειών  HTML                 

Σημαντικό
Πολλές εκδόσεις του Ms Powerpoint έχουν τη επιλογή Αποθήκευση ιστοσελίδας(Save As Web Page )
.  Αυτή η επιλογή θα πρέπει να αποφεύγεται γιατί δεν δημιουργεί περιεχόμενο με προσβασιμότητα
στη μορφή HTML.
Εάν είστε άνετοι με τα HTML και CSS  και το περιεχόμενό σας πρόκειται να εμφανιστεί στο διαδίκτυο,
θα μπορούσατε να εξετάσετε το ενδεχόμενο δημιουργίας δικών σας διαφανειών σε μορφή HTML. Θα
πρέπει να δημιουργήσετε τα δικά σας  κουμπιά (buttons) "επόμενο" και "προηγούμενο" και να
βεβαιωθείτε ότι οι συνδέσεις είναι ακριβείς. Η μέθοδος αυτή δεν είναι τόσο δύσκολη όσο φαίνεται.
Είναι πιο εύκολο να ξεκινήσετε με το περιεχόμενο του περιγράμματος (content in the outline panel )
και στη συνέχεια να προσθέσετε τις εικόνες  καθώς και  το οπτικό στυλ (visual styles). Δείγμα HTML
παρουσίασης   θα βρείτε στο σύνδεσμο sample HTML presentation -εξωτερική σύνδεση  .
Μπορείτε να δημιουργήσετε το  περίγραμμα HTML (HTML outline) εκτός του αρχείου του Ms
Powerpoint. Αυτό επιτρέπει  στους χρήστες να επανεξετάσουν τη διάρθρωση της παρουσίασης  χωρίς
να χρειαστεί να ανοιχθεί.. Για να δημιουργήσετε μια έκδοση HTML (HTML version),  αντιγράψτε τα
περιεχόμενα του πίνακα (Outline panel) και επικολλήστε τα  με ένα πρόγραμμα επεξεργασίας HTML
όπως το Dreamweaver.  Στη συνέχεια καθαρίστε το περιεχόμενο. Μπορείτε αν θέλετε να προσθέσετε
επιπλέον πληροφορίες στο περίγραμμα  όπως εικόνες με κατάλληλο εναλλακτικό κείμενο. Δείτε
παράδειγμα  HTML με περίγραμμα στη  παρουσίαση sample HTML outline - εξωτερική σύνδεση .

2.5.3 Χρήση άλλων εργαλείων προσβασιμότητας  

http://webaim.org/techniques/acrobat/converting#word
http://webaim.org/techniques/acrobat/converting#word
http://webaim.org/presentations/2010/jsaria/
http://webaim.org/presentations/2010/csun/WAVEintro.htm
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Υπάρχει αριθμός εργαλείων προσβασιμότητας που μπορούν να σας βοηθήσουν να δημιουργήσετε
περιεχόμενο με προσβασιμότητα για τον Παγκόσμιο Ιστό από τις παρουσιάσεις του Ms Powerpoint.
Τα πιο δημοφιλή εργαλεία είναι  τα ακόλουθα.

 Lecshare (http://lecshare.com/) είναι εργαλείο που επιτρέπει να προσθέσετε
συγχρονισμένο ήχο με αφήγηση (synchronized audio narration ) στις παρουσιάσεις
του Ms Powerpoint. Για αυτό μπορείτε να δείτε  βίντεο καθώς και διαφάνειες HTML
με ενσωματωμένο ήχο.

 Visual 508 Accessible Wizard(http://www.virtual508.com/index.html)  είναι
εργαλείο δημιουργίας εκδόσεων HTML με προσβασιμότητα για τις παρουσιάσεις του
Ms Powerpoint με τη διαφορά ότι δημιουργούνται πολυάριθμα αρχεία. Υπάρχουν οι
εκδόσεις του για το Office 2000-2003 και το 2007. Για το  2010 δεν αναφέρεται
κάτι σχετικό.Η προσβασιμότητα των αρχείων  PDF

2.6 Ορίζοντας  την  προσβασιμότητα     

2.6.1 Adobe, Acrobat και PDF

Πριν συζητήσουμε τη δυνατότητα πρόσβασης σε αρχεία PDF, αξίζει να συζητήσουμε τη  διάκριση που
υπάρχει μεταξύ  των   Adobe, Acrobat και PDF. Μερικές φορές  θα έχετε ακούσει  να
χρησιμοποιούνται εναλλακτικά αλλά όμως  δεν είναι ίδια.

 Η  Adobe είναι μια εταιρία που δημιούργησε το  Acrobat.

 Το Acrobat είναι ένα εργαλείο (tool) για τη δημιουργία , την επεξεργασία και τη
προβολή των αρχείων PDF.

 Το PDF είναι μια μορφή (format) ή ένας  τύπος  εγγράφου. Η  μορφή (format) του
δημιουργήθηκε από την εταιρεία Adobe και ξεχωρίζει για τη δυνατότητα μεταφοράς
του  (Portable Document Format) .

Μια σύγκριση καλή θα ήταν να γίνει μεταξύ των Adobe, Acrobat, PDF με  το Ms Word της Microsoft
και τα αρχεία κατάληξης doc.

Σημείωση
Το Adobe Reader είναι ένα βοήθημα που το βρίσκετε ελεύθερα  (free utility) και σας επιτρέπει να
διαβάσετε και να αποθηκεύεστε  αλλά όχι να επεξεργαστείτε τα αρχεία PDF. Διαβάστε περισσότερα
για τον  Adobe Reader και την Προσβασιμότητα στη  σύνδεση http://webaim.org/resources/reader/
Adobe Reader and Accessibility

http://lecshare.com/
http://www.virtual508.com/index.html
http://webaim.org/resources/reader/
http://webaim.org/resources/reader/
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2.6.2 Ετικέτες στα αρχεία PDF

Όταν μιλάμε  για αρχεία PDF με προσβασιμότητα, συνήθως εννοούμε τα  αρχεία  PDF με ετικέτες
(tagged PDF files), έστω και αν υπάρχουν περισσότερα σε ένα αρχείο  PDF με προσβασιμότητα από
ετικέτες. Οι ετικέτες  κάνουν τη διάρθρωση της παρουσίασης του PDF κειμένου  που γίνεται
αντιληπτή  από τους  αναγνώστες οθόνης (screen readers). Οι ετικέτες χρειάζονται μόνο  για τη
πρόσβαση και δεν φαίνονται (no visible effect ) στο αρχείο PDF.
Συνήθως  οι ετικέτες HTML και PDF  χρησιμοποιούν την ίδια  ονομασία  και οργάνωση δομών
(organization structures) αν και  είναι πολύ διαφορετικές. Είναι αδύνατον να εισάγετε ετικέτες PDF
σε κώδικα (code) , όπως θα  κάνατε στην  HTML. Ακόμα και αν έχετε  ευχέρεια στην HTML,  είναι
ευκολότερη η δημιουργία και επεξεργασία αρχείων  PDF με ετικέτες.
Δείτε επίσης :
A List Apart: Facts and Opinions About PDF Accessibility–από τον  Joe Clark
Επιστροφή Ορίζοντας τη Προσβασιμότητα

2.7 Μετατροπή εγγράφων σε μορφή PDF     

2.7.1 Επισκόπηση

Τα αρχεία PDF  δεν δημιουργούνται με  το Acrobat. Συνήθως δημιουργούνται με άλλο πρόγραμμα και
μετατρέπονται σε PDF. Υπάρχουν δεκάδες ή μάλλον εκατοντάδες προγράμματα που μπορούν να

δημιουργήσουν  αρχεία PDF αλλά πολύ λίγα εξ αυτών παράγουν  αρχεία PDF με ετικέτες  . Αν
χρησιμοποιείτε το Ms Word ή το Ms Powerpoint της Microsoft ή το OpenOffice.org  Writer, ή
εργαλεία της  Adobe  όπως το InDesign μπορείτε να δημιουργήσετε αρχεία PDF με προσβασιμότητα
που θα έχουν ετικέτες χωρίς να ανοίξετε το Acrobat. Η προσβασιμότητα των PDF εξαρτάται από τη
δυνατότητα πρόσβασης στο πρωτότυπο έγγραφο (original document).

2.7.2 Προϋποθέσεις  προσβασιμότητας για τις εκδόσεις του Ms Word

http://www.alistapart.com/articles/pdf_accessibility
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Σημείωση
Οι ρυθμίσεις προσβασιμότητας και  μετατροπής των  Ms Word και  Ms Powerpoint είναι βασικά ίδιες.
Μπορείτε να ακολουθήσετε τις παρακάτω οδηγίες του Ms Word για να μετατρέψετε τα αρχεία του
Ms Powerpoint σε αρχεία μορφής  PDF .
Στο διαδίκτυο  τα περισσότερα αρχεία PDF πιθανότατα έγιναν με το  Ms Word. Τα καλά νέα είναι ότι
είναι δυνατή η δημιουργία αρχείων PDF με προσβασιμότητα σε Office, εφόσον ικανοποιούνται οι
ακόλουθες προϋποθέσεις:

  Το αρχείο πρέπει να έχει προσβασιμότητα.  Να έχει εναλλακτικό κείμενο στις
εικόνες, κατάλληλες επικεφαλίδες (headings) , κατάλληλο κείμενο συνδέσμου (link
text), κλπ. Για περισσότερες πληροφορίες  διαβάστε Microsoft Word  .

 Οι χρήστες του Οffice 2000-2003 πρέπει να έχουν εγκατεστημένο το Acrobat  ως
πρόσθετο (add-in). Οι χρήστες του Office 2007 πρέπει να έχουν είτε το Acrobat είτε
εγκατεστημένο το πρόσθετο του Microsoft για  PDF.

 Το αρχείο πρέπει να εξάγεται  σωστά. Αν δημιουργείται τυπώνοντας το σε  PDF  τότε
δεν θα έχει  ορθά τοποθετημένες  (correctly tagged) τις  ετικέτες.

MS WORD 2000-2003

Κατά την εγκατάσταση του Adobe Acrobat, εγκαθίσταται ένα  πρόσθετο πρόγραμμα (add-in) της
Microsoft Office από προεπιλογή (default) . Αυτό σας επιτρέπει να μετατρέψετε τα αρχεία του Office
σε PDF χωρίς να ανοίξετε το  Acrobat. Επιπλέον αυτό το πρόσθετο εγκαθιστά το Adobe PDF μενού
που εμφανίζεται στη μπάρα των εργαλείων. Για να μετατρέψετε ένα έγγραφο του Ms Word σε PDF,
επιλέξτε Adobe PDF > Μετατροπή σε Adobe PDF (Adobe PDF > Convert to Adobe PDF) . Εάν το
έγγραφό σας είναι σωστά δομημένο, θα δημιουργηθεί αυτόματα ένα αρχείο PDF με ετικέτες. Για να
είσαστε σίγουροι  ότι η μετατροπή των  αρχείων θα γίνει σωστά, πηγαίνετε στο Adobe PDF >
Ρυθμίσεις  Αλλαγής Μετατροπής (Adobe PDF > Change Conversion Settings) και επιβεβαιώστε ότι
είναι επιλεγμένη η Ενεργή Προσβασιμότητα και  η Οπτική Διάταξη του αρχείου Adobe PDF με
ετικκέτες (Enable Accessibility  and Reflow  with  tagged  Adobe  PDF ).
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Εικόνα 27. Παράθυρο διαλόγου του Acrobat PDF  Maker   

MS WORD 2007

Πρόσθετο της  Αdobe (Adobe Αdd-in)
Έχοντας εγκαταστήσει το πρόσθετο πρόγραμμα (add-in) της Adobe  , μπορείτε να κάνετε με δύο
τρόπους την εξαγωγή σε PDF.
 Πρώτος τρόπος.

 Κάντε κλικ στο κουμπί Office (Office Button) ,  πατήστε την Αποθήκευση ως (Save
As) και επιλέξτε  Adobe PDF,  ή  πατήστε Alt + F, F, Α.
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Εικόνα 28 Καρτέλα  μετατροπής εγγράφου σε  αρχείο PDF με την επιλογή Αποθήκευση ως
 Δεύτερος τρόπος.

  Επιλέξτε Δημιουργία PDF (Create PDF)  από τη γραμμή των εργαλείων και τη
καρτέλα Acrobat (Acrobat ribbon). Μία από τις επιλογές θα ανοίξει το ίδιο παράθυρο
διαλόγου με το προηγούμενο τρόπο.

Εικόνα 29.  Μπάρα επιλογών εξαγωγής  σε  αρχείο PDF με την επιλογή δημιουργία PDF
Πριν κάνετε την αποθήκευση  , επιλέξτε Επιλογές μετατροπής Adobe σε  PDF (Adobe PDF
conversion options) και κάντε ενεργή τη Δημιουργία  αρχείου  PDF με ετικέτες προσβασιμότητας
(Create Accessible Tagged PDF file)  .
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Εικόνα 30. Παράθυρο διαλόγου  μετατροπής  εγγράφου PDF σε  έγγραφο PDF  με  ετικέτες

MS WORD 2010

Πρόσθετο του Adobe

Σημαντικό
To Πρόσθετο του Adobe προσφέρεται στους χρήστες που έχουν εγκαταστήσει το  Acrobat X και
κάνουν χρήση της  32-bit έκδοση του Office 2010.
Λέγεται και PDFMaker τo Πρόσθετο του Adobe και αποτελεί τη καλύτερη επιλογή για τη ποιότητα
των αρχείων PDF με ετικέτες. Μπορείτε να εξάγετε PDF  με δύο τρόπους αφού έχετε  εγκατεστημένο
το πρόσθετο.
Επίλεξε Αρχείο > Αποθήκευση ως PDF (File > Save as Adobe PDF)
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Εικόνα 31. Μενού Αρχείο του Ms Word 2010 για την αποθήκευση του εγγράφου σε PDF
Ή Επιλέγετε Δημιουργία PDF (Create PDF) από τη μπάρα του Acrobat

Εικόνα 32. Μπάρα εργαλείων του Ms Word 2010 για την αποθήκευση του εγγράφου σε PDF
Μια από τις επιλογές θα ανοίξει το  ίδιο παράθυρο διαλόγου. Το πρόγραμμα θα δημιουργήσει ένα
αρχείο PDF με ετικέτες. Αν δεν συμβαίνει από προεπιλογή τότε  επιλέξτε τις Προτιμήσεις
(Preferences)  από τη μπάρα και ενεργοποιήστε την επιλογή Αναδιάταξη με ετικέτα του αρχείου
Adobe PDF με προσβασιμότητα (Enable Accessibility and Reflow with tagged Adobe PDF).
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Εικόνα 33. Καρτέλα Ρυθμίσεων του Ms Word 2010 για την αναδιάταξη και τη προσβασιμότητα
αρχείου PFD με ετικέτες

Αποθήκευση ενός PDF με ετικέτες
Το  Word 2010 σας επιτρέπει να δημιουργήσετε αρχεία PDF με  ετικέτες χωρίς την εγκατάσταση του
Acrobat. Όμως μπορεί να μην είναι τόσο καλή η δημιουργία ετικετών με αυτό τον τρόπο και θα φανεί
στα επίπεδα των επικεφαλίδων, στις λίστες και στο εναλλακτικό κείμενο των εικόνων που θα



Παραγωγή Προσβάσιμου Εκπαιδευτικού Υλικού για Μαθητές με Αναπηρία

Σελίδα 52

εξαχθούν. Αν θελήσετε να επαληθεύσετε την προσβασιμότητα του PDF  ή να επεξεργαστείτε τις
ετικέτες που δημιουργούνται θα χρειαστείτε το  Acrobat Professional.
Για να κάνετε χρήση του πρόσθετου της Adobe  επιλέξτε Αρχείο > Αποθήκευση ως και επιλέξτε ως
τύπο τον  PDF. Πριν την αποθήκευση του αρχείου επιλέξτε τις Επιλογές για να διασφαλίσετε ότι οι
ετικέτες της δομής του εγγράφου για τη προσβασιμότητα έχουν επιλεγεί

Εικόνα 34. Μενού Επιλογών του Ms Word 2010 για ενεργοποίηση της δόμησης των ετικετών
αρχείου PFD  με προσβασιμότητα

Πρόσθετo της Microsoft (Add-In)
Υπάρχει ένα πρόσθετο δωρεάν  πρόγραμμα  (free Add–in)  της αποθήκευσης σε PDF ( Save as PDF
Add-in  ) για το Ms  Word 2007 που σας επιτρέπει να δημιουργήσετε αρχεία PDF με ετικέτες χωρίς
την εγκατάσταση του Acrobat. Η διαδικασία εξαγωγής σε PDF είναι ίδια. Αν θέλετε να επαληθεύσετε
την προσβασιμότητα ενός PDF ή να επεξεργαστείτε τις ετικέτες που δημιουργήσατε , θα χρειαστείτε
το Acrobat Professional.

http://www.microsoft.com/downloads/details.aspx?FamilyId=4D951911-3E7E-4AE6-B059-A2E79ED87041&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=4D951911-3E7E-4AE6-B059-A2E79ED87041&displaylang=en
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Για να κάνετε τη μετατροπή  σε PDF χρησιμοποιώντας το πρόσθετο πρόγραμμα της Microsoft
(Microsoft add-in), κάντε κλικ στο κουμπί Office (Office Button)  , πατήστε Αποθήκευση ως (Save
As) και επιλέξτε PDF, ή πατήστε Alt + F , F , P.

Εικόνα 35. Μενού επιλογών  μετατροπής  εγγράφου σε  έγγραφο PDF με πρόσθετο της
Microsoft

Πριν κάνετε την αποθήκευση του αρχείου , ανοίξτε  το παράθυρο Επιλογές (Options) και
εξασφαλίστε ότι έχει επιλεχθεί το Έγγραφο με ετικέτες με δομή προσβασιμότητας (Document
structure tags for accessibility )
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Εικόνα 36. Παράθυρο διαλόγου Επιλογές για τη   δημιουργία  εγγράφου  με ετικέτες                  

2.7.3 Ο κειμενογράφος  OpenOffice.org

Για την αποθήκευση  ενός αρχείου  σε PDF με ετικέτες, επιλέγετε  Αρχείο > Εξαγωγή ως PDF (File >
Export as PDF) , πληκτρολογείτε το όνομα του PDF αρχείου και συνέχεια επιλέγετε πού θα θέλατε να
το αποθηκεύεστε. Επιλέξτε Αποθήκευση (Save)  και ένα δεύτερο παράθυρο θα ανοίξει με τον τίτλο
Επιλογές PDF (PDF Options ).
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Εικόνα 37. Παράθυρο διαλόγου των  Επιλογών του   PDF
Υπάρχουν αρκετές επιλογές που θα μπορούσατε να αλλάξετε, αλλά το μόνο που αφορά την
προσβασιμότητα είναι το κουμπί ελέγχου (check box) που έχει  την επιλογή PDF με ετικέτες (Tagged
PDF). Αυτό πρέπει να επιλεγεί για να  έχει το αρχείο προσβασιμότητα. Η επιλογή αυτή δεν είναι
προεπιλεγμένη , αλλά παραμένει επιλεγμένη, αφού την  επιλέξετε για  πρώτη φορά.

Σ η μ α ν τ ι κ ό

Υπάρχει το εικονίδιο με την ονομασία PDF στη γραμμή των εργαλείων (menu bar )   ( )που επιτρέπει
να αποθηκεύετε ένα αρχείο ως PDF χωρίς να χρειαστεί να ανοίξετε το παράθυρο Επιλογές (Options)
. Πρέπει να  επιβεβαιώσετε  ότι η επιλογή PDF με ετικέτες (Tagged PDF) έχει γίνει ενεργή στο
παράθυρο διαλόγου PDF Επιλογές (PDF Options), πριν  χρησιμοποιηθεί το εικονίδιο   , αλλιώς  το
αρχείο σας δεν θα αποθηκευτεί ως αρχείο  PDF με  ετικέτες.
Το Adobe Acrobat Professional είναι απαραίτητο αν θελήσετε να τροποποιήσετε αρχείο PDF με
ετικέτες. Mόνο με το κειμενογράφο δεν γίνεται να δημιουργήσετε  ένα αρχείο με σωστές ετικέτες
PDF. Για παράδειγμα, ένα έγγραφο με σύνθετους πίνακες ή φόρμες (complex tables or forms), ή με
μια διάταξη πολλαπλών στηλών (multi-column layout) μπορεί να χρειαστεί να ολοκληρωθεί  με  τη
διαδικασία προσθήκης ετικετών  με το  Acrobat Pro.

2.7.4 Μετατρέψτε αρχείο Ms Word σε  PDF με  Acrobat

Εάν αντιμετωπίσετε στο Office  πρόβλημα κατά τη μετατροπή εγγράφου σε  έγγραφο PDF με
ετικέτες, ή αν θελήσετε  να συγχωνεύσετε  πολλαπλά έγγραφα σε ένα αρχείο PDF με ετικέτες ,
μπορείτε με το  Acrobat να μετατρέψετε το αρχείο σε μορφή PDF. Υπάρχουν αρκετοί τρόποι για  να
γίνει αυτό. Ένας εύκολος τρόπος  είναι να επιλέξτε Αρχείο> Δημιουργία PDF > Από αρχείο (File >
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Create PDF > From File.). Αν το αρχείο έχει την κατάλληλη μορφή (format ) (π.χ δημιουργήθηκε με
προϊόν της   Microsoft ή της Adobe), αποκτά ετικέτες (tags) καθώς αυτό μετατρέπεται. Εάν δεν
υπάρχουν ετικέτες επιλέξτε κατά σειρά Επεξεργασία> Προτιμήσεις> Μετατροπή σε PDF (Edit >
Preferences > Convert to PDF). Στη  συνέχεια την επιλογή Μετατροπές Ρυθμίσεις (Conversions
Settings) και τέλος κάντε ενεργή τη Δυνατότητα πρόσβασης και  Οπτικής Διάταξης (Enable
accessibility and Reflow).

Εικόνα 38. Παράθυρο διαλόγου των ρυθμίσεων  της μετατροπής αρχείου Ms Word  σε PDF
 Αν θέλετε να συνδυάσετε πολλαπλά αρχεία σε ένα αρχείο PDF, επιλέξτε Αρχείο > Δημιουργία PDF>
Από πολαπλά αρχεία (File > Create PDF > From Multiple Files) . Θα εμφανιστεί ένα πλαίσιο
διαλόγου. Επιλέξτε κατά σειρά Επιλογές (Options ) και το Πάντα επιτρέπετε η προσβασιμότητα και
η Οπτική Διάταξη  Περιεχομένου(Always enable accessibility and Reflow).

Εικόνα 39. Παράθυρο διαλόγου για τη Μετατροπή των  Ρυθμίσεων  των  Επιλογών της
προσβασιμότητας και της οπτικής διάταξης περιεχομένου

Επιστροφή Μετατροπή Αρχείων σε μορφή PDF

2.8 Acrobat X και Προσβασιμότητα

2.8.1 Εισαγωγή



Παραγωγή Προσβάσιμου Εκπαιδευτικού Υλικού για Μαθητές με Αναπηρία

Σελίδα 57

Υπάρχουν  πολλά προγράμματα που  μπορείτε να χρησιμοποιήσετε για να δημιουργήσετε αρχεία PDF
με προσβασιμότητα. Υπάρχει όμως  το  Acrobat Professional που  σας επιτρέπει να αξιολογήσετε , να
διορθώσετε  και να αυξήσετε την προσβασιμότητα των  αρχείων PDF.    

Σημείωση
Αυτή η παράγραφος θα περιγράψει τα χαρακτηριστικά-δυνατότητες  προσβασιμότητας του Acrobat
X. Αν χρησιμοποιείτε προηγούμενη έκδοση του Acrobat τότε να διαβάσετε την επόμενη παράγραφο
που αναφέρεται στη προσβασιμότητα του Acrobat 7-9.

ΤΙ ΝΈΟ ΈΧΕΙ ΤΟ ACROBAT X

Το Acrobat Χ έχει αρκετά νέες και βελτιωμένες δυνατότητες προσβασιμότητας όπως  :
 Έχει Οδηγό Δράσης (Action Wizard) που καθοδηγεί τους χρήστες στις πολύπλοκες

διαδικασίες όπως τη δημιουργία  αρχείων PDF με προσβασιμότητα.

 Κάνει καλύτερη μετατροπή (conversion) από PDF σε άλλες μορφές (formats).
Ιδιαίτερα στα αρχεία Ms Word.

 Έχει βελτιωμένο τρόπο ανίχνευσης πεδίων. Αν έχετε δημιουργήσει μια φόρμα με
κάποιο πρόγραμμα όπως το Ms Word , το Acrobat συνδέει αυτόματα τις ετικέτες με
τα παρακείμενα πεδία της φόρμας.

 Βελτιώνει τη προσβασιμότητα της διεπαφής  πληκτρολογίου με  Acrobat

 Έχει την ικανότητα να δημιουργεί  PDF Χαρτοφυλάκια (Portfolios)  με
προσβασιμότητα

2.8.2 Πλαίσιο Ετικετών (Tags Panel)

Το πλαίσιο ετικετών (Tags panel) σας δίνει τη δυνατότητα να δείτε, να αναδιατάξετε, να
μετονομάσετε, να τροποποιήσετε, να διαγράψετε και να δημιουργήσετε ετικέτες. Για να δείτε το
πλαίσιο ετικετών επιλέξτε Προβολή > Εμφάνιση / Απόκρυψη > Πλαίσια Πλοήγησης > Ετικέτες (View
>  Show / Hide > Navigation Panes > Tags)
Όταν  επεκτείνετε  τις <Tags> και <Sect> ένας μακρύς κατάλογος από ετικέτες θα εμφανιστεί.
Αυτός ο κατάλογος μοιάζει με λίστα που  μπορεί  να επεκταθεί και να διασπαστεί με το ποντίκι ή το
πληκτρολόγιο.
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Εικόνα 40.  Καρτέλες των Ετικετών εγγράφου 
Πολλές από τις ετικέτες μοιάζουν με αυτές της HTML αλλά δεν ταυτίζονται. Οι πιο γνωστές ετικέτες
περιγράφονται στο παρακάτω πίνακα :

Πίνακας 1  Πίνακας με τη περιγραφή και την εκπροσώπηση των  ετικετών  του  Acrobat
Ετικέτα Εκπροσωπεί Περιγραφή / Σημείωση
<H1> to <H6> Επικεφαλίδα
<P> Παράγραφο
<L> Λίστα Όμοια με <ul> ή <ol> της HTML
<LI> Στοιχείο Λίστας Θα πρέπει να είναι ένθετο (nested) όπως στη

HTML. Και το κάνει πολύ συγκεχυμένο (very
confusing)

<Table>, <TH>,
<TR>, και <TD>

Πίνακας, Γραμμή πίνακα,
Επικεφαλίδα πίνακα, Πίνακας
δεδομένων

<Figure > Εικόνα Όμοιο με το <img> της ετικέτας  της HTML

ΕΠΙΣΉΜΑΝΣΗ ΠΕΡΙΕΧΟΜΈΝΟΥ(HIGHLIGHT CONTENT)
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Ένα από τα πρώτα πράγματα που πρέπει να κάνετε στο πλαίσιο των ετικετών  είναι να επιλέξετε την
επιλογή Επισήμανση Περιεχομένου (Highlight content) από το μενού Επιλογές (Options menu).
Όταν κάνετε την επιλογή αυτή και επιλέξετε μια  ετικέτα,  θα επισημανθεί  το αντίστοιχο κείμενο ή η
αντίστοιχη εικόνα ή όποιο άλλο στοιχείο του αρχείου PDF.

Εικόνα 41.   Μενού επεξεργασίας Ετικετών με  επιλεγμένη την Επισήμανση Περιεχομένου

ΕΎΡΕΣΗ ΕΤΙΚΈΤΑΣ ΜΕ ΕΠΙΛΟΓΉ

Όπως  επισημαίνεται το περιεχόμενο του  «σώματος» του PDF  όταν επιλέγετε μια ετικέτα έτσι
υπάρχει και ο αντίστροφος τρόπος. Να επισημαίνεται  η ετικέτα που αντιστοιχεί στο επιλεγμένο

κείμενο. Αρχικά επιλέξτε το  εργαλείο Επιλογής (Select Tool) . Στη συνέχεια επιλέξτε το τμήμα του
κειμένου ή μια εικόνα ή ένα πίνακα. Τέλος επιλέξτε το μενού Επιλογές (Options) που είναι στη κορυφή
του πλαισίου Ετικέτες (Tags Panel). Στη συνέχεια επιλέξτε Εύρεση Ετικέτας  (Find Tag) για να
αναδείξετε την ετικέτα ή τις ετικέτες που περιλαμβάνονται στο προηγούμενο επιλεγμένο κείμενο σας.

ΑΛΛΑΓΉ ΕΤΙΚΕΤΏΝ

Μερικές φορές θα συναντήστε αρχεία PDF με εσφαλμένες ετικέτες. Μπορείτε να τις τροποποιήσετε
κάνοντας δεξί κλικ στην ετικέτα που θα θέλατε να αλλάξετε. Στη συνέχεια επιλέγοντας τις Ιδιότητες
και τη καρτέλα Ετικέτα μπορείτε να δώσετε το νέο τύπο ετικέτας επιλέγοντας τον από τη
αναδιπλούμενη λίστα του πεδίου Τύπος. Για παράδειγμα,  για να αλλάξετε μια ετικέτα από <Normal>
σε <Η1> κάνετε τα ακόλουθα. Πρώτα την επιλέγετε και κάνετε δεξί κλικ πάνω της. Στη συνέχεια,
επιλέξτε Ιδιότητες και από τη λίστα του πεδίου Τύπος (Type) επιλέξτε  το τύπο Επικεφαλίδα
επιπέδου 1.



Παραγωγή Προσβάσιμου Εκπαιδευτικού Υλικού για Μαθητές με Αναπηρία

Σελίδα 60

Εικόνα 42. Παράθυρο διαλόγου των ιδιοτήτων του Φτιαξίματος  ετικετών με ενεργή τη καρτέλα
Ετικέτα

ΠΡΟΣΘΉΚΗ ΕΤΙΚΕΤΏΝ ΣΕ ΈΓΓΡΑΦΟ ΠΟΥ ΔΕΝ ΈΧΕΙ ΕΤΙΚΈΤΕΣ

Αν δεν βλέπετε ετικέτα ή ετικέτες στο πίνακα ετικέτες τότε το έγγραφο σας είναι χωρίς ετικέτες και
θα χρειαστεί να μετατρέψετε το αρχείο σας με ετικέτες. Για να προσθέσετε ετικέτες σε αρχείο που
δεν έχει ετικέτες , επιλέξτε Εργαλεία από μενού που βρίσκεται πάνω δεξιά  και στη συνέχεια επιλέξτε
Προσβασιμότητα > Προσθήκη ετικετών στο έγγραφο (Accessibility>Add Tags to Document).
Μερικές φορές αυτή η διαδικασία είναι χρονοβόρα και ενδεχομένως  να χρειαστεί κάποιες από τις
ετικέτες να τις επεξεργαστείτε. Αυτό για αρχή  θα είναι πιο γρήγορο από ότι να κάνετε όλη τη δουλειά
χειροκίνητα. Αυτό ιδιαίτερα έχει μεγάλη σημασία αν το έγγραφο σας περιέχει πίνακες.

2.8.3 Εργαλείο Φτιαξίματος Σειράς Ανάγνωσης (TouchUp Reading Order)

Το εργαλείο Φτιαξίματος Σειράς Ανάγνωσης δίνει τη δυνατότητα στο χρήστη να προσθέτει και να
επεξεργάζεται τις ετικέτες ενός PDF αρχείου γρήγορα. Ακόμη του δίνει τη δυνατότητα να βλέπει τη
σειρά ανάγνωσης των στοιχείων της σελίδας. Παρόλα που επιταχύνει τη διαδικασία προσθήκης
ετικετών , δεν υποκαθιστά τα άλλα εργαλεία που αναφέρθηκαν προηγούμενα.
Για να χρησιμοποιήσετε  το Φτιάξιμο Σειράς Ανάγνωσης  επιλέξτε Εργαλεία από το δεξιά πάνω μενού
και  στη συνέχεια επιλέξτε Προσβασιμότητα > Φτιάξιμο Σειράς Ανάγνωσης(Accessibility>TouchUp
Reading Order) . Όταν επιλεγεί αυτή η δυνατότητα, η όψη της οθόνης αλλάζει. Όλο το περιεχόμενο
είναι κλεισμένο (enclosed) σε  πλαίσια που έχουν αρίθμηση (numbered boxes).Κάθε πλαίσιο
αντιπροσωπεύει μια ετικέτα και ο αριθμός της αντιστοιχεί στον αριθμό της ετικέτας στο πλαίσιο της
Διάταξης (Order panel).Το παράθυρο του Φτιαξίματος Σειράς Ανάγνωσης παραμένει ανοικτό.
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Εικόνα 43.  Καρτέλα Φτιαξίματος Σειράς Ανάγνωσης

Σημείωση
Αν είναι  ανοικτή η καρτέλα του Φτιαξίματος Σειράς Ανάγνωσης και δεν δείτε κάποιο  πλαίσιο τότε
πιθανόν το PDF έγγραφο σας  να μην έχει ετικέτες.
Θα δείτε  μια ομάδα κουμπιών με τα ονόματα των πιο γνωστών ετικετών. Μπορείτε να
χρησιμοποιήσετε τα κουμπιά αυτά για να αντιστοιχίσετε τις ετικέτες σε ένα επιλεγμένο τμήμα
κειμένου ή σε ένα αντικείμενο.
Το εργαλείο Φτιάξιμο Σειράς Ανάγνωσης δεν είναι τέλειο. Η επιλογή του κειμένου γίνεται  δύσκολα και
υπάρχουν  πολλές ετικέτες  που δεν τις υποστηρίζει. Επίσης είναι κάπως δύσκολο να εκχωρηθεί
εναλλακτικό κείμενο στις εικόνες. Παρόλα αυτά η επισήμανση του PDF κειμένου γίνεται πιο εύκολα
από οποιοδήποτε άλλο τρόπο.
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ΠΡΟΣΘΈΤΩ / ΑΛΛΆΖΩ ΕΤΙΚΈΤΕΣ

Υπάρχουν δυο τρόποι για να επιλέξετε μια περιοχή κειμένου , εικόνας, πίνακα ή άλλο στοιχείο
χρησιμοποιώντας το εργαλείο Φτιάξιμο Σειράς Ανάγνωσης.

 Χρησιμοποιώντας  την επιλογή  σταυρός   που αντικαθιστά το δείκτη του ποντικιού
   επιλέγεις ένα  στοιχείο σέρνοντας το δείκτη γύρω από αυτό σχηματίζοντας το
πλαίσιο επιλογής (drag box).  Μερικές φορές είναι δύσκολο να επιλέξετε ολόκληρο το
στοιχείο αλλά γίνεται ευκολότερα αν προσπαθήσετε να σχηματίσετε ένα πλαίσιο
επιλογής μεγαλύτερο από το στοιχείο. Αφού το επιλέξετε μπορείτε να του ορίσετε
μερικές από τις γνωστές ετικέτες κάνοντας κλικ σε ένα από τα πολλά κουμπιά.

 Μπορείτε  να επιλέξετε όλα τα στοιχεία σε ένα πλαίσιο , αρκεί να κάνετε κλικ στον
αριθμό που είναι στην επάνω αριστερή γωνία.  

Τώρα που έχετε επιλέξει το κείμενο, μπορείτε να ορίσετε μια ετικέτα κάνοντας κλικ στο αντίστοιχο
κουμπί. Το Acrobat θα τοποθετήσει στο επιλεγμένο κείμενο τη κατάλληλη ετικέτα. Αν έχετε ανοικτό το
πλαίσιο των ετικετών (Tags panel)  θα δείτε να προβάλλονται  οι αλλαγές  αμέσως.
Ενώ χρησιμοποιείτε το Φτιάξιμο Σειράς Ανάγνωσης,   μπορείτε να ορίσετε  εναλλακτικό κείμενο στις
εικόνες κάνοντας δεξί κλικ και επιλέγοντας την Επεξεργασία Εναλλακτικού Κείμενου (Edit Alternate
Text).

Πίνακας 2  Τα Κουμπιά και Ετικέτες  του Φτιαξίματος Σειράς Ανάγνωσης
Κουμπί Ετικέτα Adobe Επιπλέον πληροφορίες
Text / Κείμενο <P>
Form Field / Πεδίο
Φόρμας

<Form>

Heading 1/
Εικεφαλίδα 1

<H1>

Heading 2 /
Επικεφαλίδα 2

<H2>

Heading 3 /
Επικεφαλίδα 3

<H3>

Figure / Εικόνα <Figure>
F i g u r e / C a p t i o n
Εικόνα / Λεζάντα

< F i g u r e >
<Caption>

Αν επιλέξετε μια εικόνα και την κοντινή της λεζάντα,
τότε η εικόνα θα πάρει ετικέτα την ίδια με το κείμενο της
λεζάντας

Table /  Πίνακας <Table>, <TR>, Το Acrobat εκχωρεί γραμμές, στήλες και επικεφαλίδες.



Παραγωγή Προσβάσιμου Εκπαιδευτικού Υλικού για Μαθητές με Αναπηρία

Σελίδα 63

<TH> και <TD> Μερικές φορές γίνεται  σωστά αλλά θα πρέπει να
ελεγχθεί με τον  Ελεγκτή Πίνακα (Table Inspector)

Cell / Κελί <TD> Χρησιμοποιείτε για τη συγχώνευση κατά λάθος
διασπασμένων κελιών 

Formula / Τύπος <Formula>
Background /
Υπόβαθρο-Φόντο

None Ονομάζεται  το εργαλείο που κρύβει τα αντικείμενα από
τον αναγνώστη οθόνης.

ΠΛΑΊΣΙΟ ΔΙΆΤΑΞΗΣ(ORDER PANEL)

Το πλαίσιο Διάταξης σας επιτρέπει να αλλάξετε τη σειρά ανάγνωσης του περιεχομένου μιας σελίδας
ώστε να ταιριάζει με την οπτική σειρά ανάγνωσης. Για να ανοίξετε το πλαίσιο Διάταξης , επιλέξτε
Προβολή> Εμφάνιση /Απόκρυψη> Πλαίσια Πλοήγησης  > Διάταξη (View > Show / Hide > Navigation
Panes > Order ή επιλέξτε Εμφάνιση Πλαισίου Διάταξης (Show Order Panel) στο Φτιάξιμο Σειράς
Ανάγνωσης.

Εικόνα 44. Μενού καρτέλας Διάταξης των στοιχείων μιας σελίδας του αρχείου Hello all.pdf

Με τη πρώτη ματιά μοιάζει με το πλαίσιο των ετικετών , αλλά υπάρχουν διαφορές.
 Το έγγραφο χωρίζεται σε σελίδες
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 Κάθε στοιχείο έχει τον αριθμό του και η αρίθμηση των στοιχείων ξεκινά από την
αρχή κάθε σελίδας

 Δεν γίνεται η ιεράρχηση των στοιχείων και  όλα είναι στο  ίδιο επίπεδο

Αυτές οι διαφορές θα βοηθήσουν να γίνει πολύ πιο εύκολη η διάταξη των ετικετών μέσω του πλαισίου
Διάταξης. Για να αλλάξετε τη σειρά ανάγνωσης ενός στοιχείου, απλά κάντε κλικ στην ετικέτα του
στοιχείου και σύρετε  την στη  θέση της  σωστής σειράς ανάγνωσης. Η αλλαγή θα γίνει ορατή στο
πλαίσιο των Ετικετών (Tags panel) όταν το έγγραφο προβάλετε σε Οπτική Διάταξη (Reflow mode) .

ΕΝΑΛΛΑΚΤΙΚΌ ΚΕΊΜΕΝΟ

Με το εργαλείο Φτιαξίματος Σειράς Ανάγνωσης (TouchUp Reading Order) μπορείτε να προσθέσετε
εναλλακτικό κείμενο σε εικόνα πολύ εύκολα. Όταν μια εικόνα έχει ετικέτα το εναλλακτικό της κείμενο
εμφανίζεται δίπλα στην εικόνα. Αν όμως δεν έχει εναλλακτικό κείμενο, υπάρχει λεζάντα που θα λέει
ότι «Στην εικόνα δεν υπάρχει εναλλακτικό κείμενο» 

Εικόνα 45.  Εικόνα με την επισήμανση «χωρίς εναλλακτικό κείμενο»
Για να προσθέσετε εναλλακτικό κείμενο , κάντε δεξί κλικ πάνω στην εικόνα και επιλέξτε Επεξεργασία
εναλλακτικό κείμενο (Edit Alternate text).  Στη συνέχεια πληκτρολογήστε το εναλλακτικό κείμενο στο
πλαίσιο που εμφανίζεται.

ΠΊΝΑΚΑΣ ΕΛΈΓΧΟΥ

Ο Πίνακας Ελέγχου σας επιτρέπει να εντοπίσετε και να εκχωρήσετε το πεδίο εφαρμογής (scope) στις
επικεφαλίδες πίνακα.
Επιλέξτε ένα πίνακα με ανοικτό το παράθυρο του εργαλείου  Φτιαξίματος Σειράς Ανάγνωσης. Στη
συνέχεια επιλέγετε Πίνακας Ελέγχου (Table Inspector). Τώρα μπορείτε να επιλέξετε τα κελία του
πίνακα που θα γίνουν επικεφαλίδες κάνοντας δεξί κλικ σε ένα επιλεγμένο κελί ή κελιά και επιλέγοντας
Πίνακας Ιδιοτήτες Κελιού (Table Cell Properties). Ένα πλαίσιο διαλόγου θα εμφανιστεί.
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Εικόνα 46. Καρτέλα των Ιδιοτήτων κελιού  πίνακα
Επιλέξτε Επικεφαλίδα Κελί αν θέλετε τα επιλεγμένα κελία ή κελί να έχουν ετικέτα επικεφαλίδας.
Επίσης πρέπει να ορίσετε το πεδίο «scope» είτε ως Γραμμή είτε ως Στήλη. Πατώντας ΟΚ  θα δείτε τα
κελιά του πίνακα που έχουν οριστεί ως επικεφαλίδες να τονίζονται με κόκκινο χρώμα και τα κελιά των
δεδομένων να τονίζονται με γκρι χρώμα .

Εικόνα 47. Παράδειγμα  πίνακα με χρωματισμένα κελιά , τα κόκκινα κελιά είναι Επικεφαλίδες
και τα γκρι κελιά είναι Δεδομένα 

ΑΝΤΙΚΕΊΜΕΝΑ ΠΟΥ ΔΕΝ ΔΙΑΒΆΖΟΝΤΑΙ ΑΠΌ ΤΟΝ ΑΝΑΓΝΏΣΤΗ ΟΘΌΝΗΣ

Είναι στοιχεία  που αγνοούνται από το  πρόγραμμα ανάγνωσης οθόνης. Μοιάζουν με   εικόνα  χωρίς
εναλλακτικό  κείμενο  που  αγνοείται στη μορφή  HTML. Ποτέ κείμενο που θεωρείτε σημαντικό  δεν
πρέπει  να  χαρακτηρίζεται  ως  ένα  τέτοιο  αντικείμενο. Όπως και με το  εναλλακτικό κείμενο, ο
ευκολότερος  τρόπος για να αλλάξει  ένα στοιχείο σε  αντικείμενο  που  δεν διαβάζεται  γίνεται  με  το
εργαλείο   Φτιάξιμο Σειράς Ανάγνωσης  (Touchup  Reading Order) . Για να γίνει αυτό, επιλέξτε το
στοιχείο και πατήστε το κουμπί Μεταφορά Πίσω (Background).Για να αναζητήσετε κάποιο
αντικείμενο που δεν διαβάζεται , από τη καρτέλα Ετικέτες επιλέξτε Επιλογές> Εύρεση (Options>
Find). Θα εμφανιστούν διάφορες επιλογές αναζήτησης. Η αναζήτηση του αντικειμένου που δεν
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φαίνεται  είναι η εξ ορισμού επιλεγμένη, οπότε κάντε κλικ στο κουμπί Εύρεση(Find). Αν υπάρχουν
αρκετά τέτοια αντικείμενα , η αναζήτηση θα τα εντοπίσει  και θα σας επιτρέψει να τα αλλάξετε.
Για να αλλάξετε μια ετικέτα σε τέτοιο αντικείμενο πάτε στην καρτέλα  Ετικέτες, κάντε δεξί κλικ πάνω
στο αντικείμενο και επιλέξτε Αλλαγή της ετικέτας  σε Αντικείμενο που δεν φαίνεται (Change Tag to
Airfact).

2.8.4 Άλλα εργαλεία και δυνατότητες

ΜΕΤΑΤΡΟΠΉ ΣΑΡΩΜΈΝΟΥ ΚΕΊΜΕΝΟΥ

Για να δημιουργήσετε ένα αρχείο PDF με ετικέτες θα πρέπει να εξασφαλίσετε ότι περιέχει πραγματικό
κείμενο (real text). Αν δεν έχει πραγματικό κείμενο πρέπει,  είτε να το μετατρέψετε ξανά  με το
Acrobat  εφόσον έχετε το πρωτότυπο είτε να το μετατρέψετε σε πραγματικό κείμενο κάνοντας τα
ακόλουθα. Επιλέξτε Εργαλεία (Tools) από τη  δεξιά πλευρά της  μπάρας και στη συνέχεια επιλέξτε
Αναγνώριση Κειμένου (Recognize Text).  Η ποιότητα του κειμένου εξαρτάται από τη ποιότητα του
πηγαίου εγγράφου  (source document). Αυτή η μετατροπή συνήθως γίνεται αρκετά καλά αρκεί να το
έγγραφο να είναι καθαρό. Ο καθαρισμός του εγγράφου γίνεται επιλέγοντας Εύρεση Όλων των
Ύποπτων χαρακτήρων (Find All Suspects)  από το μενού Αναγνώριση Κειμένου (Recognize Text).

ΓΡΉΓΟΡΟΣ ΈΛΕΓΧΟΣ

Το Acrobat Professional περιλαμβάνει δύο διαφορετικούς Ελέγχους  Πρόσβασης. O πρώτος έλεγχος
είναι  ο Γρήγορος Έλεγχος (Quick Check) που δεν είναι τόσο χρήσιμος όσο ακούγεται. Ο Γρήγορος
Έλεγχος σας πληροφορεί αν το αρχείο έχει ετικέτες ή όχι. Δεν προσδιορίζει  βασικά λάθη, όπως την
έλλειψη εναλλακτικού κειμένου. Για να εκτελέσετε το Γρήγορο Έλεγχο επιλέξτε Για προχωρημένους>
Προσβασιμότητα> Γρήγορος Έλεγχος (Advanced> Accessibility>Quick Check)

ΠΛΉΡΗΣ ΈΛΕΓΧΟΣ

Για πιο  προχωρημένο έλεγχο  κάντε τα ακόλουθα. Από το μενού Για Προχωρημένους>
Προσβασιμότητα> Πλήρης έλεγχος (Advanced> Accessibility> Full Check) . Ο έλεγχος αυτός είναι
πιο λεπτομερής  από αυτόν του Γρήγορου Ελέγχου. Απέχει πολύ από τον ολοκληρωτικό Έλεγχο.
Αναγνωρίζει γνωρίσματα, όπως αν λείπει εναλλακτικό κείμενο στοιχείου και προσφέρει συμβουλές για
το πώς διορθώνονται κάποια λάθη.

ΟΠΤΙΚΉ ΔΙΆΤΑΞΗ ΠΕΡΙΕΧΟΜΈΝΟΥ(REFLOW)

Όπως στην  HTML,  έτσι και το διάβασμα  ενός εγγράφου  PDF με το πρόγραμμα ανάγνωσης οθόνης
γίνεται με  βάση τη σειρά των ετικετών. Η σειρά των ετικετών στο PFD μπορεί να μην είναι η ίδια με
την οπτική σειρά ανάγνωσης. Αυτό είναι ιδιαίτερα πιθανό εάν το PDF περιέχει πολλές στήλες ή άλλα
τμήματα κειμένου(blocks of text) ή έχει σύνθετες ένθετες λίστες. Το εργαλείο οπτικής διάταξης
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περιεχομένου (Reflow) με βάση τη σειρά των ετικετών σας επιτρέπει να δείτε την οπτική διάταξη του
περιεχομένου του εγγράφου όπως καθορίζει η σειρά των ετικετών. Επιλέξτε Προβολή >  Μεγέθυνση
> Οπτική Διάταξη Περιεχομένου (View >Zoom>Reflow ή Ctrl + 4). Αν το  έγγραφο ενώ είναι σε
προβολή οπτικής διάταξης δεν εμφανίζεται με τη σωστή σειρά θα πρέπει να αλλάξει η  σειρά των
ετικετών .

ΣΥΝΘΈΤΗΣ ΦΩΝΉΣ(READ OUT LOUD)

Ο  συνθέτης αυτός υπάρχει στο  Adobe Reader και στο Acrobat. Διαβάζει το περιεχόμενο ενός
εγγράφου PDF όπως κάνει και ο αναγνώστης  οθόνης. Για περισσότερες πληροφορίες δείτε το  άρθρο
Read Out Loud section in the WebAIM article on Adobe Reader

ΟΔΗΓΌΣ  ΔΡΆΣΗΣ

Ένα από τα πιο ενδιαφέροντα γνωρίσματα του Acrobat X είναι ο Οδηγός  Δράσης (Action Wizard).
Αυτός αυτοματοποιεί τις διαδικασίες πολλαπλών βημάτων, όπως και τη δημιουργία αρχείου PDF με
προσβασιμότητα. Ο Οδηγός Δράσης δεν δίνει προσβασιμότητα σε αρχείο PDF  που δεν έχει  αλλά θα
βοηθάει   δείχνοντας τα αναγκαία βήματα.
Για να κάνεις χρήση του Οδηγού Δράσης επιλέξτε Εργαλεία και στη συνέχεια Οδηγός Δράσης >
Δημιουργία PDFs με προσβασιμότητα ( Action Wizard > Create Accessible PDFs). Ο Οδηγός
Δράσης θα σας καθοδηγήσει  με  τα παρακάτω βήματα :

 Προσθήκη Περιγραφής στο έγγραφο

 Οδηγίες

 Κατάργηση Κρυφών Πληροφοριών

 Προσθήκη ετικετών στο έγγραφο

 Έλεγχος Πρόσβασης (Πλήρης)

http://webaim.org/resources/reader/#outloud
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Εικόνα 48. Καρτέλα Οδηγού  Δράσης για τη δημιουργία αρχείων PDF με προσβασιμότητα
Αν ολοκληρωθεί με επιτυχία το κάθε βήμα από τα παραπάνω, η τελική μορφή του PDF θα έχει
προσβασιμότητα. Ακόμη μπορεί να γίνει προσαρμογή του Οδηγού Δράσης (custom Action Wizards).
Για παράδειγμα ένα σαρωμένο έγγραφο μπορεί να γίνει σε μορφή PDF  με προσβασιμότητα.
Επιστροφή σε Acrobat X και Προσβασιμότητα

2.9   Προσβασιμότητα στο Acrobat  
Υπάρχουν  πολλά προγράμματα με τα οποία μπορείτε να δημιουργήσετε αρχεία PDF με
προσβασιμότητα. Όμως υπάρχει το  Acrobat Professional που  σας επιτρέπει να αξιολογήσετε , να
διορθώσετε  και να αυξήσετε την προσβασιμότητα των  αρχείων PDF.    

Σημείωση
Αυτή η παράγραφος θα καλύψει τη προσβασιμότητα των εκδόσεων του Acrobat 7-9. Για
περισσότερες πληροφορίες επισκεφτείτε τη διεύθυνση
http://webaim.org/techniques/acrobat/acrobat  . Για θέματα προσβασιμότητας  της  μορφής PDF
και τη μετατροπή των εγγράφων του Ms Word και άλλων μορφών κειμένων σε PDF δείτε τη
παράγραφο Προσβασιμότητα σε  ΑΡΧΕΙΑ  PDF

2.9.1 Καρτέλα ετικετών (Tags Panel)

Σημείωση
Στο Acrobat 8, η  Adobe ονομάζει τις ετικέτες πλαίσια (calling tabs panels). Αν χρησιμοποιείτε το
Acrobat 7 ή προηγούμενες εκδόσεις  του αντικαταστήσετε κάθε φορά τη  λέξη  πλαίσιο (panel)  με τη
λέξη  ετικέτα (tab).

http://webaim.org/techniques/acrobat/acrobat
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Το πλαίσιο ετικετών σας επιτρέπει να δείτε, να αναδιατάξετε, να μετονομάσετε, να τροποποιήσετε,
να διαγράψετε και να δημιουργήσετε ετικέτες. Για να δείτε το πλαίσιο ετικέτες (Tags panel), επιλέξτε
Προβολή> Πλαίσια  πλοήγησης> Ετικέτες (View>Navigation Panels>Tags) . Είναι πιο εύκολο να δείτε
το πλαίσιο Ετικέτες, εάν γίνει πλευρική μπάρα (side bar). Κάντε κλικ στην Προβολή> Πλαίσια
πλοήγησης> Πλευρίζω τις καρτέλες(View>Navigation Panels>Dock all Panels)  ή σύρετε την καρτέλα
Ετικέτες προς στην πλευρά της μπάρας. Δεν θα γίνει  αυτό αν σύρετε  ολόκληρο το παράθυρο. Θα
πρέπει να το σύρετε από τη καρτέλα.
Οι  επεκτάσεις των <Tags> και <Sect>  εμφανίζουν ένα μακρύ κατάλογο από ετικέτες. Μπορείτε τη
λίστα να την προηγηθείτε (navigated) , να την επεκτείνετε (expanded)  , να την διασπάσετε
(collapsed)   κάνοντας χρήση  του ποντικιού  ή του πληκτρολόγιου.

Εικόνα 49. Μενού  καρτελών σε  πλευρική μπάρα που έχει επιλεγεί η καρτέλα Ετικέτες
Πολλές από τις ετικέτες (tags) είναι παρόμοιες, με τις αντίστοιχες του HTML όχι όμως ακριβώς ίδιες.
Οι πιο  γνωστές ετικέτες περιγράφονται στον παρακάτω πίνακα:

Πίνακας 3  Είδη ετικετών για τη προσβασιμότητα του Acrobat
Eτικέτα Εκπροσωπεί Περιγραφή/Σημείωση
<H1> μέχρι <H6> Επικεφαλίδα
<P> Παράγραφο
<L> Λίστα Όμοια με τα <ul> ή <ol>  της HTML     
<LI> Λίστα αντικειμένων Θα πρέπει να είναι φωλιασμένα όπως στην

HTML . Προκαλεί σύγχυση 
<Table><TH><TR><TD> Πίνακας , Γραμμή Πίνακα,

Επικεφαλίδα Πίνακα ,
Δεδομένα Πίνακα         

<Figure> Εικόνα Όμοια με την ετικέτα <img>  της HTML
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 ΕΠΙΣΉΜΑΝΣΗ  ΠΕΡΙΕΧΟΜΈΝΟΥ (HIGHLIGHT CONTENT)

Ένα από τα πρώτα πράγματα που πρέπει να κάνετε στη καρτέλα ετικέτες (tags panel) είναι να
επιλέξετε την Επισήμανση περιεχομένου (Highlight Content) της καρτέλας Επιλογών. Η   επιλογή
αυτή  θα  δώσει επισήμανση - έμφαση στο αντίστοιχο κείμενο,  της  αντίστοιχης εικόνας ή κάποιου
άλλου στοιχείου όταν επιλεγεί μια ετικέτα στο αρχείο PDF

Εικόνα 50. Μενού καρτελών σε πλευρική διάταξη με ανοιγμένη τη καρτέλα Ετικέτες

ΕΎΡΕΣΗ ΕΤΙΚΈΤΑΣ  ΜΕ ΤΟ ΕΡΓΑΛΕΊΟ  ΤΗΣ   ΕΠΙΛΟΓΉΣ

Όταν επιλέγετε μία ετικέτα επισημαίνεται (highlight) το  περιεχόμενο  του αρχείο PDF. Υπάρχει
τρόπος να κάνεις και  το αντίθετο της  επισήμανσης της  ετικέτας που αντιστοιχεί στο επιλεγμένο

περιεχόμενο. Πρώτον, κάντε κλικ στο Εργαλείο Επιλογής   . Στη συνέχεια, επιλέξτε ένα τμήμα
κειμένου, μια εικόνα ή ένα πίνακα. Τέλος  από τη αναπτυσσόμενη λίστα του μενού Επιλογών
(Options) στο επάνω μέρος της καρτέλας Ετικέτες επιλέξτε Επιλογές> Εύρεση Ετικέτας Με Επιλογή
(Options > Find Tag From Selection). Αυτό θα επισημάνει  την ετικέτα ή τις ετικέτες που έχουν ως
περιεχόμενο αυτό που είχατε επιλέξει προηγούμενα.
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ΑΛΛΑΓΉ ΕΤΙΚΕΤΏΝ

Κάποιες φορές , θα  συναντήστε ένα αρχείο PDF, το οποίο περιέχει εσφαλμένες ετικέτες. Μπορείτε
να τις τροποποιήσετε  κάνοντας δεξί κλικ στην ετικέτα που θέλετε να αλλάξετε. Στη συνέχεια
επιλέγετε Ιδιότητες και από τη καρτέλα Ετικέτα (Tag tab)  επιλέγετε το νέο τύπο  ετικέτας από  την
επιλογή Τύς  (Type).

Εικόνα 51. Μενού επιλογών που εμφανίζεται κάνοντας δεξί κλικ πάνω στην ετικέτα
Για παράδειγμα, για να αλλάξετε την ετικέτα από <Normal> σε <H1> επιλέξτε την ετικέτα <Normal>
που θα θέλατε να αλλάξετε, κάντε δεξί κλικ σ αυτήν  και επιλέξτε κατά σειρά Ιδιότητες , Επικεφαλίδα
Επιπέδου 1 από τη  αναπτυσσόμενη λίστα των Τύπων (Type).

Εικόνα 52. Παράθυρο διαλόγου του Φτιαξίματος του Τύπου Ετικέτας

ΠΡΟΣΘΉΚΗ ΕΤΙΚΕΤΏΝ ΣΕ ΈΓΓΡΑΦΟ ΧΩΡΊΣ ΕΤΙΚΈΤΕΣ
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Αν  δεν  βλέπετε κάποια ετικέτα στη καρτέλα  ετικέτες  τότε  το έγγραφό  σας είναι  χωρίς   ετικέτες
και  θα χρειαστεί να τις  προσθέσετε. Για να προσθέσετε ετικέτες σε  έγγραφο, επιλέξτε Για
προχωρημένους> Προσβασιμότητα> Προσθήκη ετικετών στο έγγραφο (Advanced > Accessibility >
Add Tags to Document) . Αυτή η διαδικασία μπορεί μερικές φορές να είναι εξαιρετικά χρονοβόρα
γιατί  θα πρέπει να επεξεργαστείτε τις νέες ετικέτες χειροκίνητα (manually). Για αρχή αυτό μπορεί  να
είναι πιο γρήγορο από το να  κάνετε όλη τη δουλειά χειροκίνητα. Είναι καλύτερο  για  έγγραφο που
περιέχει πίνακες.

2.9.2 Εργαλείο Φτιαξίματος Σειράς Ανάγνωσης (Touchup Reading Order)

Σημείωση
Αυτό το χαρακτηριστικό   είναι  του  Acrobat 7 και των επόμενων  εκδόσεών  του.
Το Φτιάξιμο Σειράς Ανάγνωσης (Touchup Reading Order) είναι μια νέα και πολλά υποσχόμενη
προσθήκη του  Acrobat 7 και των επόμενων εκδόσεων του. Δημιουργεί  ετικέτες σε PDF γρήγορα.
Παρόλο που μπορεί να επιταχύνει την διαδικασία προσθήκης ετικετών, δεν υποκαθιστά τα άλλα
εργαλεία που αναφέρθηκαν προηγούμενα.
Για να χρησιμοποιήσετε το εργαλείο  Φτιάξιμο Σειράς Ανάγνωσης, επιλέξτε  Για προχωρημένους>
Προσβασιμότητα> Φτιάξιμο Σειράς Ανάγνωσης(Advanced > Accessibility>TouchUp Reading Order).
Μετά την  επιλογή , η  προβολή της οθόνης θα αλλάξει. Όλο το περιεχόμενο του κειμένου θα
περικλείεται σε πλαίσια με αρίθμηση (numbered boxes)  . Καθένα από αυτά  αντιπροσωπεύει μια
ετικέτα και ο αριθμός του πλαισίου  αντιστοιχεί  στον  αριθμό της ετικέτας στη Καρτέλα Διάταξης
(Order panel) . Επίσης θα είναι ανοικτό το  παράθυρο Φτιάξιμο Σειράς Ανάγνωσης « Touchup
Reading Order»  .
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Εικόνα 53. Παράθυρο διαλόγου του Φτιαξίματος Σειράς  Ανάγνωσης  για ετικέτες

Σ η μ ε ί ω σ η
Αν έχετε ανοικτό το Φτιάξιμο Σειράς Ανάγνωσης (Touchup Reading Order) και δεν βλέπετε κανένα
πλαίσιο (box) , πιθανότατα το έγγραφο σας να μην  έχει  ετικέτες.
Θα παρατηρήσετε μια ομάδα  κουμπιών (buttons) με τα ονόματα των γνωστών ετικετών. Μπορείτε
να τα χρησιμοποιήσετε  για να αντιστοιχίσετε τις ετικέτες σε ένα επιλεγμένο τμήμα κειμένου  ή  σ’ ένα
αντικείμενο.
Το εργαλείο Φτιάξιμο Σειράς Ανάγνωσης δεν είναι  τέλειο. Η επιλογή κειμένου είναι δύσκολη και
πολλές ετικέτες δεν υποστηρίζονται. Επίσης, είναι δύσκολο να εκχωρήσεις εναλλακτικό κείμενο στις
εικόνες. Παρόλα αυτά είναι ο ευκολότερος  τρόπος να «μαρκάρεις» (mark up)  ένα  αρχείο PDF
χρησιμοποιώντας αυτό .

ΠΡΟΣΘΉΚΗ / ΑΛΛΑΓΉ ΕΤΙΚΕΤΏΝ

Δύο τρόποι υπάρχουν για να επιλέξετε μια περιοχή κειμένου, εικόνας, πίνακα ή άλλου στοιχείου
χρησιμοποιώντας το Φτιάξιμο Σειράς Ανάγνωσης (Touchup Reading Order).
1. Σχεδιάστε  ένα  πλαίσιο (box)  γύρω  από  ένα  στοιχείο  (element)   χρησιμοποιώντας  το  εργαλείο

επιλογής      που   έχει   αντικαταστήσει   τον κλασσικό   δείκτη  (default pointer).  Μερικές   φορές 
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      η επιλογή    της   σωστής   περιοχής   είναι   δύσκολη ,  αλλά    θα    γίνει   ευκολότερη   αν 
προσπαθήσετε   να   σχεδιάσετε   το    πλαίσιο    ελαφρώς   μεγαλύτερο   από  το    στοιχείο
(element).  Αφού   επιλέξετε    το   νέο    στοιχείο,   μπορείτε  να   του    ορίσετε  μερικές  από    τις 
πιο γνωστές   ετικέτες   ,  κάνοντας  κλικ  σε   ένα από τα πολλά κουμπιά .
2. Μπορείτε επίσης να επιλέξετε οτιδήποτε βρίσκεται μέσα στο πλαίσιο , κάνοντας κλικ στο αριθμό
που είναι στην πάνω αριστερή γωνία.
Αφού  έχετε επιλέξει το κείμενο, μπορείτε να ορίσετε μια ετικέτα, κάνοντας κλικ στο αντίστοιχο
κουμπί (button). Το  Acrobat θα τοποθετήσει το επιλεγμένο περιεχόμενο στη κατάλληλη ετικέτα. Αν
έχετε ανοιχτή την καρτέλα Ετικέτες, μπορείτε να δείτε αυτές τις αλλαγές αμέσως.
Επίσης με το Φτιάξιμο Σειράς Ανάγνωσης (Touchup Reading Order) , μπορείς να ορίσεις το
Εναλλακτικό κείμενο στις  εικόνες κάνοντας Δεξί κλικ πάνω στην εικόνα και επιλέγοντας
Επεξεργασία Εναλλακτικού Κείμενου (Edit Alternate Text).

Πίνακας 4  Κουμπιά Φτιαξίματος Σειράς Ανάγνωσης με τις ετικέτες που εκπροσωπούν
Κουμπί Ετικέτα Adobe Επιπλέον πληροφορίες
Κείμενο <P>
Φόρμα Πεδίου <Form>

Επικεφαλίδα 1 <H1>
Επικεφαλίδα 2  <H2>
Επικεφαλίδα  3 <H3>
Εικόνα <Figure>
Εικόνα / Σχόλιο
Εικόνας      

< F i g u r e >
<Caption>

Αν επιλέξεις μια εικόνα και τη κοντινή της λεζάντα που την
επεξηγεί , η εικόνα αποκτά ετικέτα  το ίδιο και το κείμενο
της λεζάντας.

Πίνακας <Table> <TR>
<TH> <TD>

Προσπαθεί να εκχωρήσει γραμμές, στήλες και επικεφαλίδες.
Μερικές φορές το κάνει σωστά αλλά θα πρέπει να έχει
«τσεκαριστεί»  στην επιλογή Ελεγκτή Πίνακα .

Κελί <TD> Συγχωνεύει τα κελιά  που  είναι διαχωρισμένα- διασπασμένα
κατά λάθος

Τύπος <Formula>
Υπόβαθρο None Κρύβει εντελώς το στοιχείο  από τον αναγνώστη οθόνης .

Αυτό λέγεται artifact.

ΚΑΡΤΈΛΑ  ΔΙΆΤΑΞΗΣ

Σημείωση
Αυτή το χαρακτηριστικό  είναι  του  Acrobat 7  Professional και των  νεότερων  εκδόσεων  του.
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Η σειρά ανάγνωσης ενός PDF μπορεί να αλλάξει σύροντας τις ετικέτες  πάνω – κάτω  στη καρτέλα
Ετικέτες. Υπάρχει όμως ένας ευκολότερος τρόπος στο Acrobat 7 και στις νεότερες εκδόσεις του.
Επιλέξτε Προβολή> Καρτέλες πλοήγησης> Διάταξη (View>Navigation>Panels>Order) ή επιλέξτε
Εμφάνιση Διάταξης Καρτέλας (Show Order Panel) του εργαλείου Φτιαξίματος Σειράς Ανάγνωσης
(Touchup Reading ) για να ανοίξετε τη καρτέλα Εντολή (Order) .

Εικόνα 54. Καρτέλα  Διάταξης  των  ετικετών  της πρώτης σελίδας του correctly_tagged.pdf
Με μια πρώτη ματιά φαίνεται να μοιάζει με την καρτέλα Ετικέτες, αλλά έχει διαφορές.

 Το έγγραφο χωρίζεται σε σελίδες.

 Κάθε  στοιχείο  έχει αρίθμηση  που  ξεκινά από την αρχή κάθε σελίδας.

 Δεν υπάρχει ιεράρχηση των στοιχείων. Όλα είναι στο ίδιο επίπεδο.

Αυτές οι διαφορές κάνουν τη καρτέλα Διάταξης  (Order)  τον ευκολότερο  τρόπο αναδιάταξης των
ετικετών. Για να αλλάξει η σειρά διάταξης μιας  ετικέτας, απλά κάντε κλικ και σύρετε την ετικέτα στη
θέση της σωστής σειράς ανάγνωσης. Η νέα  σειρά των ετικετών   θα πρέπει να φαίνεται   στη
καρτέλα Ετικέτες όταν το έγγραφο προβάλλεται στη μορφή Οπτική Διάταξη περιεχομένου(Reflow
mode).

ΕΝΑΛΛΑΚΤΙΚΌ ΚΕΊΜΕΝΟ

 O ευκολότερος τρόπος για να προσθέσετε εναλλακτικό κείμενο γίνεται  με το  Εργαλείο Φτιαξίματος
Σειράς Ανάγνωσης (Touchup Reading Order) . Για μια εικόνα με ετικέτα το εναλλακτικό κείμενο της
εμφανίζεται δίπλα στην εικόνα. Αν η εικόνα δεν έχει εναλλακτικό κείμενο θα υπάρχει  η επισήμανση
"Εικόνα - χωρίς εναλλακτικό κείμενο.
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Εικόνα 55. Εικόνα με την επισήμανση «χωρίς εναλλακτικό κείμενο»
Για να προσθέσετε εναλλακτικό κείμενο, κάντε δεξί  κλικ    πάνω στην εικόνα και επιλέξτε
Επεξεργασία Εναλλακτικού Κείμενου (Edit Alternate Text) .Εισάγετε το κατάλληλο εναλλακτικό
κείμενο στο παράθυρο διαλόγου. Δείτε περισσότερα στη σύνδεση
http://webaim.org/techniques/alttext/

ΕΛΕΓΚΤΉΣ ΠΊΝΑΚΑ

Σ η μ ε ί ω σ η
Αυτό το γνώρισμα είναι διαθέσιμο στο Acrobat 8 και στις νεότερες εκδόσεις του.

Ο Ελεγκτής Πίνακα (table inspector)  εντοπίζει και  εκχωρεί  την ιδιότητα  «scop»  στις  επικεφαλίδες
του πίνακα.
Με ανοικτό το παράθυρο του εργαλείου Φτιαξίματος Σειράς Ανάγνωσης (Touchup Reading Order),
επιλέξτε έναν πίνακα και στη συνέχεια επιλέξτε το κουμπί Ελεγκτής Πίνακα ( Table Inspector) . Τώρα
 επιλέξτε τα κελιά του πίνακα που θα γίνουν  επικεφαλίδες. Κάνοντας δεξί κλικ σε ένα επιλεγμένο κελί
ή κελιά επιλέγετε Πίνακας Ιδιότητες Κελιού ( Table Cell Properties) . Ένα  παράθυρο  διαλόγου θα
εμφανιστεί.

http://webaim.org/techniques/alttext/
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Εικόνα 56.Παράθυρο διαλόγου ιδιότητες Κελιού Πίνακα
 Αν πρέπει το επιλεγμένο(-α) κελί(-α) να γίνουν ετικέτες  επικεφαλίδας , επιλέξτε την επιλογή Κεφαλίδα
Κελί (Header Cell) και χαρακτηρίστε  το  πεδίο «scope»  είτε ως Γραμμή είτε ως Στήλη. Μετά την
επιλογή OK, θα παρατηρήσετε ότι τα κελιά του πίνακα που είναι επικεφαλίδες θα χρωματιστούν  με
κόκκινο χρώμα και τα κελιά των δεδομένων με γκρι χρώμα.

Εικόνα 57. Παράδειγμα  πίνακα με χρωματισμένα κελιά , τα κόκκινα κελιά είναι Επικεφαλίδες
και τα γκρι κελιά είναι Δεδομένα 

ΑΝΤΙΚΕΊΜΕΝΑ ΠΟΥ ΔΕΝ ΔΙΑΒΆΖΟΝΤΑΙ ΑΠΌ ΤΟΝ ΑΝΑΓΝΏΣΤΗ ΟΘΌΝΗΣ (ARTIFACTS)

Τα αντικείμενα αυτά  είναι στοιχεία  που αγνοούνται από το  πρόγραμμα ανάγνωσης οθόνης.
Μοιάζουν με  μια  εικόνα  χωρίς  εναλλακτικό  κείμενο  που  αγνοείται στη μορφή  HTML. Το  κείμενο
που θεωρείτε σημαντικό  δεν  πρέπει  ποτέ  να  χαρακτηρίζεται  ως  ένα  τέτοιο  αντικείμενο. Όπως
και με το  εναλλακτικό κείμενο, ο  ευκολότερος  τρόπος για να αλλάξει  ένα στοιχείο σε  αντικείμενο
που  δεν διαβάζεται  γίνεται  με  το εργαλείο   Φτιάξιμο Σειράς Ανάγνωσης  (Touchup  Reading Order)
. Για να γίνει αυτό, επιλέξτε το στοιχείο και πατήστε το κουμπί Μεταφορά Πίσω (Background).Για να
αναζητήσετε κάποιο αντικείμενο που δεν διαβάζεται , στη καρτέλα Ετικέτες επιλέξτε Επιλογές>
Εύρεση(Options> Find). Στο παράθυρο θα εμφανιστούν διάφορες επιλογές αναζήτησης. Η
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αναζήτηση του αντικειμένου που δεν φαίνεται  είναι η εξ ορισμού επιλεγμένη, οπότε κάντε κλικ στο
κουμπί Εύρεση(Find). Αν υπάρχουν αρκετά τέτοια αντικείμενα , η αναζήτηση θα τα εντοπίσει  και θα
σας επιτρέψει να τα αλλάξετε.
Για να αλλάξετε μια ετικέτα σε ένα τέτοιο αντικείμενο πάτε στην καρτέλα  Ετικέτες, κάντε δεξί κλικ
πάνω στο αντικείμενο και επιλέξτε Αλλαγή της ετικέτας  σε Αντικείμενο που δεν φαίνεται (Change
Tag to Airfact).

2.9.3 Άλλα εργαλεία και δυνατότητες προσβασιμότητας

ΜΕΤΑΤΡΟΠΉ ΣΑΡΩΜΈΝΟΥ ΚΕΊΜΕΝΟΥ ΣΕ ΑΡΧΕΊΟ PDF ΜΕ ΕΤΙΚΕΤΕΣ

Πριν  δημιουργήσετε  ένα αρχείο PDF με ετικέτες , πρέπει να διασφαλιστεί  ότι το PDF περιέχει
πραγματικό κείμενο (real text). Αν δεν έχει   πραγματικό κείμενο , μπορείτε είτε να το επαναφέρετε
(reconvert) σε μορφή  Acrobat (αν έχετε το πρωτότυπο  αρχείο) είτε  να το μετατρέψετε σε κείμενο
(text). Για να κάνετε τη μετατροπή του εγγράφου , επιλέξτε Έγγραφο> OCR >Αναγνώριση κειμένου>
Αναγνώριση κειμένου χρησιμοποιώντας το OCR (Document > OCR>Text Recognition > Recognize
Text Using OCR). Η ποιότητα του κειμένου της μετατροπής εξαρτάται από την ποιότητα του
πρωτότυπου εγγράφου (source document). Συνήθως αυτό  γίνεται αρκετά καλά, αλλά υπάρχει
πιθανότητα να πρέπει  να καθαριστεί. Ο καθαρισμός του εγγράφου γίνεται  επιλέγοντας Έγγραφο>
Αναγνώριση Κειμένου με OCR  >Βρείτε όλα τα Υποπτα  σημεία (Document > OCR Text Recognition
> Find All OCR Suspects).

ΓΡΉΓΟΡΟΣ ΈΛΕΓΧΟΣ ΠΡΟΣΒΑΣΙΜΌΤΗΤΑΣ

Το Acrobat Professional περιλαμβάνει δύο διαφορετικούς Ελέγχους  Πρόσβασης. O πρώτος έλεγχος
είναι , ο Γρήγορος Έλεγχος (Quick Check) που δεν είναι τόσο χρήσιμος όσο ακούγεται. Ο Γρήγορος
Έλεγχος σας πληροφορεί αν το αρχείο έχει ετικέτες ή όχι. Δεν προσδιορίζει  βασικά λάθη, όπως την
έλλειψη εναλλακτικού κειμένου. Για να εκτελέσετε το Γρήγορο Έλεγχο επιλέξτε Για προχωρημένους>
Προσβασιμότητα> Γρήγορος Έλεγχος (Advanced> Accessibility>Quick Check)

ΠΛΉΡΗΣ ΈΛΕΓΧΟΣ ΠΡΟΣΒΑΣΙΜΌΤΗΤΑΣ

Για πιο  προχωρημένο έλεγχο  κάντε Για Προχωρημένους> Προσβασιμότητα> Πλήρης έλεγχος
(Advanced> Accessibility> Full Check) . Ο έλεγχος αυτός είναι πιο λεπτομερής  από αυτόν του
Γρήγορου Ελέγχου. Απέχει πολύ από τον ολοκληρωτικό Έλεγχο. Αναγνωρίζει γνωρίσματα, όπως αν
λείπει το εναλλακτικό κείμενο ενός στοιχείου και προσφέρει συμβουλές για το πώς να διορθώσετε
κάποια λάθη.

ΕΡΓΑΛΕΊΟ ΟΠΤΙΚΉΣ ΔΙΆΤΑΞΗΣ ΤΟΥ ΠΕΡΙΕΧΟΜΈΝΟΥ ΕΝΌΣ ΕΓΓΡΆΦΟΥ (REFLOW)
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Όπως με την HTML,  έτσι το διάβασμα  ενός εγγράφου  PDF με το πρόγραμμα ανάγνωσης οθόνης
γίνεται με  βάση τη σειρά των ετικετών. Η σειρά των ετικετών στο PFD μπορεί να μην είναι η ίδια με
την οπτική σειρά ανάγνωσης. Αυτό είναι ιδιαίτερα πιθανό εάν το PDF περιέχει πολλές στήλες ή άλλα
τμήματα κειμένου ή έχει σύνθετες ένθετες λίστες. Το εργαλείο οπτικής διάταξης περιεχομένου με
βάση τη σειρά των ετικετών (reflow) θα σας επιτρέψει να δείτε την οπτική διάταξη του περιεχομένου
του εγγράφου όπως καθορίζεται με τη σειρά των ετικετών. Επιλέξτε Προβολή >  Reflow ή Ctrl + 4.
Αν το  έγγραφο δεν εμφανίζεται με τη σωστή σειρά ενώ είναι σε προβολή οπτικής διάταξης  , η σειρά
των ετικετών πρέπει να αλλάξει.

ΣΥΝΘΈΤΗΣ ΦΩΝΉΣ (READ OUT LOUD)

Ο  συνθέτης αυτός υπάρχει στο  Adobe Reader και στο Acrobat. Διαβάζει το περιεχόμενο ενός
εγγράφου PDF όπως κάνει και ο αναγνώστης  οθόνης. Για περισσότερες πληροφορίες δείτε το  άρθρο
Read Out Loud section in the WebAIM article on Adobe Reader
Δείτε επίσης :
Σχετικές  πηγές  Web AIM 

 http://webaim.org/resources/reader/

 http://webaim.org/resources/commonlook/

Εξωτερικές Πηγές
 http://www.adobe.com/enterprise/accessibility/pdfs/acro7_pg_ue.pdf

Επιστροφή Acrobat και Προσβασιμότητα 

http://webaim.org/resources/reader/#outloud
http://webaim.org/resources/reader/
http://webaim.org/resources/commonlook/
http://www.adobe.com/enterprise/accessibility/pdfs/acro7_pg_ue.pdf
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3 Δημιουργία αρχείων  PDF  με προσβασιμότητα από τα έγγραφα του
Ms Word

3.1 Προσθέτοντας δομή στα έγγραφα του Ms Word
Να σχεδιάζετε τα έγγραφα χρησιμοποιώντας τα  Στυλ (Styles). Τα Στυλ και η δομή είναι απαραίτητα
για τους ανθρώπους με αναπηρίες (βλέπε Επικεφαλίδες).

3.2 Γραφικά και εικόνες
Όλα τα γραφικά και οι εικόνες θα πρέπει να έχουν εναλλακτικό κείμενο περιγραφής (βλέπε
Εναλλακτικό Κείμενο ή Alt Κείμενο). Αποφεύγετε να τοποθετείτε γραφικά πολύ κοντά στο κείμενο
γιατί μπορεί να δημιουργηθούν προβλήματα κατά τη μετατροπή σε PDF. Τοποθετήστε κενό μεταξύ
κειμένου και των γραφικών.

3.3 Εναλλακτικό κείμενο ή  ALT κείμενο
Με τον όρο εναλλακτικό κείμενο ή Alt κείμενο (Alt Text) ορίζουμε το κείμενο που διαβάζεται από έναν
αναγνώστη οθόνης και περιγράφει τα γραφικά και τις εικόνες στα άτομα που δεν μπορούν να δουν.

3.3.1 MS WORD 2003

Εικόνα 58. Παράθυρο διαλόγου
Μορφοποίησης  Εικόνας Ms

Word 2003  με ενεργή τη
καρτέλα Web

 Κάντε διπλό κλικ (Double Click) ή
δεξί κλικ σε μια εικόνα με το
ποντίκι. Επιλέξτε το παράθυρο
διαλόγου μορφοποίησης

 Επιλέξτε την καρτέλα Web για
την εισαγωγή εναλλακτικού
κείμενου

3.3.2 MS WORD 2007



Παραγωγή Προσβάσιμου Εκπαιδευτικού Υλικού για Μαθητές με Αναπηρία

Σελίδα 81

Εικόνα 59. Παράθυρο διαλόγου Μέγεθος  Ms Word 2007 με ενεργή τη καρτέλα Alt Text
 Κάντε δεξί κλικ στην εικόνα και επιλέξτε  Μέγεθος (Size)

 Επιλέξτε τη καρτέλα  Alt Text  για να εισάγετε εναλλακτικό κείμενο

3.4 Κείμενο
 Το μέγεθος των γραμμάτων του κειμένου πρέπει να είναι τουλάχιστον  12

 Αποφύγετε την χρήση των πλαισίων κειμένου του Ms Word (Ms Word text boxes)

 Αποφύγετε την χρήση του πλήκτρου Enter για να δημιουργείτε κενά μεταξύ των
παραγράφων. Χρησιμοποιήστε κενό πριν στις ιδιότητες των  Στυλ σας

3.5 Στήλες
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Για τη δημιουργία στηλών , μην χρησιμοποιήσετε το πλήκτρο Tab για να αφήσετε κενά μεταξύ των
στηλών του κειμένου ή για να τοποθετήσετε κείμενο σε πίνακα. Χρησιμοποιήστε εντολή για τις στήλες
του Ms Word (Word column command).

3.5.1 MS WORD 2003

Εικόνα 60. Παράθυρο διαλόγου Στήλες Ms Word 2003
 Μορφοποίηση > Στήλες

 ή  Κάντε κλικ στο εργαλείο Στήλες  

3.5.2 MS WORD 2007

Εικόνα 61. Γραμμή εργαλείων με τις επιλογές  Διάταξη Σελίδας  και  Στήλες  στο Ms Word 2007

 Επιλέξτε τη Διάταξη Σελίδας (Page Layout) που θα βρείτε στη μπάρα των εργαλείων.
Στη συνέχεια επιλέξτε Στήλες (Columns) από την ομάδα (group)  της επιλογής
Διαμόρφωση Σελίδας (Page Setup)

3.6 Επικεφαλίδες
Δημιουργείστε επικεφαλίδες χρησιμοποιώντας το Στυλ (Style) όπως το Τίτλο, την Επικεφαλίδα
επιπέδου 1, την Επικεφαλίδα επιπέδου  2,  την Επικεφαλίδα επιπέδου 3  κ.λ.π  με  λογικό τρόπο
ανάπτυξης. Δηλ. η Επικεφαλίδα επιπέδου 2 να έπεται της  Επικεφαλίδας επιπέδου 1.
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3.6.1 MS WORD 2003

 Μορφή > Στυλ και μορφοποίηση ( Format > Styles and Formatting) για να
αποκαλύψετε  Στυλ  και Μορφοποίηση

Εικόνα 62. Μενού Μορφοποίησης Ms Word 2003

3.6.2 MS WORD 2007

 Επέλεξε τη  βασική (Home) μπάρα του Ms Word 2007  και από την ομάδα των  Στυλ
(group styles) επιλέξτε την κατάλληλη επικεφαλίδα

Εικόνα 63. Η βασική  μπάρα των εργαλείων της καρτέλας Αρχείο Ms Word 2007

3.7 Οδηγός γρήγορης αναφοράς για τη προσβασιμότητα του Adobe

3.7.1 Πλήκτρα συντομεύσεων για την εφαρμογή Στυλ  (Keyboard shortcuts)

Αφορά και τις δύο εκδόσεις του Ms Word (2003 , 2007)
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  Ctrl Alt 1 για Επικεφαλίδα επιπέδου 1

  Ctrl Alt 2 για Επικεφαλίδα επιπέδου 2

  Ctrl Alt 3 για Επικεφαλίδα επιπέδου 3

3.7.2 Υπερσυνδέσεις (MS WORD 2003 & 2007)

 Εισαγωγή Υπερσύνδεσης  Ctrl K

 Χρησιμοποίησε το  κουμπί  Συμβουλής Οθόνης (Screen Tip…)  για να προσθέσετε
κείμενο

Εικόνα 64. Παράθυρο διαλόγου Εισαγωγής Υπερσύνδεσης Ms Word 2003 2007

3.7.3 Λίστες

  Χρησιμοποιήστε τις  Λίστες με τις Κουκίδες για να δώσετε έμφαση σε κάποια  σημεία

 Χρησιμοποιήστε τις Λίστες με την Αρίθμηση  για να περιγράψετε τη σωστή σειρά των
βημάτων μιας ακολουθίας ενεργειών

3.7.4 Πίνακες

  Απαγορεύεται να χρησιμοποιείτε το πλήκτρο Tab και διάστημα (Space) για τη
δημιουργία πινάκων. Μπορείτε να χρησιμοποιείται την εντολή Εισαγωγή Πίνακα
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 Αποφεύγετε να χωρίζετε τις γραμμές του  πίνακα στα όρια της σελίδας

  Πίνακες που υπερβαίνουν μια σελίδα   πρέπει να επαναλαμβάνουν τις επικεφαλίδες
γραμμών στην αρχή κάθε σελίδας

MS WORD 2003

 Χρησιμοποιήστε το παράθυρο διαλόγου των ιδιοτήτων πίνακα

Εικόνα 65. Παράθυρο διαλόγου Ιδιοτήτων πίνακα

MS WORD 2007

 Τοποθετήστε τον κέρσορα (cursor) πάνω στον πίνακα και επιλέξτε την καρτέλα των
Εργαλείων Πίνακα από τη  γραμμή
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Εικόνα 66. Καρτέλα των εργαλείων Πίνακα Ms Word 2007

Επιστροφή  Δημιουργία Αρχείων PDF  με προσβασιμότητα από έγγραφα του Word
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4 Μετατρέποντας έγγραφα Ms Word σε  αρχεία  PDF με
προσβασιμότητα χρησιμοποιώντας το  Adobe Acrobat

4.1 Tο μενού δημιουργίας του αρχείου PDF (PDF MAKER)

4.1.1 MS WORD 2003 με τη χρήση ACROBAT 7 & 8

 Επιλέξτε από το βασικό μενού της μπάρας του Ms Word τη καρτέλα  Adobe PDF

 Επιλέξτε την επιλογή Αλλάζοντας τις Ρυθμίσεις των Μετατροπών

Εικόνα 67. Παράθυρο διαλόγου του μενού Adobe PDF

4.1.2 MS WORD 2007  με τη χρήση ACROBAT 8

 Από τη  γραμμή (Ribbon) επιλέξτε την καρτέλα Acrobat.

 Επιλέξτε Προτιμήσεις (Preferences)  από την ομάδα Δημιουργώ Adobe PDF ( Create Adobe
PDF)
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Εικόνα 68. Μενού βασικής μπάρας Ms Word 2007 με επιλεγμένη τη καρτέλα  Acrobat

4.2 Διαμορφώνοντας τη καρτέλα του PDF Maker

4.2.1 Καρτέλα Ρυθμίσεων

 Σελιδοδείκτες

 Συνδέσεις

 Ενεργοποίηση προσβασιμότητας και οπτική διάταξη περιεχομένου

Εικόνα 69. Παράθυρο διαλόγου του PDF Maker με ενεργή τη καρτέλα Ρυθμίσεις 
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4.2.2 Καρτέλα Ασφάλεια

 Ενεργοποιείστε  την επιλογή  οι αναγνώστες  οθόνης να έχουν προσβασιμότητα για
να  δοθούν   άδειες  στα άτομα με προβλήματα όρασης 

Εικόνα 70. Παράθυρο διαλόγου του PDF Maker με ενεργή τη καρτέλα Ασφάλεια

4.2.3 Καρτέλα MS WORD

 Μετατρέψτε τις παραπομπές

 Μετατρέψτε τις σημειώσεις και υποσημειώσεις των συνδέσεων

 Ενεργοποιήστε τη προχωρημένη χρήση των ετικετών 
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Εικόνα 71. Παράθυρο διαλόγου του PDF Maker με ενεργή τη καρτέλα Ms Word

4.2.4 Καρτέλα Σελιδοδείκτες

 Μετατρέψτε τις Επικεφαλίδες Ms Word  σε Σελιδοδείκτες

 Καθορίστε  επίπεδα με κατάλληλο τρόπο
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Εικόνα 72. Παράθυρο διαλόγου του PDF Maker με ενεργή τη καρτέλα Σελιδοδεικτών

4.3 Αποθηκεύοντας  PDF σε αρχείο με προσβασιμότητα 

4.3.1 MS WORD 2003 με χρήση ACROBAT 7 & 8

 Κάντε τη μετατροπή σε Adobe PDF από το μενού Adobe PDF

 Επιλέξτε  Μετατροπή από την μπάρα εργαλείων του Adobe PDF

Εικόνα 73. Παράθυρο διαλόγου του μενού  Adobe PDF Ms Word 2003



Παραγωγή Προσβάσιμου Εκπαιδευτικού Υλικού για Μαθητές με Αναπηρία

Σελίδα 92

4.3.2 MS WORD 2007 με χρήση ACROBAT 8

  Επιλέξτε Δημιουργία PDF από τη ομάδα Δημιουργία Adobe PDF (Create PDF Adobe
Group)

  Κάντε την αποθήκευση με τη μορφή ως Adobe PDF

Εικόνα 74. Γραμμή εργαλείων της  καρτέλας Adobe  Ms Word 2007 

Εικόνα 75. Μενού  αποθήκευσης εγγράφου σε μορφή Adobe PDF
Μπορείτε να επισκεφτείτε για θέματα προσβασιμότητας το κέντρο πόρων της ADOBE στη διεύθυνση
WWW.ADOBE.COM/ ACCEBILITY  .
Επιστροφή Μετατρέποντας τα έγγραφα της Microsoft σε αρχεία PDF με προσβασιμότητα

http://www.adobe.com/20�ACCEBILITY
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5 Οδηγός προσβασιμότητας των προγραμμάτων  Ms Word και Ms Ms
Powerpoint

ΕΙΣΑΓΩΓΗ
Ο οδηγός αυτός παρέχει βήμα προς βήμα τις οδηγίες  δημιουργίας και μορφοποίησης των αρχείων
των Ms Word και Ms Powerpoint ώστε να έχουν προσβασιμότητα από τους χρήστες με αναπηρίες.
Τα αρχεία αυτά θα μπορούν να διαβαστούν από αναγνώστες οθόνης με υψηλή ανάλυση.
Τα αρχεία πρέπει να  έχουν δομή. Με τον όρο  δομή ορίζουμε  τη λογική σύνδεση των περιεχομένων,
τη σωστή σειρά ανάγνωσης, τη παρουσία στοιχείων όπως λιστών, γραφικών και πινάκων.
Ο τρόπος διάρθρωσης  παίζει σημαντικό ρόλο στη προσβασιμότητα.
Η δημιουργία εγγράφου με προσβασιμότητα στο Ms Word και Ms Powerpoint απαιτεί από τον
συντάκτη να σκεφτεί το πίνακα περιεχομένων. Τα άτομα με προβλήματα όρασης δεν μπορούν να
διακρίνουν  τις διαφορές μεταξύ των τίτλων , των υπότιτλων και των στηλών του κειμένου όπως οι
άνθρωποι που έχουν όραση. Η τεχνολογία υποβοήθησης δεν εξαρτάται από τις οπτικές ενδείξεις
όπως τα μεγάλα μεγέθη γραμματοσειρών  και τη θέση του κειμένου σε μία σελίδα για να ορίσει τη
δομή ενός εγγράφου. Αντί  αυτού οι τεχνολογίες βασίζονται στη βασική δομή για να παρέχουν τις
κατευθύνσεις.
Για την ανάπτυξη  αρχείων  με προσβασιμότητα θα πρέπει οι συγγραφείς τους να γνωρίζουν :
 Τη σημασία  που έχει να γράφεις  αρχείο με προσβασιμότητα

 Την ανάγκη να αναπτύξεις γνώσεις και  δεξιότητες που είναι απαραίτητες για τη δημιουργία
ενός ποιοτικού προσιτού εγγράφου

 Την ανάγκη της χρήσης του Section 508 που παρέχει  εργαλεία  συγγραφής και έκδοσης

Ο οδηγός θεμάτων  πρόσβασης για  Ms Word και Ms Powerpoint  προβλέπει :
 Δημιουργία αρχείου  Ms Word με προσβασιμότητα

 Δημιουργία παρουσίασης  Ms Powerpoint με προσβασιμότητα

 Τεστ προσβασιμότητας σε έγγραφα του Ms Word και Ms Powerpoint

 Ο οδηγός που θα σας δοθεί,  προϋποθέτει ότι είστε εξοικειωμένοι με τα προγράμματα Ms Word και
Ms Powerpoint. 
Επιστροφή  Οδηγός Προσβασιμότητας στα προγράμματα Word και PowerPoint

5.1 Δημιουργία εγγράφου Ms Word  με προσβασιμότητα
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Αυτή η παράγραφος έχει σχόλια και κατευθυντήριες γραμμές για την παραγωγή εγγράφων στο Ms
Word με προσβασιμότητα. Αν θέλετε τα έγγραφα σας να διαβάζονται από  μηχανήματα
υποβοήθησης θα πρέπει να εφαρμοστούν κάποιες προδιαγραφές σ’ αυτά .

5.1.1 Γενικές Επιλογές προσβασιμότητας

Ακολουθείστε τις παρακάτω οδηγίες για να βελτιώσετε τη ποιότητα δομής  του εγγράφου
βελτιώνοντας ταυτόχρονα και την προσβασιμότητα του.
 Καθορίστε το στυλ των τίτλων, των επικεφαλίδων και του κείμενου  

 Χρησιμοποιήστε υψηλή αντίθεση χρωμάτων μεταξύ του φόντου και του κειμένου

 Βεβαιωθείτε ότι οι πληροφορίες των γραφικών παραστάσεων ή διαγραμμάτων προκαλούν τη
προσοχή   εφόσον δεν έχουν χρώμα

 Προσθέσετε εναλλακτικό κείμενο  ή κείμενο περιγραφής σε όλες τις εικόνες

 Ομαδοποιείστε τις μικρές εικόνες (small illustrations) σε μεγαλύτερες (larger illustrations)

 Συμπεριλάβετε εργαλεία πλοήγησης και οργάνωσης

 Χρησιμοποιείστε τους κωδικούς αρίθμησης των σελίδων για την αρίθμηση. Μην
πληκτρολογείτε τους αριθμούς των σελίδων στο κάτω μέρος της σελίδας

5.1.2 Κείμενο

Η δομή κειμένου δημιουργείται μέσω των Στυλ. Τα Στυλ είναι ένα προκαθορισμένο σύνολο
χαρακτηριστικών  μορφοποίησης που μπορούν να εφαρμοστούν στα στοιχεία του κειμένου όπως
στους  τίτλους, στις επικεφαλίδες και  στο κύριο σώμα. Με την εφαρμογή  του Στυλ της ετικέτας
εκχωρούνται πολλαπλές ιδιότητες στο επιλεγμένο κείμενο σε  δυο βήματα.
Για παράδειγμα, αντί να εκτελέσεις  τρεις  διαφορετικές ομάδες (set) βημάτων εντολών για να
μορφοποιήσεις ένα τίτλο σε  μέγεθος γραμματοσειράς Arial 16 και να είναι κεντραρισμένος
(center-aligned) , μπορείς με ένα βήμα να καθορίσεις το στυλ του τίτλου μέσω του προκαθορισμένου
Στυλ ετικέτας “Title”(style tag) . Βάζοντας ετικέτες (Tagging) στο κείμενο με καθορισμένα Στυλ το
δομείς και βάζεις τις πληροφορίες του σε μια  σειρά.
Όταν ένα έγγραφο δημιουργείται  για πρώτη φορά , το πρόγραμμα της εφαρμογής  αυτόματα
εκχωρεί σε όλο το κείμενο το  στυλ της ετικέτας “Normal”. Η  αλλαγή του στυλ αυτόματα σχετίζεται
με  :

 Την εφαρμογή μιας υπάρχουσας ετικέτας Στυλ που αναφέρεται ως  «ενσωματωμένο»
Στυλ

  Την δημιουργία  δικιάς σας ετικέτας  Στυλ
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 Την  τροποποίηση  των υπαρχόντων ετικετών Στυλ

Μια ενσωματωμένη ετικέτα Στυλ (style tag) είναι μια ετικέτα με προκαθορισμένα χαρακτηριστικά
από το Ms Word.Υπάρχει  ποικιλία από ενσωματωμένες ετικέτες.
Τα πιο συχνά χρησιμοποιούμενα ενσωματωμένα Στυλ περιλαμβάνουν  το Τίτλο, το Σώμα του
Κειμένου, τις Επικεφαλίδες των Επιπέδων 1,2,3, το Σχήμα ή τη Λεζάντα.
Κατευθυντήριες γραμμές για το κείμενο :

 Χρησιμοποιήστε  πρότυπο με γραμματοσειρά που συναντάτε συχνά στα κείμενα
(common font). Ασυνήθιστες γραμματοσειρές δεν βοηθούν την προσβασιμότητα

 Επιλέξτε το μέγεθος της γραμματοσειράς να μην είναι μικρότερο από 10 γιατί οι
αναγνώστες με λίγη όραση δεν θα μπορέσουν να τη  καταλάβουν

 Κάντε όλο το κείμενο σας εκτός από τον Τίτλο, να είναι   ευθυγραμμισμένο 
αριστερά γιατί είναι πιο εύκολο να διαβαστεί. Όταν το κείμενο είναι
ευθυγραμμισμένο στο κέντρο τότε υπάρχουν κενά μεταξύ των λέξεων , γεγονός που
καθιστά δύσκολη την ανάγνωση και την κατανόηση

 Μορφοποιήστε  το έγγραφο σας χρησιμοποιώντας μπλοκ στυλ (π.χ  να μην υπάρχουν
 εσοχές εκτός από εκείνες που δημιουργούν οι κουκκίδες και η αρίθμηση). Οι
άνθρωποι που χρησιμοποιούν αναγνώστες οθόνης μπορεί να κάνουν πλοήγηση στο
κείμενο γραμμή – γραμμή ή διάστημα – διάστημα. Αν ο κέρσορας είναι στην αρχή
μιας  γραμμής που έχει εσοχή  δεν γνωρίζουν τις πληροφορίες της γραμμής

  Δημιουργήστε ετικέτες επικεφαλίδας (heading tags)   μέσα στην ετικέτα του
σώματος του κειμένου (body text tag). Χρησιμοποιήστε διαφορετικό μέγεθος και
είδος γραμματοσειράς. Τα διαφορετικά στυλ και οι διαφορετικές μορφοποιήσεις
βοηθούν τους χρήστες να διακρίνουν τις επικεφαλίδες από το σώμα του κειμένου.

 Μην τοποθετείτε επικεφαλίδα μέσα στο σώμα κειμένου. Τα περιθώρια θα
διαφοροποιήσουν  τις  επικεφαλίδες   από το σώμα του κειμένου

ΣΤΉΛΕΣ

Οι στήλες παρέχουν την δομή για να ερμηνευθεί σωστά η ροή του κειμένου από τα τεχνολογικά μέσα
υποστήριξης.
Μην χρησιμοποιήσετε το πλήκτρο Tab για τις στήλες. Τα προγράμματα ανάγνωσης οθόνης θα
διαβάσουν το κείμενο σαν να ήταν οργανωμένο σε καρτέλες (tabbed text). Δεν μπορούν να
διακρίνουν ότι το κείμενο είναι σε στήλες.
Αν το κείμενο σας  πρόκειται να γραφεί σε  στήλες διαχωρίστε αυτές με περιθώριο αρκετό. Τα άτομα
χαμηλής όρασης λόγω του ότι χρησιμοποιούν μεγεθυντικούς φακούς για να δουν το κείμενο  στην
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οθόνη δεν είναι σε θέση να διαφοροποιήσουν τις στήλες αν δεν υπάρχει αρκετό διάστημα μεταξύ
τους.

ΠΊΝΑΚΕΣ

Δημιουργήστε πίνακες με το εργαλείο που προσφέρεται από το Ms Word (Insert Table feature). Με
αυτό ορίζεις τις ιδιότητες του πίνακα όπως μπορείς να προσθέτεις ή σβήνεις γραμμές και στήλες.
Οι επικεφαλίδες Στήλης εμφανίζεται στη κορυφή της. Αυτές πρέπει να είναι σύντομες και
περιγραφικές.
Οι επικεφαλίδες γραμμής τοποθετούνται στη πρώτη αριστερή στήλη του πίνακα. Αυτές πρέπει να
είναι περιγραφικές για να τα καταλαβαίνουν οι αναγνώστες τι αντιπροσωπεύουν τα δεδομένα.
Στο παράδειγμα  που ακολουθεί , οι επικεφαλίδες στήλης είναι οι ημέρες της βδομάδας  και
εμφανίζονται στη πρώτη γραμμή. Οι επικεφαλίδες γραμμών είναι ώρες της ημέρας και εμφανίζονται
κάθετα στη πρώτη στήλη.

Πίνακας 5  Παράδειγμα πίνακα
Monday Tuesday Wednesday Thursday Friday

8
AM
9

AM

Δεν πρέπει να χρησιμοποιείτε γραμμή ή στήλες για να προκαλέσουμε οπτικά εφέ. Για παράδειγμα μια
γραμμή με σκούρα γκρι απόχρωση  θα μπορούσε να εισαχθεί ως γραμμή κάτω από την επικεφαλίδα
στήλης για να διαχωρίσει τη γραμμή επικεφαλίδας από τα δεδομένα. Το πρόγραμμα ανάγνωσης
οθόνης θα διάβαζε αυτή τη γραμμή ως κενό. Αντί αυτού θα μπορούσατε να είχατε το αποτέλεσμα
διαχωρισμού με το αλλάξετε το πάχος διαχωρισμού των γραμμών ή  των στηλών.

ΥΠΕΡΣΥΝΔΈΣΕΙΣ

Οι υπερσυνδέσεις είναι μια έγχρωμη υπογραμμισμένη φράση κειμένου ή ένα γραφικό που όταν
κάνετε κλικ σ’ αυτό θα  σας μεταφέρει  σε ένα αρχείο ή σε μια HTML τοποθεσία.
Στο Ms Word μια υπερσύνδεση μπορεί να συνδέσει :

  Τα στοιχεία ενός εγγράφου (εσωτερική σύνδεση)
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  Το κείμενο με  ένα εναλλακτικό έγγραφο ή μια ιστοσελίδα (εξωτερική σύνδεση)

Η υπερσύνδεση δίνει τη δυνατότητα στους χρήστες να περιηγηθούν σε ένα έγγραφο γρήγορα και
εύκολα επιτρέποντας να έχουν πρόσβαση στο περιεχόμενο που τους ενδιαφέρει χωρίς να χρειαστεί
να διαβάσουν ολόκληρο το έγγραφο.
Το Ms Word δημιουργεί μια υπερσύνδεση αυτόματα όταν γραφεί η διεύθυνση μιας ιστοσελίδας π.χ
http://www.microsoft.com/en/us/default.aspx . Αυτό γίνεται αν είναι ενεργοποιημένη η αυτόματη
μορφοποίηση των υπερσυνδέσεων.
Όλες οι υπερσυνδέσεις θα πρέπει να ελέγχονται για να βεβαιωθεί ο ακριβής προορισμός του
συνδέσμου. Εάν ένα επιπλέον κενό περιληφθεί στο τέλος μιας σύνδεσης δεν θα φορτώνεται η
ιστοσελίδα.
Για να δημιουργήσετε υπερσυνδέσεις με προσβασιμότητα,  χρησιμοποιήστε περιγραφικό κείμενο μαζί
με την πλήρη ηλεκτρονική διεύθυνση. Αυτό εξασφαλίζει ότι οι σύνδεσμοι  θα διαβάζονται σωστά με
βάση το περιεχόμενο του κειμένου. Όταν χρησιμοποιείτε τις εικόνες για υπερσυνδέσεις βεβαιωθείτε
ότι το εναλλακτικό τους κείμενο  αφορά τις  ίδιες τις  συνδέσεις για να μπορεί ο αναγνώστης οθόνης
να τις εντοπίσει.

5.1.3 Εικόνες

Η εμφάνιση στατικών εικόνων (static images) είναι σύνηθες στα έγγραφα του Ms Word. Μια στατική
εικόνα δεν έχει κίνηση. Μπορεί να είναι ένα clip art ,  μια φωτογραφία ή ένα διάγραμμα. Κινούμενες
εικόνες μπορούν να τοποθετηθούν στα έγγραφα του Ms Word. Αξίζει να σημειωθεί ότι μια κινούμενη
εικόνα θα εμφανιστεί ως στατική όταν  το έγγραφο αποθηκευτεί ως ιστοσελίδα.
Συχνά τα διαγράμματα και τα  γραφήματα  περιέχουν πληροφορίες που είναι μεγάλες για να
περιγράφουν  με εναλλακτικό κείμενο. Στις περιπτώσεις αυτές καλό είναι να υπάρχει ένα κείμενο που
θα περιγράψει αυτά  στο σώμα του εγγράφου. Αν η δομή του κειμένου  διακόπτει τη ροή της
πληροφορίας σκόπιμο είναι να συμπεριληφθεί σε ένα παράρτημα με όλη την απαραίτητη
συμπληρωματική πληροφορία.
Κατευθυντήριες γραμμές για τις εικόνες :

 Tα πλαίσια κειμένου να μην χρησιμοποιούνται ως  λεζάντες στα  απλά γραφικά

 Να μην χρησιμοποιούνται εικόνες υπόβαθρου η υδατογραφήματα. Αυτά τα στοιχεία
δυσκολεύουν τους αναγνώστες που χρησιμοποιούν τα μέσα μεγέθυνσης για να
διακρίνουν το κείμενο από το φόντο

 Μην επικολλήσετε γραφικό σε πλαίσιο κειμένου

 Όλες οι εικόνες πρέπει να εξηγούνται στο κείμενο

 Πάντα πρέπει να αποδίδεται εναλλακτικό κείμενο σε οποιοδήποτε γραφικό

 Το περιεχόμενο δεν πρέπει να προβάλλεται μόνο με τη χρήση του χρώματος

http://www.microsoft.com/en/us/default.aspx
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Οι ιδιότητες του γραφικού θα πρέπει να απαλειφθούν για να διαβαστεί από τα τεχνολογικά  μέσα
υποστήριξης.
Για να διασφαλιστεί ότι το γραφικό σας  διατηρεί τη σωστή σειρά ανάγνωσης  είναι απαραίτητο να
ρυθμίσετε τις ιδιότητες των γραφικών ώστε να διαβάζεται  «πάνω στη γραμμή του κειμένου» (in line
with text). Αν και το Ms Word προσφέρει πολλά στυλ αναδίπλωσης το κάθε γραφικό τοποθετείται σε
μια γραμμή και σε θέση σχετική με το κείμενο του εγγράφου. Οι άλλες μορφές αναδίπλωσης κάνουν
το γραφικό να φαίνεται ότι «επιπλέει» (floating) σχετικά με το κείμενο.

ΕΝΑΛΛΑΚΤΙΚΌ ΚΕΊΜΕΝΟ

Το εναλλακτικό κείμενο χρησιμοποιείται για να περιγράψει όλα τα στοιχεία που δεν είναι κείμενο
όπως τις εικόνες, τους τύπους, τα γραφήματα, τους χάρτες κ.λ.π. Οι περιγραφές πρέπει να είναι
ακριβείς και πλήρεις.
Τι πρέπει να κάνετε για να δημιουργήσετε εναλλακτικό κείμενο που θα συνδεθεί με  αντικείμενο :

 Κάνε κλικ στο αντικείμενο που  θα το αποδοθεί από το   εναλλακτικό κείμενο

 Από το βασικό Μενού, επιλέξτε Format > Picture (Μορφή > Εικόνα) (Object /
Autoshape –  Αντικείμενο / Αυτόματο Σχήμα)

 Επιλέξτε τη καρτέλα  WEB

 Πληκτρολογήστε το εναλλακτικό κείμενο στο πεδίο Text

 Κάντε κλικ στο κουμπί  ΟΚ  για  να συνδεθεί το εναλλακτικό κείμενο με το
αντικείμενο 

Η  δημιουργία και  το «πάντρεμα» εναλλακτικού κειμένου με στοιχεία  που δεν είναι κείμενο δίνουν τη
δυνατότητα στην υποστηρικτική τεχνολογία να ερμηνεύσει και να μεταδώσει την έννοια του
αντικειμένου στον αναγνώστη. Αν το έγγραφό σας πρόκειται να μετατραπεί σε αρχείο PDF ή σε
ιστοσελίδα  το εναλλακτικό κείμενο είναι σημαντικό .
Κατευθυντήριες γραμμές για  εναλλακτικό κείμενο :

 Τα μαθηματικά σύμβολα όπως =,+,*,/ πρέπει να γράφονται ως κείμενο(δηλαδή
ισούται, συν, αστερίσκος, μπάρα)

  Γενικά οι αριθμοί και οι ακέραιοι μπορούν να γραφτούν σε αριθμητική μορφή. Η
μόνη εξαίρεση είναι αν ο αριθμός είναι κλάσμα. Τα κλάσματα πρέπει να γράφονται
με κείμενο. Για παράδειγμα το 2/3  θα πρέπει να γραφτεί ως δυο τρίτα. Πρέπει να

αποφεύγονται διατυπώσεις όπως 2/3rds, 4th.

 Συντομογραφίες μπορούν να χρησιμοποιηθούν αλλά πρέπει να αναγράφονται στην
πλήρη μορφή τους όταν γράφονται για πρώτη φορά στη ενότητα. Αυτό είναι χρήσιμο
όταν το έγγραφο δεν διαβάζεται με μια σειρά (linearly)
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 Πρέπει να γράφεται το πρώτο γράμμα κάθε λέξης κεφαλαίο όταν εισάγετε
διευθύνσεις ηλεκτρονικού ταχυδρομείου (ή άλλες λέξεις που συνδέονται μεταξύ με
κενό διάστημα). Οι αναγνώστες οθόνης διαβάζουν το κείμενο ως να ήταν ξεχωριστές
λέξεις.

ΛΕΖΆΝΤΕΣ

Η  λεζάντα είναι μια ετικέτα με αρίθμηση όπως το Σχήμα 1 . Έτσι μπορείτε να τη συσχετίσετε με  ένα
πίνακα  ή μια εικόνα ή μια εξίσωση ή κάποιο άλλο στοιχείο. Με τις  λεζάντες οργανώνεται η σελίδα.
Επίσης παρέχονται συμπληρωματικές  πληροφορίες σχετικά με την ιεράρχηση των αντικειμένων. Οι
λεζάντες παράγονται αυτόματα από το Ms Word  όπως και χειροκίνητα.
Όταν δημιουργείται στο Ms Word μια λεζάντα θα  πρέπει αρχικά να εισάγετε την ετικέτα της όπως τη
λέξη Σχήμα και στη συνέχεια τον αριθμό της. Θα χρειαστεί να γράψετε κάποιο κείμενο για να
περιγράψετε το αντικείμενο της. Αυτό θα γίνει  με το να τοποθετήσετε τον κέρσορα μετά τη λεζάντα
και να πληκτρολογήσετε  τη επιθυμητή περιγραφή.

ΟΜΑΔΟΠΟΊΗΣΗ

Όταν μια εικόνα δημιουργείται από μικρότερες εικόνες όπως το κολάζ είναι χρήσιμο να
ομαδοποιήσετε τις μικρότερες εικόνες δημιουργώντας ένα αντικείμενο. Αυτό θα βοηθήσει τη
τεχνολογία υποστήριξης  να το ερμηνεύσει.
Μετά την ομαδοποίηση των αντικειμένων θα πρέπει να γίνει προσθήκη εναλλακτικού κειμένου.

5.1.4 Πολυμέσα

Στο Βίντεο και τον ήχο μπορούν να έχουν προσβασιμότητα άτομα με ειδικές ανάγκες όπως  με
προβλήματα όρασης και  ακοής καθώς και άτομα που δεν έχουν τόσο εξελιγμένα συστήματα
ηλεκτρονικών υπολογιστών. Δείτε προσεκτικά τα παρακάτω πριν συμπεριλάβετε βίντεο και  ήχο σε
έγγραφο του Ms Word.
 Να εξετάσετε αν τo βίντεο (ή ο ήχος)  έχουν ουσιαστική πληροφορία να δώσουν ;

 Να εξετάσετε αν θα κάνετε το έγγραφο σας πιο κατανοητό με τις πληροφορίες του βίντεο ή
του ήχου που θα προσθέσετε ;

 Να εξετάσετε αν τα μέσα που υποστηρίζουν βίντεο και ήχο μπορούν να επικοινωνήσουν με τα
στατικά εργαλεία (static tools) ;
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 Να εξετάσετε αν το κόστος ανάπτυξης , συντήρησης και διατήρησης των  μέσων αυτών είναι
δικαιολογημένο ; Και αυτό γιατί τα αρχεία πολυμέσων είναι μεγάλα και απαιτούν επιπλέον
αποθηκευτικό χώρο. 

 Να εξετάσετε αν το κοινό που απευθύνονται τα μέσα αυτά διαθέτουν τις τεχνολογικές
γνώσεις για να τα χρησιμοποιήσουν και να έχουν πρόσβαση στα αντικείμενα αυτών ;

VIDEO

Aν το video σας συνοδεύεται από ήχο τότε είναι απαραίτητες οι  λεζάντες. Αυτές πρέπει να
βρίσκονται σε συγχρονισμό  με τα αντίστοιχα video  έτσι ώστε να  μπορούν οι χρήστες να διαβάζουν
και να  βλέπουν τη γλώσσα του σώματος (body language) και κάθε άλλη οπτική πληροφορία που θα
συνοδεύει το κείμενο. Οι λεζάντες του video θα πρέπει να ακολουθούν τις λέξεις του προφορικού
λόγου και να έχουν πρόσθετες περιγραφές, επεξηγήσεις, σχόλια και κάθε τι που βοηθά.
Λόγω του ότι  υπάρχει ήχος  πρέπει να δημιουργείται ένα  αντίγραφο (transcript). Αυτό είναι ένα
ξεχωριστό έγγραφο ή παράγραφος που μεταβιβάζει τις πληροφορίες που περιέχονται στον ήχο. Αν το
βίντεο περιλαμβάνει μουσική  είναι απαραίτητο να έχει  στίχους (lyrics) για τη κατανόηση του. Ένα
αντίγραφο (transcript) μπορεί να έχει πρόσθετες περιγραφές , επεξηγήσεις ή και σχόλια. Στα μεγάλα
βίντεο ένα αντίγραφο είναι ένας καλός τρόπος για τους έμπειρους  χρήστες της τεχνολογίας να
αποκτήσουν τις πληροφορίες πιο γρήγορα καθώς είναι πιθανόν να έχουν γρήγορους αναγνώστες
οθόνης .
Υπάρχουν εργαλεία λογισμικού που μπορεί να βοηθήσουν στη δημιουργία λεζάντων και ηχητικών
περιγραφών. Ένα τέτοιο είναι το Media Access Generator (MAGpie). Τα περισσότερα από αυτά είναι
εφαρμογές συμβατές με το  RealPlayer,  το QuickTime και τον Media Player.
Στα βίντεο χωρίς ήχο  μια λεζάντα είναι  κατάλληλη για  να περιγράψει το περιεχόμενο του κλιπ (clip) .
Λόγω  έλλειψης ήχου ενδείκνυται οπωσδήποτε μια λεζάντα για να περιγράφει  το περιεχόμενο.

AUDIO

Όταν εξετάζετε αρχείο ήχου είναι σημαντικό να βεβαιωθείτε ότι οι πληροφορίες του  είναι ακριβείς.
Δηλαδή  για παράδειγμα μια περιγραφή με δυο λέξεις όπως «H ομιλία του Προέδρου» δεν θα ήταν
αρκετό όπως το ισοδύναμο αρχείο ήχου (equivalent audio file) ενός αντίγραφου του πραγματικού
λόγου. Τα σύντομα αρχεία ήχου (short audio files) πρέπει να έχουν εναλλακτικό κείμενο όπως τα
γραφικά. Το εναλλακτικό κείμενο μπορεί να τεθεί ως λεζάντα.
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Σημείωση : Η λέξη Λεζάντα (Caption)  που αναφέρθηκε εδώ , είναι κείμενο που περιγράφει  και
τοποθετείται κάτω από το γραφικό. Δεν  έχει σχέση με τις λεζάντες του βίντεο.

5.1.5 Βοηθήματα πλοήγησης και οργάνωσης

Οι επικεφαλίδες , οι λίστες με αρίθμηση ,οι πίνακες περιεχομένων, οι υπερσυνδέσεις και ευρετήρια
είναι μερικά από τα στοιχεία του εγγράφου που μπορεί κάποιος χρήστης με αναπηρία να
χρησιμοποιήσει για να περιηγηθεί.

ΕΠΙΚΕΦΑΛΊΔΕΣ

Οι επικεφαλίδες είναι ένα αποτελεσματικό μέσο για να συνδέεται η δομή του εγγράφου. Τα μεγάλα
έγγραφα χωρίζονται σε θέματα - κεφάλαια (chapters), τα θέματα σε υποθέματα (subtopics) , τα
υποθέματα σε τμήματα (sections) και τα τμήματα σε παραγράφους. Αυτά τα σημασιολογικά μέρη
πληροφοριών αποτελούν τη δομή ενός εγγράφου. Οι επικεφαλίδες πρέπει να διακρίνονται από το
σώμα (κύριο μέρος) του εγγράφου. Μπορούν να έχουν διαφορετικά μεγέθη γραμμάτων  και
διαφορετικές γραμματοσειρές. Επικεφαλίδες που έχουν μόνο κεφαλαία γράμματα είναι δύσκολο να
διαβαστούν.

ΛΊΣΤΕΣ ΜΕ ΑΡΊΘΜΗΣΗ

Οι λίστες με αρίθμηση (numbered lists) βοηθούν τη πλοήγηση δημιουργώντας  διαφορετικά  επίπεδα
(different level)  πληροφόρησης . Βοηθούν τη περαιτέρω δόμηση του εγγράφου.

ΠΊΝΑΚΑΣ ΠΕΡΙΕΧΟΜΈΝΩΝ

Οι  χρήστες χρησιμοποιώντας τον πίνακα περιεχομένων  βλέπουν με  μια ματιά τα περιεχόμενα του
εγγράφου και  περιηγούνται  σε αυτό.
Πριν τη δημιουργία του πίνακα περιεχομένων πρέπει να κάνουμε κάποια προετοιμασία για τον τρόπο
σχηματισμού του χρησιμοποιώντας τα στυλ των ετικετών ή ένα περίγραμμα των επιπέδων (outline
level format) διάρθρωσης. Ο πίνακας περιεχομένων  δημιουργείται από αυτά και ενσωματώνεται στο
κείμενο.

ΕΥΡΕΤΉΡΙΑ

Ένα ευρετήριο δημιουργείται αν κάνετε την επισήμανση των σημείων του κειμένου που θα μπουν στη
λίστα και στη συνέχεια τη δομήσετε.  Σε  μεγάλα έγγραφα ή σε έγγραφα υψηλής τεχνικής  το
ευρετήριο είναι ένα χρήσιμο εργαλείο για την εύρεση  συγκεκριμένων πληροφοριών.
Επιστροφή  Οδηγός Προσβασιμότητας  στα  προγράμματα Word και PowerPoint

5.2 Πως δημιουργώ  παρουσίαση με προσβασιμότητα στο Ms Powerpoint
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Πολλά από τα στοιχεία προσβασιμότητας  στο Ms Powerpoint  είναι παρόμοια με εκείνα του  Ms
Word. Τα στοιχεία αυτά περιλαμβάνουν εναλλακτικό κείμενο σε εικόνες , εσωτερικές και εξωτερικές
συνδέσεις , τρόπους οργάνωσης , σαφή και συνοπτική γλώσσα όπως και συγκεκριμένες
γραμματοσειρές. Όμως ορισμένα στοιχεία έχουν  ιδιαίτερη σημασία για το Ms Powerpoint λόγω του
ότι είναι  εφαρμογή  με  οπτικό περιεχόμενο. Αυτά τα επιπλέον στοιχεία έχουν να κάνουν με την
υψηλή αντίθεση στις ρυθμίσεις της οθόνης που θέτουν περιορισμένους στους συνδυασμούς των
χρωμάτων και  την αφήγηση των διαφανειών.
Απλό μόνο κείμενο θα κάνει τη παρουσίαση να έχει προσβασιμότητα με δυσκολία. Αξίζει να σημειωθεί
ότι η  χρήση εικόνων, διαγραμμάτων και πολυμέσων μπορεί να δημιουργήσει προβλήματα
προσβασιμότητας στα άτομα με ειδικές ανάγκες. Εναλλακτικό κείμενο πρέπει να παρέχεται στα
αντικείμενα που δεν έχουν κείμενο. Στις επόμενες ενότητες θα  εξετάσουμε πως τα αντικείμενα που
δεν είναι κείμενο  θα αποκτήσουν προσβασιμότητα.

5.2.1 Γενικές  Επιλογές Προσβασιμότητας

Ακολουθώντας τις παρακάτω οδηγίες θα μπορέσετε να βελτιώσετε την ποιότητα και τη δομή του
περιεχομένου της παρουσίασης  και κατά συνέπεια την προσβασιμότητα της.

 Να χρησιμοποιείτε σαφή γλώσσα με λογική σειρά ανάγνωσης. Να οργανώσετε το
περιεχόμενο και τις επικεφαλίδες  ώστε να διαβάζονται με λογική σειρά. Να εισάγετε
τις πληροφορίες από πάνω προς τα κάτω και από αριστερά προς τα δεξιά

 Να χρησιμοποιείτε χρώματα με έντονες αντιθέσεις που βελτιώνουν την
αναγνωσιμότητα

 Να εισάγετε εναλλακτικό κείμενο στα αντικείμενα για τους χρήστες που
υποβοηθούνται  από τη τεχνολογία ανάγνωσης

 Να έχετε ένα αντίγραφο κειμένου για τον ήχο. Ο ήχος να μην είναι το μοναδικό μέσο
μετάδοσης πληροφοριών. Κάντε τις περιγραφές κειμένου να έχουν προσβασιμότητα
για τους χρήστες με προβλήματα ακοής

 Οι εσωτερικές και οι εξωτερικές υπερσυνδέσεις βοηθούν τους χρήστες να
προσπελάσουν  το έγγραφο

5.2.2 Κείμενο

Οι γραμματοσειρές μπορούν να διαδραματίσουν μεγάλο ρόλο σε θέματα προσβασιμότητας. Λάβετε
υπόψη σας τα παρακάτω όταν επιλέγετε γραμματοσειρές :
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 Χρησιμοποιήστε  γραμματοσειρές Sans Serif  (όπως Arial). Αυτών των γραμματοσειρών τα
γράμματα είναι καθαρά και ευανάγνωστα. Να τα χρησιμοποιείτε για τους τίτλους και τις
επικεφαλίδες.

 Μην χρησιμοποιείται περισσότερες από δυο διαφορετικές γραμματοσειρές σε μια παρουσίαση

 Δεν μεταφέρει πληροφορίες το χρώμα μόνο του

 Δημιουργήστε αντίθεση μεταξύ των  χρωμάτων του φόντου και της γραμματοσειράς

 Χρησιμοποιήστε σταθερά  μεγέθη για τις γραμματοσειρές όπως για το τίτλο μέγεθος  44 , για
το πρώτο επίπεδο ενότητας  μέγεθος 32, για το δεύτερο επίπεδο  ενότητας μέγεθος  28,  για
το τρίτο επίπεδο ενότητας  μέγεθος 24, για το τέταρτο επίπεδο ενότητας  μέγεθος 22 και για
το πέμπτο επίπεδο ενότητας  μέγεθος 20

 Μην χρησιμοποιείτε  μέγεθος γραμματοσειράς μικρότερο του μεγέθους 20

ΣΤΉΛΕΣ

Μπορείτε να επιλέξετε στην  ίδια διαφάνεια μια διάταξη μέχρι και τέσσερεις στήλες για την εμφάνιση
του κειμένου , των εικόνων, των  κλιπ και των πολυμέσων. Η διάταξη  πολλαπλών στηλών δίνει τη
δυνατότητα να διαχωρίσετε  τις εικόνες / κλιπ από το κείμενο. Χρησιμοποιώντας τις επιλογές
διάταξης διαφάνειας (σε αντίθεση με τη δημιουργία πολλαπλών πλαισίων κειμένου) οργανώνουμε τις
πληροφορίες της διαφάνειας.
Αν  εισάγετε  νέες στήλες, να τις εισάγετε από τα δεξιά των υπαρχουσών στηλών με τη σειρά που θα
διαβάζονται. Έτσι εξασφαλίζεται μια λογική σειρά ανάγνωσης για τους αναγνώστες οθόνης (screen
readers) και τους χρήστες που χρησιμοποιούν το πλήκτρο Tab.

ΠΊΝΑΚΕΣ

Οι πίνακες αποτελούν πρόκληση για τους χρήστες της τεχνολογίας  ειδικών αναγκών. Η δομή του
πίνακα πρέπει να έχει λογικές συσχετίσεις μεταξύ των στοιχείων του. Η σήμανση των στηλών και των
γραμμών των στοιχείων του πίνακα κάνει τη  παρουσίαση ευκολότερη στα άτομα με αναπηρία.
Πρέπει να φαίνονται οι επικεφαλίδες των γραμμών και των στηλών με σαφήνεια.
Είναι καλό να  συμπεριληφθεί στο κείμενο μια περίληψη ή ένα επεξηγηματικό κείμενο για το πίνακα .
Αυτή η μικρή βοήθεια κάνει τη διαφορά μεγάλη για τους  χρήστες  της τεχνολογίας  ειδικών αναγκών.
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ΥΠΕΡΣΥΝΔΈΣΕΙΣ

Η υπερσύνδεση  συνδέει μια διαφάνεια με μια επόμενη διαφάνεια ή μια ιστοσελίδα ή ένα αρχείο. Η
υπερσύνδεση είναι κείμενο ή ένα αντικείμενο όπως μια εικόνα, ένα γράφημα, ένα σχήμα ή ένα
WordΑrt. Η υπερσύνδεση μας πλοηγεί εύκολα και γρήγορα σε μια παρουσίαση. Μας επιτρέπει να
έχουμε πρόσβαση στο περιεχόμενο που ενδιαφερόμαστε χωρίς να χρειάζεται να διαβάσουμε
ολόκληρη τη παρουσίαση. Οι υπερσυνδέσεις παρέχουν  μεγάλη βοήθεια στη προσβασιμότητα και τη
πλοήγηση.
Για να δημιουργήσεις υπερσυνδέσεις με προσβασιμότητα χρησιμοποιήστε κείμενο που να περιγράφει
την υπερσύνδεση μαζί με την πλήρη ηλεκτρονική της  διεύθυνση αντί να λέτε κάνετε «κλικ εδώ». Αυτό
θα εξασφαλίσει ότι οι σύνδεσμοι θα διαβάζονται σωστά και δεν θα  οδηγήσουν εκτός περιεχομένου
Για τις υπερσυνδέσεις που χρησιμοποιούν εικόνες είναι απαραίτητο το εναλλακτικό κείμενο ώστε οι
αναγνώστες οθόνης να μπορούν να τις εντοπίζουν.
Μπορείτε να δημιουργήσετε προσαρμοσμένα κουμπιά (customized action buttons) εισάγοντας  ένα
πλαίσιο κειμένου (text box with borders) και μια υπερσύνδεση που να καθορίζει τον προορισμό μέσα
στο αρχείο όπως  προηγούμενο, επόμενο, στην αρχή.

5.2.3 Εικόνες

Οι εικόνες  όπως τα  κλιπ (clip art) και οι φωτογραφίες μπορούν να χρησιμοποιηθούν σε μια
παρουσίαση. Ωστόσο θα πρέπει να δώσουμε έναν εναλλακτικό τρόπο για την πρόσβαση του
περιεχομένου που απεικονίζουν.
Οι χρήστες με προβλήματα όρασης εξαρτώνται από τις ακριβείς περιγραφές ή το εναλλακτικό
κείμενο  για να κατανοήσουν τις εικόνες, τα γραφήματα, τα διαγράμματα κ.λ.π.
Στοιχεία που δεν έχουν κείμενο είναι απαραίτητο να έχουν εναλλακτικό ή περιγραφικό κείμενο για να
αναδείξουν το περιεχόμενο που απεικονίζει η εικόνα.

ΣΎΝΤΟΜΗ ΠΕΡΙΓΡΑΦΉ  ΓΡΑΦΙΚΟΎ ΜΕ ΚΕΊΜΕΝΟ

Το κείμενο περιγραφής παρέχει μια σύντομη περιγραφή ενός γραφικού, ενός αντικειμένου, ενός
σχήματος, ενός πίνακα κ.τ.λ.  χρησιμοποιώντας το όνομα, το σκοπό, τον αριθμό, το τίτλο κ.λ.π. Βάλε
ένα πλαίσιο κειμένου στο πάνω ή το κάτω μέρος μιας εικόνας και μέσα σ’ αυτό το κείμενο που
περιγράφει το αντικείμενο. Το λογισμικό ανάγνωσης το αναγνωρίζει και το διαβάζει.
Να εισάγετε τα στοιχεία που εμφανίζονται στην οθόνη με τη σειρά που πρέπει να διαβάζονται. Για
παράδειγμα τοποθετήστε πλαίσιο κειμένου περιγραφής  στη συνέχεια το γραφικό αντικείμενο και μην
τα μετακινήσετε μετά  την εισαγωγή.
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ΕΝΑΛΛΑΚΤΙΚΌ ΚΕΊΜΕΝΟ

Το εναλλακτικό κείμενο χρησιμοποιείται για να περιγράψει όλα τα στοιχεία του κειμένου που δεν είναι
κείμενο ( non-element text) για αυτούς που έχουν προβλήματα όρασης. Ως μη κείμενο είναι οι
εικόνες, οι τύποι , τα γραφήματα, οι χάρτες κ.τ.λ. Το εναλλακτικό κείμενο είναι ενσωματωμένο στο
αντικείμενο. Γενικά δεν είναι ορατό στους χρήστες αλλά είναι ορατό από τα άτομα με ειδικές
ανάγκες. Αναγνωρίζεται από το λογισμικό του  αναγνώστη οθόνης (screen reading software) και
αποτελεί τον εναλλακτικό τρόπο  παροχής πληροφοριών των  διαφανειών  της παρουσίασης στους
χρήστες με προβλήματα όρασης. Οι περιγραφές του κειμένου θα πρέπει να είναι ακριβείς και
πλήρεις.
Βεβαιωθείτε ότι το εναλλακτικό κείμενο έχει λεπτομέρειες ώστε οι χρήστες με προβλήματα όρασης
να κατανοήσουν το περιεχόμενο και τις πρόσθετες πληροφορίες των  οπτικών  εφέ .
Το πρόγραμμα ανάγνωσης οθόνης θα διαβάσει την περιγραφή και το εναλλακτικό κείμενο.
Βεβαιωθείτε ότι δεν είναι ταυτόσημες και αλληλοσυμπληρώνονται.
Για τη δημιουργία εναλλακτικού κειμένου ακολουθήστε τα βήματα :

 Κάντε κλικ στο αντικείμενο που θα του αποδοθεί εναλλακτικό κείμενο

 Από το κύριο μενού επιλέξτε Μορφή > Αυτόματο σχήμα ή (Εικόνα / Αντικείμενο)
(Format > Autoshape  or (Picture / Object)

 Επιλέξτε τη καρτέλα Web

 Πληκτρολογήστε το εναλλακτικό κείμενο στο πεδίο (Alternate text field)

 Κάντε κλικ στο ΟΚ . Το εναλλακτικό κείμενο έχει συνδεθεί με το αντικείμενο

5.2.4 Δυνατότητες  Πολυμέσων

Αρκετά από τα χαρακτηριστικά που θα τα περιγράψουμε παρακάτω δεν συνίσταται γιατί κάνουν την
προσβασιμότητα δύσκολη. Παρόλα αυτά οι λειτουργίες βίντεο και ήχου είναι χρήσιμες και κάνουν την
παρουσίαση πιο ελκυστική. Να είστε προσεκτικοί κατά την εφαρμογή αυτών των δυνατοτήτων.

ΚΟΥΜΠΙΆ  ΔΡΆΣΗΣ (ACTION BUTTONS)

Τα κουμπιά Δράσης λειτουργούν σαν υπερσυνδέσεις στη παρουσίαση. Τα ενσωματωμένα κουμπιά
(Built–in action buttons) δεν γίνονται αντιληπτά  από τα μέσα υποστήριξης και αυτός είναι ένας
λόγος να μην χρησιμοποιούνται. Αντί αυτών δημιουργήστε μια υπερσύνδεση στο σημείο της
παρουσίασης που θέλετε χρησιμοποιώντας το κλίπ (clip art) αφού μοιάζει με κουμπί.

ΠΡΟΒΟΛΉ ΚΊΝΗΣΗΣ (SLIDE ANIMATION)
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Το Ms Powerpoint  έχει μια ενσωματωμένη  (custom)  δυνατότητα που επιτρέπει να προσθέτεις
ειδικά οπτικά εφέ σε κείμενο ή αντικείμενο. Μπορείτε να κάνετε το κείμενο σας να εμφανίζεται
μια-μια λέξη από τα αριστερά ή όταν εμφανίζεται μια εικόνα να ακούτε ένα χειροκρότημα.
Τα στοιχεία αυτά μπορούν να προκαλέσουν δυσκολίες στην προσβασιμότητα. Συνίστανται να
αποφεύγονται οι κινήσεις (animations) ειδικά αν δεν συμβάλλουν εννοιολογικά. Τα άτομα με οπτική
και ακουστική αναπηρία δεν επωφελούνται από αυτά. Αποφύγετε τα εφέ διαρκής κίνησης, αυτά που
προκαλούν την κίνηση του συρσίματος (crawl) , της έντασης (peek) και  αυτά που αναβοσβήνουν σαν
φλας. Αποφεύγετε να χρησιμοποιείτε τις επιλογές κίνησης του κειμένου να εμφανίζεται λέξη-λέξη ή
γράμμα- γράμμα.

ΜΕΤΑΒΆΣΕΙΣ ΠΡΟΒΟΛΉΣ (SLIDE TRANSITIONS)

Το Ms Powerpoint έχει μια μεγάλη επιλογή διαφανειών μετάβασης. Οι μεταβάσεις (transactions)
καθορίζουν τον τρόπο της εναλλαγής  των διαφανειών της προβολής μιας παρουσίασης. Οι
μεταβάσεις των διαφανειών μπορούν να  οδηγήσουν το κοινό της παρουσίασης σε διαφορετικά
θέματα και έννοιες ή κρατήσουν ζωντανή την παρουσίαση σας με την αίσθηση της κίνησης.
Αυτές οι μεταβάσεις δεν γίνονται αντιληπτές από τα βοηθητικά μέσα της τεχνολογίας. Πρέπει να
αποφεύγονται γιατί δεν διευκολύνουν. Αν αποφασίσετε να έχετε μεταβάσεις στις παρουσιάσεις σας
τότε να τις χρησιμοποιείτε συστηματικά και συνεχώς  και όχι με τυχαίο τρόπο.

ΗΧΗΤΙΚΆ ΕΦΈ (SOUND EFFECTS)

Το Ms Powerpoint έχει πολλά ηχητικά εφέ για να εισάγετε στο αρχείο της παρουσίασης σας. Όλα
αυτά θα πρέπει να αποφεύγονται. Αν τα συμπεριλάβετε τότε χρησιμοποιήστε το εναλλακτικό κείμενο
για τα περιγράψετε στους χρήστες που τα έχουν ανάγκη.

ΑΡΧΕΊΑ ΒΊΝΤΕΟ ΚΑΙ ΉΧΟΥ (VIDEO AND AUDIO FILES)

Το Βίντεο και ήχος να περιλαμβάνονται όπου είναι απαραίτητα. Όπως στα άλλα στοιχεία είχαμε
συμπεριλάβει εναλλακτικό κείμενο ή κάποιο κείμενο περιγραφής έτσι και εδώ θα πρέπει να κάνουμε
το ίδιο για τα βίντεο κλιπ. Αν η περιγραφή του βίντεο χωρίς ήχο έχει αρκετές γραμμές τότε να
περιγράψεις με λεπτομέρεια την οπτική δράση σε ξεχωριστό έγγραφο.
Βεβαιωθείτε ότι το βίντεο με ήχο έχει λεζάντες δηλαδή τα λόγια του ήχου εμφανίζονται στο κάτω
μέρος του βίντεο. Οι λεζάντες του βίντεο θα πρέπει να είναι ακριβείς και ακολουθούν την  προφορική
ομιλία. Μπορεί να υπάρχουν πρόσθετες περιγραφές , εξηγήσεις ή σχόλια .
Αν το βίντεο περιλαμβάνει μουσική, θα πρέπει να έχει τους στίχους μόνον εφόσον κρίνεται
απαραίτητο για την κατανόηση.
Για σύντομα ηχητικά αρχεία είναι σκόπιμο να συμπεριλάβετε το περιεχόμενο του ήχου σε λεζάντα και
να έχετε εναλλακτικό κείμενο όπως σε ένα γραφικό.
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Τα μεγάλα ηχητικά αρχεία  πρέπει να έχουν ξεχωριστό έγγραφο  που θα μεταφέρει τις πληροφορίες
του ήχου. Θα υπάρχει  πρόσβαση στις λέξεις του ηχητικού αρχείου σε όσους έχουν  πρόβλημα ακοής.
Οι λέξεις του αρχείου θα πρέπει να είναι ακριβείς.

ΑΦΉΓΗΣΗ (NARRATION)

Η αφήγηση είναι η φωνή υπόβαθρου που συνοδεύει  τη παρουσίαση. Η αφήγηση στη παρουσίαση
είναι χρήσιμη στη περίπτωση που  γίνεται σε κάποιο περίπτερο έκθεσης  και μπορεί να λειτουργεί
μόνη της. Για τους χρήστες με προβλήματα όρασης ή ανάγνωσης η αφήγηση είναι ένας εναλλακτικός
τρόπος πληροφόρησης.
Η μέθοδος είναι παρόμοια με τη προσθήκη ήχου σε κλιπ. Σε κάθε διαφάνεια θα πρέπει να
καταγραφεί μια αφήγηση και να εισαχθεί ως αρχείου ήχου. Για τις παρουσιάσεις των εκθέσεων ή των
περιπτέρων  είναι δυνατόν το αρχείο ήχου κάθε εισερχόμενης διαφάνειας να εκτελείται αυτόματα.
Αφού  τοποθετήσετε τα αρχεία ήχου σε κάθε διαφάνεια κάνετε μερικές δοκιμές για να διασφαλίσετε
ότι αφήγηση μιας διαφάνειας θα τελειώνει πριν από την επόμενη εμφανιζόμενη διαφάνεια. Για να το
καταφέρετε προσαρμόστε κατάλληλα τους χρονισμούς των διαφανειών σας. Βεβαιωθείτε ότι έχετε
συμπεριλάβει ένα αντίγραφο της αφήγησης σας.
Επιστροφή Πως δημιουργώ παρουσίαση με προσβασιμότητα στο PowerPoint

5.3 Ελέγχοντας τη προσβασιμότητα των αρχείων Ms Word και  Ms PowerPoint

5.3.1 Γενικά

ΧΡΗΣΙΜΟΠΟΙΏΝΤΑΣ ΤΙΣ ΚΑΡΤΈΛΕΣ ΤΩΝ  ΣΤΥΛ ΚΕΙΜΈΝΟΥ (TEXT STYLE TAGS)

Οι καρτέλες των ετικετών (Style tags) δημιουργούν ένα έγγραφο με σαφή δομή γιατί δίνει
συγκεκριμένες ιδιότητες μορφοποίησης στις παράγραφους του. Στο Ms Word XP μπορείτε εύκολα να
επιλέξετε τον επιθυμητό τύπο επικεφαλίδας από ένα μενού αναδίπλωσης. Υπάρχει και η δυνατότητα
να δημιουργήσετε δικό σας Στυλ.

ΚΆΝΟΝΤΑΣ ΣΚΈΨΕΙΣ ΓΙΑ ΤΗ ΔΙΆΤΑΞΗ ΚΑΙ ΤΟ ΧΡΏΜΑ (LAYOUT AND COLOR)

Προσπαθήστε να κάνετε το έργο του διαβάσματος  των αναγνωστών όσο πιο ευκολότερο γίνεται.
Αφιερώστε χρόνο και  σκέψη για το σχεδιασμό και τη διάταξη γιατί και το καλύτερο περιεχόμενο
κειμένου είναι άχρηστο αν το ακροατήριο δεν μπορεί να το διαβάσει. Σκεφτείτε τη διάταξη και τις
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επιλογές του  χρώματος έχοντας υπόψη ότι κάποιοι αναγνώστες μπορεί να έχουν χαμηλή όραση ή
δεν είναι σε θέση να διαχωρίσουν τα χρώματα  μεταξύ τους.

ΔΗΜΙΟΥΡΓΊΑ ΕΙΚΌΝΩΝ ΜΕ ΠΡΟΣΒΑΣΙΜΌΤΗΤΑ ( ACCESSIBLE IMAGES)

Κάθε εικόνα που προστίθεται σε σελίδα πρέπει να έχει εναλλακτικό κείμενο. Αν η εικόνα προσφέρει
σημαντικές πληροφορίες θα πρέπει να έχει εναλλακτικό κείμενο επεξήγησης.

ΔΗΜΙΟΥΡΓΊΑ ΠΙΝΆΚΩΝ ΜΕ ΠΡΟΣΒΑΣΙΜΌΤΗΤΑ (ACCESSIBLE TABLES)

Όταν σε μια σελίδα τοποθετούμε πίνακα δεδομένων θα πρέπει να περιγράψουμε τη δομή και το
περιεχόμενο του. Είναι σημαντικό να προσδιορίσουμε αν ο πίνακας έχει γραμμή επικεφαλίδων ή
στήλη επικεφαλίδων ή επικεφαλίδες γραμμών και στηλών ή δεν θα έχει καμία επικεφαλίδα. Η
περιγραφή του πίνακα τόσο των γραμμών , των στηλών και των επικεφαλίδων με κείμενο που
προηγείται  του πίνακα βοηθά τα άτομα  που χρησιμοποιούν τον αναγνώστη οθόνης.

ΕΝΣΩΜΑΤΏΣΗ ΒΟΗΘΉΜΑΤΩΝ ΠΛΟΉΓΗΣΗΣ  ΚΑΙ ΟΡΓΆΝΩΣΗΣ

Τα βοηθήματα οργάνωσης (organizational aids) κάνουν την μετακίνηση των χρηστών εντός του
εγγράφου ευκολότερη χωρίς να χρειαστεί να διαβαστεί όλο το έγγραφο.

ΕΛΕΓΧΟΣ ΜΕ ΤΕΧΝΟΛΟΓΙΚΆ ΒΟΗΘΉΜΑΤΑ

Ο έλεγχος του αρχείου από τα τεχνολογικά βοηθήματα σημαίνει τη δοκιμή του ανοίγματος από ένα
πρόγραμμα αναγνώστη οθόνης.  Βεβαιωθείτε ότι όλα τα στοιχεία του εγγράφου ή της παρουσίασης
είναι διακριτά από τον αναγνώστη οθόνης. Μπορείτε να κατεβάσετε τη δοκιμαστική έκδοση
λογισμικού  ανάγνωσης οθόνης JAWS από τη διεύθυνση :
http://www.freedomscientific.com/downloads/jaws/jaws-downloads.asp

5.3.2 Λίστα ελέγχου προσβασιμότητας στο Ms Word

Πίνακας 6  Κριτήρια Ελέγχου Προσβασιμότητας στο Ms Word
ΣΤΟΧΟΣ ΚΡΙΤΗΡΙΑ ΠΡΟΣΒΑΣΙΜΟΤΗΤΑΣ
1 Έχετε χρησιμοποιήσει τις καρτέλες των Στυλ για να συνδέσετε τα στοιχεία του με τις

ιδιότητες τους; (όπως  Επικεφαλίδα επιπέδου 1) ;
2 Χρησιμοποιείται στο έγγραφο μια τυποποιημένη γραμματοσειρά μεγέθους τουλάχιστον

10;
3 Είναι το κείμενο του εγγράφου κεντραρισμένο αριστερά εκτός από τον τίτλο;
4 Έχει μορφοποιήσει το έγγραφο σε μπλοκ (block style) (δηλ. να μην έχει εσοχές αλλά

κουκκίδες ή αρίθμηση (bulleted / numbered items) ;
5 Είναι οι ετικέτες των επικεφαλίδων διαφορετικές από την ετικέτα του κειμένου του

http://www.freedomscientific.com/downloads/jaws/jaws-downloads.asp
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σώματος (δηλαδή σε μέγεθος και τύπο) ;  Είναι το κείμενο της επικεφαλίδας σε ξεχωριστή
γραμμή από το κείμενο του σώματος ;

6  Έχει προσβασιμότητα το περιεχόμενο που έχει χρώματα από όλα τα μέσα;
7 Έχουν μορφοποιηθεί οι Στήλες χωρίς τη χρήση του πλήκτρου Tab ;
8 Το έγγραφο περιλαμβάνει βοηθήματα περιήγησης και οργάνωσης;
9 Οι πίνακες έχουν επικεφαλίδες; Περιγράφεται το περιεχόμενο του πίνακα με κείμενο ή με

λεζάντα ;
10 Είναι ενεργές όλες οι υπερσυνδέσεις  ;
11 Κάθε στοιχείο που δεν είναι κείμενο έχει ισοδύναμο εναλλακτικό κείμενο ; Αν δεν έχει θα

χρειαστεί να το προσθέσετε. Έχουν νόημα οι  περιγραφές που συνοδεύουν κάθε στοιχείο
που δεν κείμενο ;

12 Έχουν ομαδοποιηθεί οι μικρές  εικόνες σε μεγαλύτερες με εναλλακτικό κείμενο  ;
13 Υπάρχουν λεζάντες στους πίνακες και στις εικόνες ;
14 Υπάρχουν λεζάντες σε όλα τα βίντεο;
15 Προβλέπονται αντίγραφα αρχείων για όλα τα ηχητικά αρχεία ;
16 Υπάρχουν οι  διασυνδέσεις του πίνακα περιεχομένων με τις σελίδες του κειμένου ;

5.3.3 Λίστα ελέγχου προσβασιμότητας στο Ms Powerpoint

Πίνακας 7  Κριτήρια  Ελέγχου Προσβασιμότητας στο Ms Powerpoint
ΣΤΟΧΟΣ ΚΡΙΤΗΡΙΑ ΠΡΟΣΒΑΣΙΜΟΤΗΤΑΣ
1 Εμφανίζονται όλα τα μέρη του περιεχομένου με λογική σειρά , από πάνω προς τα

κάτω και από αριστερά προς τα δεξιά ;
2 Είναι  κατάλληλη η  αντίθεση των χρωμάτων φόντου και κειμένου ;
3 Έχει κάθε στοιχείο μη κειμένου ισοδύναμο εναλλακτικό κείμενο ή περιγραφή ;
4 Υπάρχουν λεζάντες σε όλα τα βίντεο ;
5 Προβλέπονται μεταγραφές (transcripts) σε όλα τα βίντεο ;
6 Μετακινούνται οι χρήστες εύκολα με τη βοήθεια των υπερσυνδέσεων στις

ιστοσελίδες ή στα  τμήματα της παρουσίασης μέσω του περιεχομένου ;
7 Έχει η παρουσίαση δομή με επικεφαλίδες για λόγους βελτίωσης της

προσβασιμότητας ;
8 Tο περιεχόμενο και η περιήγηση θα γίνουν κατανοητά από χρήστες που δεν έχουν

ικανότητα να εντοπίζουν συγκεκριμένα χρώματα ή διαφορές σ’ αυτά ;
9 Είναι οι επικεφαλίδες των γραμμών και των στηλών σύντομες και περιγραφικές ;

Εξηγούνται με κείμενο τα δεδομένα των πινάκων και των διαγραμμάτων;
10 Έχετε αποφύγει η παρουσίαση να έχει κινούμενα σχέδια ; Αν έχει,  χρησιμοποιείται

εναλλακτικό κείμενο γι’ αυτά ;
11 Οι εναλλαγές των διαφανειών γίνονται με συνεπή τρόπο ;
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Επιστροφή  Κάνοντας Έλεγχο προσβασιμότητας στα αρχεία Word και PowerPoint
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6 Οδηγός προσβασιμότητας των αρχείων μορφής PDF

6.1 Εισαγωγή
Ο οδηγός προσβασιμότητας των μεταφέρσιμων αρχείων μορφής PDF δίνει τα βήματα για την
δημιουργία και τη μορφοποίηση  των αρχείων PDF ώστε να είναι προσιτά στους χρήστες με
αναπηρίες. Τα αρχεία μορφής PDF με προσβασιμότητα υψηλής αντίθεσης διαβάζονται από
αναγνώστες οθόνης . Ακολουθούν οι κατευθύνσεις για τη δημιουργία αρχείων με προσβασιμότητα
χρησιμοποιώντας τα προγράμματα  Adobe Professional 6.0 και 7.0.
Ο οδηγός προσβασιμότητας για PDF αρχεία :

 Καλύπτει τη δημιουργία  αρχείου PDF με πρόσβαση καθώς και τη μετατροπή των
υπαρχόντων αρχείων PDF σε αρχεία PDF με πρόσβαση

 Εξηγεί πως  συνδέονται οι  εικόνες με τα αρχεία PDF και τους  περιορισμούς για το
ποια αρχεία μπορούν ή δεν μπορούν  να έχουν προσβασιμότητα

 Παρουσιάζει τη διαδικασία τροποποίησης ενός PDF για έχει προσβασιμότητα

 Γίνεται αναφορά στη δομή ,στις ετικέτες και στις οδηγίες του ελέγχου πρόσβασης
στο αρχείο PDF

 Συγκρίνει τις εκδόσεις 6.0 και 7.0 του Adobe Acrobat

Γίνεται αναφορά στις διαφορές των  εκδόσεων 6.0 και 7.0 του Acrobat Professional
Η εργασία αυτή εστιάζει στο να κάνει τα αρχεία PDF να έχουν πρόσβαση χρησιμοποιώντας την
πλατφόρμα των Windows και των εφαρμογών του Office της Microsoft. Συγκεκριμένα ο οδηγός που
αναφέρεται η εργασία αυτή είναι προσανατολισμένος για το Microsoft 2000 και τις νεότερες
εκδόσεις του.

6.1.1 Απαιτούμενο Λογισμικό

Για να κάνετε ένα PDF να έχει προσβασιμότητα πρέπει να έχετε τα κατάλληλα προγράμματα της
Adobe . Για να δείτε αν έχετε τα απαιτούμενα προγράμματα – εργαλεία ( plug-ins) επιλέξτε Βοήθεια
> Σχετικά με τα Plug-ins της  Adobe. Μια λίστα  από εργαλεία με τις περιγραφές και τις εξαρτήσεις
τους θα εμφανιστούν. Αν είσαστε σε θέση να εκτελέσετε τα βήματα του οδηγού αυτού βεβαιωθείτε
ότι έχετε το κατάλληλο plug-in. Αυτό είναι σημαντικό όταν κάνετε τη  προσαρμοσμένη εγκατάσταση
του Adobe Acrobat Professional.
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Πίνακας 8  Απαιτούμενο  λογισμικό εφαρμογών  και  χρήσεις
Εφαρμογή / Εργαλείο Ο λόγος που  χρησιμοποιείτε Που θα το βρεις
     Το Adobe Acrobat
Professional 6.0   or 7.0.

Μετατρέπει τα έγγραφα σε αρχεία
PDF

Από προμηθευτή. Δεν είναι δωρεάν
όπως το πρόγραμμα Adobe Reader

To Acrobat Accessibility
plug-in

Επιτρέπει τη χρήση βοηθητικών
τεχνολογιών (όπως αναγνώστη
οθόνης)  με το Adobe Acrobat.

Διατίθεται στη τυπική εγκατάσταση
του  Acrobat Professional 6.0/7.0.

Plug-in για Φόρμες
(Forms)

Δημιουργεί και χρησιμοποιεί PDF
φόρμες

Διατίθεται στη τυπική εγκατάσταση
του Acrobat Professional 6.0/7.0

Plug-in προσβασιμότητας Μετατρέπει τα υπάρχοντα αρχεία σε
 αρχεία PDF  με πρόσβαση

Διατίθεται στη τυπική εγκατάσταση
του Acrobat Professional 6.0/7.0

Plug-in σύλληψης Μετατρέπει τα σαρωμένα έγγραφα
και τα αρχεία εικόνας PDF σε
αρχεία PDF με προσβασιμότητα

Διατίθεται στη τυπική εγκατάσταση
του Acrobat Professional 6.0/7.0

Plug-in οπτικής
διάταξης(Reflow)

Κάνει οπτική διάταξη του
περιεχομένου της σελίδας για να
προσαρμοστεί σε παράθυρο

Διατίθεται στη τυπική εγκατάσταση
του Acrobat Professional 6.0/7.0

Plug-in Φτιαξίματος
(TouchUp)

Επεξεργάζεται τις πληροφορίες και
τις ετικέτες  του εγγράφου

Διατίθεται στη τυπική εγκατάσταση
του Acrobat Professional 6.0/7.0

Εφαρμογές  Microsoft
Office  Windows (Ms
Word, Excel, Ms
Powerpoint)

Δημιουργεί νέο αρχείο με ετικέτες
έτσι ώστε όταν γίνει PDF να έχει
προσβασιμότητα

Η αγορά μέσω προμηθευτή

* Αν δεν είστε σίγουρος για το ποια έκδοση του Acrobat έχετε , πηγαίνετε στη Βοήθεια.
Επιλέξτε την  επιλογή  «Σχετικά με το Acrobat»  για να δείτε την έκδοση του.

6.1.2 Χαρακτηριστικά των εκδόσεων  Adobe Professional  6.0 και  7.0

Πίνακας 9  Διαβάζοντας  αρχεία  PDF με τις  εκδόσεις  6.0 και 7.0
Χαρακτηριστικό Adobe Acrobat 6.0 Professional Adobe Acrobat 7.0

Professional
Διαβάζει μεγαλοφώνως  τα
αρχεία PDF χρησιμοποιώντας το

Ναι Ναι*
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στάνταρ  σύστημα μετατροπής
κειμένου σε ομιλία
Αξιολογεί γρήγορα τη
δυνατότητα πρόσβασης σε PDF
αρχείο

Ναι Ναι*

Προσαρμόζει το μέγεθος της
γραμματοσειράς στο πλαίσιο
(panel)  του σελιδοδείκτη

Ναι Ναι

Επιλέγει εναλλακτική σειρά
διαβάσματος

Ναι Ναι

Χρησιμοποιεί τα πλήκτρα
πλοήγησης

Ναι Ναι *

Χρησιμοποιεί προηγμένες
λειτουργίες ανάγνωσης
βασιζόμενη σε προγράμματα
ανάγνωσης των Windows

Ναι Ναι

Προβάλλει τα έγγραφα  υψηλής
αντίθεσης

Ναι Ναι

Μεγεθύνει το κείμενο κάνοντας
οπτική διάταξη του περιεχομένου
του  έτσι ώστε  ταιριάζει σε κάθε
μέγεθος παραθύρου προβολής

Ναι Ναι *

Αποθηκεύει τα περιεχόμενα του
εγγράφου  PDF σε κείμενο
μορφής .txt

Ναι Ναι

Κάνει προσαρμογή των
προτιμήσεων προσβασιμότητας
εύκολα με  το εργαλείο
Accessibility Wizard

Όχι Ναι

Έχει την δυνατότητα της άμεσης
ανατροφοδότησης και  βοήθειας
κατά τη πρόσβαση σε αρχεία
PDF χωρίς ετικέτες  από την
τεχνολογία υποστήριξης

Όχι Ναι

Έχει τη δυνατότητα να ορίσεις
στις προτιμήσεις του δρομέα να
εμφανίζεται στην αρχή κάθε
σελίδας

Όχι Ναι
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Έχει αυτόματο άνοιγμα των
αρχείων PDF στη σελίδα που
διαβάστηκε  τελευταία

Όχι Ναι

* Έχει βελτιωθεί  από την προηγούμενη έκδοση
Πίνακας 10  Δημιουργώντας αρχεία  PDF  με προσβασιμότητα με τις εκδόσεις 6.0 και 7.0 

Χαρακτηριστικό Adobe Acrobat 6.0 Professional
Adobe Acrobat 7.0
Professional

Μειώνει το μέγεθος του αρχείου
PDF  με ετικέτες για ταχύτερη
λήψη

Ναι Ναι

Μετατρέπει τα υπάρχοντα PDF
έγγραφα σε έγγραφα PDF με
ετικέτες

Ναι Ναι

Δημιουργεί αρχεία PDF της
Adobe με ετικέτες
χρησιμοποιώντας τις εφαρμογές
του Office της Microssoft

Ναι Ναι

Προσθέτει ασφάλεια ενώ
διατηρεί τη προσβασιμότητα

Ναι Ναι

Προσθέτει κείμενο στις
σαρωμένες σελίδες για καλύτερη
προσβασιμότητα

Ναι Ναι

Εξάγει το κείμενο Adobe PDF σε
κείμενο μορφών .txt, Rich Text
Format( .rtf), XML, HTML και Ms
Word (.doc)

Ναι Ναι

Πίνακας 11  Βελτιστοποιώντας τη προσβασιμότητα στα αρχεία PDF με τις  εκδόσεις 6.0 και 7.0
Χαρακτηριστικό Adobe Acrobat 6.0 Professional Adobe Acrobat 7.0

Professional
Προκαλεί την ανασκόπηση και τη
 τροποποίηση της οπτικής σειράς
διάταξης του περιεχομένου των
αντικειμένων της σελίδας

Ναι Ναι *

Ελέγχει (Check and touch up) Ναι Ναι *
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την προσβασιμότητα των
εγγράφων
Δημιουργεί και βελτιστοποιεί την
πρόσβαση  στις φόρμες  του
έγγραφου Adobe PDF

Ναι Ναι

Έχει τη δυνατότητα το κείμενο
να διαβάζεται φωνακτά για να
προσομοιώνεται με τον
αναγνώστη οθόνης

Όχι Ναι

* Έχει βελτιωθεί  από την προηγούμενη έκδοση

6.1.3 Κατανοώντας  τις  Ετικέτες

Τα αρχεία  PDF έχουν περιεχόμενο και  δομή. Ως δομή ορίζουμε τη λογική που υπάρχει στο τρόπο
σύνδεσης του περιεχομένου του εγγράφου όπως στη σωστή σειρά ανάγνωσης, τη ερμηνεία των
σημαντικών στοιχείων  δηλ.  των λιστών, των γραφικών και των πινάκων. 
Η δομή στα αρχεία PDF εκφράζεται με ετικέτες. Ένα αρχείο PDF με καλά τοποθετημένες  ετικέτες
(well-formed) έχει μια  σειρά οπτικής διάταξης για να χωρέσει σε  σελίδες διαφορετικού πλάτους ή σε
διαφορετικά πλάτη οθόνων όπως και για να εμφανίζεται με ωραίο τρόπο στις συσκευές χειρός. Η
δημιουργία αρχείων PDF με ετικέτες είναι αναγκαία για υπάρχει προσβασιμότητα στα έγγραφα PDF .
Ένα αρχείο PDF με ετικέτες  :

 Εξασφαλίζει ότι οι πληροφορίες έχουν μπει στη σωστή σειρά ανάγνωσης στις σελίδες
του εγγράφου

  Έχει παραγράφους με ιδιότητες που μπορούν να «βάλουν» το κείμενο σε μια σειρά
οπτικής διάταξης  αν χρησιμοποιηθούν γραμματοσειρές μεγαλύτερου μεγέθους

 Κάνει  τις εικόνες και τους πίνακες  να  είναι περιγράψιμοι στο χρήστη 

 Εξασφαλίζει την αξιόπιστη μετάφραση του κειμένου  με όλους τους τυποποιημένους
χαρακτήρες Unicode ανεξάρτητα γραμματοσειράς

 Επιτρέπει να εξαχθεί το έγγραφο σε μορφή εμπλουτισμένου κειμένου (RTF) για να
επαναχρησιμοποιηθεί και σε άλλα έγγραφα

Μπορείτε να δημιουργήσετε αρχείο PDF  με ετικέτες ή μια φόρμα καθώς δημιουργείτε το έγγραφο ή
όταν γίνεται η μετατροπή ενός αρχείου  σε PDF. Για το πώς θα κάνετε  εξαρτάται  από τον τρόπο
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δημιουργίας του  και τα εργαλεία που χρησιμοποιείτε. Το καλύτερο είναι να δημιουργηθούν ετικέτες
στο έγγραφο κατά την σύνταξη του και όχι όταν αυτό είναι μορφής PDF. Το Acrobat Professional
(6.0 / 7.0) περιλαμβάνει την έκδοση του Adobe Maker που δημιουργεί αρχεία PDF της Adobe με
ετικέτες απευθείας από τις εφαρμογές του Microsoft Office.
Αν το αρχείο PDF δεν έχει ετικέτες θα χρειαστείτε τα κατάλληλα εργαλείο (plug-in). Το Make
Accessible plug-in κάνει τη μετατροπή των αρχείων PDF χωρίς ετικέτες σε αρχεία ετικετών PDF με
πρόσβαση. Είναι χρήσιμο για αυτούς που χρησιμοποιούν παλαιά αρχεία PDF ή για αυτούς που δεν
έχουν δημιουργήσει τα αρχεία τους με το Microsoft Office 2000 και τις νεότερες  εκδόσεις του.
Επιστροφή Οδηγός Προσβασιμότητας των Μεταφέρσιμων αρχείων PDF

6.1.4 Δημιουργία  νέου αρχείου PDF με πρόσβαση

Ο καλύτερος και ο πιο συνηθισμένος τρόπος για να δημιουργήσετε ένα αρχείο PDF  με δυνατότητες
πρόσβασης  είναι να κάνετε χρήση των εφαρμογών του Office της Microsoft. Όταν εγκαθιστάτε την
εφαρμογή το Acrobat Professional ο  PDFMaker εγκαθίσταται αυτόματα στις εφαρμογές του  Office
της Microsoft ώστε να κάνετε τη μετατροπή  των  εγγράφων σας . Ο PDF Maker μετατρέπει τα
αρχεία σε μορφή PDF με δυνατότητες πρόσβασης.
Πρώτα εγκαθιστάμε την εφαρμογή που παράγει αρχεία με δυνατότητες πρόσβασης. Στη συνέχεια
δημιουργείτε το πραγματικό έγγραφο (actual document) και το μετατρέπεται σε αρχείο PDF με
δυνατότητες πρόσβασης. Στο τέλος κάνετε τις απαραίτητες διορθώσεις.
Ακολουθήστε τις παρακάτω οδηγίες  :

 Πριν ξεκινήσετε , κάντε τις απαραίτητες ρυθμίσεις στα στυλ των επικεφαλίδων, των
τίτλων και του κειμένου στο έγγραφο που έχετε δημιουργήσει με το Microsoft Office.
Με τις ρυθμίσεις αυτές μπορείτε να έχει το έγγραφο σας το ακριβές ύφος κειμένου
πριν ξεκινήσετε να το γράφετε και  χωρίς να χρειαστεί κάθε τμήμα του τροποποίηση.
Αυτές οι ρυθμίσεις των στυλ του δίνουν τη δομή  που χρειάζεται για να γίνει PDF με
ετικέτες. Επίσης πριν ξεκινήσετε, καθορίστε τη συνολική μορφή και τα διαστήματα
του εγγράφου. Οι ρυθμίσεις εξαρτώνται από την εφαρμογή που χρησιμοποιείται

 Ενώ γράφεται το κείμενο να είστε σίγουροι για το σωστό ύφος – στυλ και μορφή
κειμένου.

 Αντί να χρησιμοποιείται το πλήκτρο Enter για εισαγωγή κενών διαστημάτων  μεταξύ
των παραγράφων , πηγαίνετε στο Μορφή > Παράγραφος  > Εσοχές και Καρτέλα
Διαστήματα ( Format > Paragraph>Indents > Spacing Tab) . Επιλέξτε το μέγεθος
της απόστασης που θέλετε πριν η μετά τις παραγράφους

 Προσθέστε εναλλακτικό κείμενο  ή περιγραφή σε όλες τις εικόνες. Με το κείμενο
αυτό μπορούν οι αναγνώστες οθόνης να τις περιγράψουν

 Ομαδοποιήστε τις μικρές εικόνες σε μεγαλύτερες. Η  ομαδοποιημένη εικόνα κάνει τις
εικόνες να μένουν μαζί ακόμα και όταν γίνεται αλλαγή σελίδας. Αυτό συμβαίνει στην
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οπτική διάταξη της σειράς ανάγνωσης  όταν έχουμε αλλαγή γραμματοσειράς  σε
μεγαλύτερο  μέγεθος. Εναλλακτικό κείμενο θα πρέπει να προστεθεί για να
περιγράψει ολόκληρη την ομαδοποιημένη εικόνα.

 Να συμπεριλάβετε  βοηθήματα περιήγησης και οργάνωσης (navigational and
organizational aids). Να χρησιμοποιείτε υπερσυνδέσεις, διαδραστικές  σελίδες,
πίνακες περιεχομένων και επικεφαλίδες. Αυτά δίνουν τη δυνατότητα της
μετακίνησης μέσα στο έγγραφο κατευθείαν στο τμήμα που ενδιαφέρει χωρίς να
χρειαστεί να διαβαστεί  ολόκληρο το κείμενο σελίδα-σελίδα μέχρι να το σημείο που
θέλετε

 Καθορίστε τη γλώσσα του εγγράφου για τις μελλοντικές τεχνολογίες ανάγνωσης
οθόνης. Ίσως να έχετε τη δυνατότητα να αλλάξετε τη γλώσσα που μιλάτε εν ώρα
εκτέλεσης (ον the fly) 

Τώρα είστε έτοιμοι να δημιουργήσετε  ένα αρχείο PDF  με δυνατότητες πρόσβασης με κάποια από τις
εφαρμογές του Microsoft Office.
  Ανοίξτε το έγγραφο που επιθυμείτε να μετατρέψετε σε PDF με τη κατάλληλη εφαρμογή του

Microsoft Office

 Στη γραμμή του μενού επιλέξτε Adobe PDF >> Αλλαγή ρυθμίσεων μετατροπής  (Adobe PDF>>
Change Conversion Settings)

 Κάντε κλικ στη καρτέλα Ρυθμίσεις (Settings tab) και κάνετε τα ακόλουθα :

 Επιβεβαιώστε τη μετατροπή πληροφοριών (Convert document information box)

  Επιβεβαιώστε  τη προσθήκη συνδέσμων (add links to adobe box)

 Επιβεβαιώστε τη προσθήκη σελιδοδεικτών(add bookmarks to adobe PDF box)

 Επιβεβαιώστε τη  δυνατότητα πρόσβασης και οπτικής διάταξης περιεχομένου

 Εάν γράφετε  αρχείο  σε Ms Word κάντε κλικ στη καρτέλα Ms Word  (δεν διατίθεται για Excel
και Ms Powerpoint)  και με βάση την έκδοση ακολουθείστε τις οδηγίες :

ΈΚΔΟΣΗ 6.0

 Επιβεβαιώστε τη Μετατροπή των σχόλιων στο πλαίσιο σημειώσεων (Convert
comments to notes box)

 Επιβεβαιώστε τη Μετατροπή σύνδεσης πλαισίων κειμένου στο πλαίσιο θέματος
(Convert linked text boxes to article thread box)
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 Επιβεβαιώστε τη Μετατροπή των παραπομπών και του πίνακα περιεχομένων στο
πλαίσιο  συνδέσεων (Convert cross-reference and table of contents to links box)

 Επιβεβαιώστε τη Μετατροπή των σημειώσεων και υποσημειώσεων στο πλαίσιο
συνδέσεων (Convert footnote and endnote links box)

ΈΚΔΟΣΗ 7.0

 Επιβεβαιώστε τη Μετατροπή να εμφανίζονται τα σχόλια στις σημειώσεις στο πλαίσιο
PDF(Convert displayed comments to notes in PDF box)

 Επιβεβαιώστε τη Μετατροπή των παραπομπών και του πίνακα περιεχομένων στο
πλαίσιο  συνδέσεων (Convert cross-reference and table of contents to links box)

 Επιβεβαιώστε τη Μετατροπή των σημειώσεων και υποσημειώσεων στο πλαίσιο των
συνδέσεων (Convert footnote and endnote links)

 Στο παράθυρο διαλόγου , κάντε κλικ στην καρτέλα Σελιδοδείκτες και κάντε τα εξής :

 Επιβεβαιώστε τη μετατροπή επικεφαλίδων στο πλαίσιο  σελιδοδείκτες

 Από τη λίστα επιλέξτε οποιοδήποτε από τα  πρόσθετα στυλ MS Word για να
δημιουργήσετε σελιδοδείκτες στο αρχείο PDF

 Κάντε κλικ στο ΟΚ

 Από τη βασική μπάρα της εφαρμογής Microsoft Office Επιλέξτε Adobe PDF > Μετατροπή σε
Adobe PDF (Adobe PDF > Convert to Adobe PDF)

 Ονομάστε το αρχείο και κάντε την αποθήκευση του.

Το νέο έγγραφο είναι ένα αρχείο με ετικέτες σε μορφή PDF.
Στη συνέχεια μπορείτε να χρησιμοποιήσετε τον Accessibility Checker του Acrobat για να ελέγξετε τη
δομή και τις ετικέτες του. Χρησιμοποιήστε την παλέτα ετικετών για να κάνετε τις απαραίτητες
επιδιορθώσεις.
Για να επαληθεύσετε  αρχεία  ή να  τροποποιήσετε  ένα PDF είναι απαραίτητο :
 Να ανοίξετε το Acrobat Professional

 Να ανοίξετε το νέο αρχείο PDF που δημιουργήθηκε  

 Να εκτελέσετε τον Πλήρη Έλεγχο Προσβασιμότητας (Accessibility Full Check)

 Πληροφορίες θα εμφανιστούν σχετικά με τη προσβασιμότητα
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 Αν υπάρχουν προβλήματα , χρησιμοποιήστε τη Έκθεση (Accessibility Report) ως αναφορά για
να διορθώσετε τα προβλήματα. Για προχωρημένους > Προσβασιμότητα > Ανοικτή Αναφορά
Πρόσβασης ( Advanced > Accessibility > Open Accessibility Report)

 Χρησιμοποιήστε τη παλέτα ετικετών για να προβείτε σε αναγκαίες διορθώσεις. 

    Επιλέξτε Αρχείο > Αποθήκευση ως (Select File > Save As). Να κάνετε Αποθήκευση ως αντί
Αποθήκευση επειδή οι  αλλαγές έγιναν στη εσωτερική δομή του εγγράφου και δεν μπορούν 
να αντιστραφούν 

 Δώστε όνομα και κάντε αποθήκευση

 Εκτελέστε για ακόμη μια φορά τον Πλήρη Έλεγχο Προσβασιμότητας (Accessibility Full Check)

 Κάντε τυχόν πρόσθετες αλλαγές με βάση τα αποτελέσματα της νέας έκθεσης πρόσβασης

 Ελέγξτε  το αρχείο με ένα πρόγραμμα ανάγνωσης οθόνης. Αν χρησιμοποιείτε την έκδοση 7.0,
μπορείτε να χρησιμοποιήσετε τη δυνατότητα του Διαβάσματος Φωνακτά (Read Out Loud)

Επιστροφή Δημιουργία νέου αρχείου PDF με πρόσβαση

6.2  Μετατρέποντας υπάρχοντα αρχεία σε  αρχεία μορφής PDF με
προσβασιμότητα

Τα υπάρχοντα αρχεία  μπορούν να έχουν δυνατότητες προσβασιμότητας αν αποκτήσουν ετικέτες και
εφόσον μετατραπούν  σε PDF αρχεία. Τα είδη αρχείων που ακολουθούν μπορούν να έχουν
προσβασιμότητα : PDF που δεν έχουν μορφή εικόνας, σαρωμένα έγγραφα , αρχεία  PDF μορφής
εικόνας  και τα PDF με φόρμες.
Αν και όλα τα αρχεία PDF  θεωρούνται μορφής εικόνας , κάποια αρχεία όμως είναι μόνο PDF
μορφής εικόνας. Αυτό σημαίνει ότι όλο το έγγραφο είναι μια εικόνα όπως και το κείμενο που
περιέχεται στην εικόνα και ως εκ τούτου γίνεται ανιχνεύσιμο από τους αναγνώστες οθόνης. Συνήθως
τα σαρωμένα έγγραφα είναι αρχεία PDF εικόνας. Ο Ελεγκτής της Πρόσβασης (Accessibility Checker)
σας ενημερώνει αν ένα αρχείο PDF είναι μόνο εικόνα.

6.2.1 Αρχεία PDF που δεν έχουν μορφή  εικόνας

Αρκετά αρχεία PDF δεν έχουν δυνατότητες πρόσβασης. Μπορείτε να τα μετατρέψετε σε αρχεία PDF
με δυνατότητες πρόσβασης ακολουθώντας τις παρακάτω οδηγίες εφόσον δεν είναι αρχεία PDF
εικόνας (not a PDF Image Only file).
Τα περισσότερα  σαρωμένα PDF έγγραφα είναι αρχεία PDF εικόνας. Αν ο Ελεγκτής της Πρόσβασης
(Accessibility Checker) δεν είναι σε θέση να εντοπίσει  κείμενο  σε αρχείο PDF  , αν και υπάρχει , τότε
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πιθανόν  το αρχείο να είναι PDF εικόνας. Εμείς θα ασχοληθούμε στην παρακάτω ενότητα με αρχεία
PDF που δεν είναι εικόνες. Στις πιο κάτω ενότητες θα ασχοληθούμε και με αρχεία PDF εικόνας.

ΔΊΝΟΝΤΑΣ  ΣΕ  ΑΡΧΕΊΟ PDF  ΔΥΝΑΤΌΤΗΤΕΣ ΠΡΟΣΒΑΣΙΜΌΤΗΤΑΣ

 Ανοίξτε το αρχείο PDF με το Acrobat

 Επιλέξτε Για προχωρημένους > Πρόσβαση > Προσθήκη Ετικετών (Advanced >
Accessibility > Add Tags to Document). Αν λάβετε το μήνυμα λάθους ότι το έγγραφο
σας έχει  ήδη ετικέτες κάντε κλικ στο ΟΚ και συνεχίστε με το επόμενο βήμα

 Εκτελέστε το πρόγραμμα Πλήρης Έλεγχος Προσβασιμότητας

 Εμφανίζονται πληροφορίες σχετικά με την Προσβασιμότητα του εγγράφου

 Αν αντιμετωπίσετε προβλήματα χρησιμοποιήστε την έκθεση προσβασιμότητας
(Accessibility Report) για να διορθώσετε τα λάθη. Αν έχετε κλείσει την έκθεση
προσβασιμότητας  μπορείτε να επιλέξετε  Για προχωρημένους > Προσβασιμότητα >
Έκθεση Προσβασιμότητας για να την ανοίξετε. Αξίζει να σημειωθεί ότι αν με τον
έλεγχο δεν βρεθεί  γραμματοσειρά τότε πιθανότατα το έγγραφο να είναι αρχείο PDF
εικόνας. Κλείστε το έγγραφο χωρίς αποθήκευση.

 Με τη παλέτα Ετικέτες κάνετε τις διορθώσεις.

 Επιλέξτε  Αρχείο > Αποθήκευση ως

 Γράψετε το όνομα του αρχείου και κάντε αποθήκευση. Συνίσταται ιδιαίτερα η χρήση
Αποθήκευση ως αντί Αποθήκευση γιατί οι αλλαγές στην εσωτερική δομή του
εγγράφου δεν μπορούν να αντιστραφούν

 Εκτελέστε για άλλη μια φορά τον Έλεγχο Προσβασιμότητας (Accessibility Full Check)

  Κάντε τυχόν πρόσθετες αλλαγές με βάση τα αποτελέσματα της έκθεσης του
Ελέγχου Πρόσβασης

 Ελέγξτε το αρχείο με ένα πρόγραμμα ανάγνωσης οθόνης. Αν χρησιμοποιείτε την
έκδοση 7.0 θα μπορέσετε να το διαβάσετε φωνακτά.

6.2.2 Σαρωμένα έγγραφα και αρχεία PDF με μορφή εικόνας

Μπορείτε να δημιουργήσετε αρχεία PDF με πρόσβαση αν το αρχικό σας έγγραφο είναι έγγραφο σε
χαρτί ή σαρωμένη εικόνα ή ένα αρχείο PDF με μορφή εικόνας. Με το Acrobat  και με ένα σαρωτή
δημιουργείτε ένα αρχείο PDF εικόνας. Το αρχείο που προκύπτει προβάλλεται από το Acrobat αλλά το
κείμενο του είναι μέρος της εικόνας και δεν γίνεται αντιληπτό από συσκευές αναγνώρισης
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χαρακτήρων  και λέξεων. Ως εκ τούτου ένα  πρόγραμμα ανάγνωσης οθόνης δεν μπορεί να διαβάσει
το κείμενο αυτό.
Θα πρέπει να κάνετε «σύλληψη» των σελίδων του αρχείου (must capture the pages) για να έχουν οι
αναγνώστες οθόνης πρόσβαση στο αρχείο PDF εικόνας . Υπάρχουν δυο σενάρια, είτε έχετε το
έγγραφο σας στο  χαρτί και πρέπει να αποκτήσει  προσβασιμότητα μορφής αρχείου PDF είτε έχετε
αρχείο PDF εικόνας που πρέπει και αυτό  να αποκτήσει  προσβασιμότητα.
Για  σάρωση  μεγάλης ποσότητας χρησιμοποιήστε  το λογισμικό Acrobat Capture 3 που μπορείτε να
το αγοράσετε ξεχωριστά. Το Capture 3 With Agent Pack μπορεί να κάνει σύλληψη  και μετατροπή
μεγάλων όγκων εγγράφων σε χαρτί.
Αν έχετε σαρωμένο έγγραφο ή μια εικόνα PDF μπορείτε  με μια εφαρμογή σύλληψης να
δημιουργήσετε αρχεία PDF με ετικέτες. Αυτά μπορούν να διορθωθούν , να αντιγραφούν και να τους
γίνει αναζήτηση.  Ακολουθήστε τα παρακάτω βήματα για  κάνετε τις σαρωμένες εικόνες  και τα
αρχεία εικόνας PDF  να έχουν πρόσβαση.

ΤΡΌΠΟΙ ΣΆΡΩΣΗΣ ΕΓΓΡΆΦΟΥ

  Για την έκδοση 6.0

 Στο Acrobat,  Επιλέξτε αρχείο > Δημιουργία PDF > Από σαρωτή (File > Create PDF >
From Scanner)

 Επιλέξτε συσκευή σάρωσης

 Επιλέξτε μορφή (μίας όψης , διπλής όψης)

 Επιλέξτε προορισμό  (σε ένα νέο  η σε ένα  τρέχον έγγραφο)

 Επιλέξτε κάποιες επιλογές αν επιθυμείτε

 Επιλέξτε Σάρωση (Scan)

 Κάντε  τη  μετατροπή σε  αρχείο  σαρωμένης Εικόνας  

  Για την έκδοση 7.0

 Στο Acrobat , Επιλέξτε αρχείο > Δημιουργία PDF > Από σαρωτή (File > Create PDF >
From Scanner)

 Επιλέξτε την επιλογή Αναγνώριση κειμένου με  OCR (Recognize text using ocr
checkbox)

 Κάντε κλικ στις ρυθμίσεις για να προσαρμόσετε τη διαδικασία σάρωσης
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 Επιλέξτε τη προσθήκη ετικετών στο έγγραφο (Add Tags to Document) για το δώσετε
προσβασιμότητα. Το εργαλείο Φτιαξίματος Σειράς Ανάγνωσης  (Touch reading
order) θα σας βοηθήσει να διορθώσετε τα τυχόν προβλήματα.

 Επιλέξτε  συσκευή σάρωσης  από το μενού Δημιουργία PDF με  σαρωτή

 Επιλέξτε  μορφή σάρωσης (μονής πλευράς ή διπλής πλευράς)

 Επιλέξτε το προορισμό επισύναψης (στο παρόν έγγραφο ή σε ένα νέο έγγραφο)

ΚΆΝΟΝΤΑΣ ΜΕΤΑΤΡΟΠΈΣ  ΣΕ  ΣΑΡΩΜΈΝΗ ΕΙΚΌΝΑ

 ΓΙΑ ΤΗΝ ΕΚΔΟΣΗ 6.0

 Ανοίξτε το αρχείο που θα θέλατε να γίνει η σύλληψη

 Επιλέξτε  Έγγραφο > Σύλληψη > Έναρξη Σύλληψης  (Document  Capture > Start Capture)

 Επιλέξτε τις σελίδες που θα θέλατε να κάνετε σύλληψη   

 Επιλέξτε την Επεξεργασία  (Edit) στις Ρυθμίσεις  (Settings) και   :

 Επανεξετάστε τη γλώσσα του  OCR (Primary OCR Language)

 Επανεξετάστε το Στυλ εξόδου του PDF. Έχετε τις ακόλουθες δυνατότητες 1)
Αναζήτηση εικόνας (Exact) , 2) Αναζήτηση εικόνας (Compact) – Αναζήτηση εικόνας
που διατηρεί την αρχική εικόνα στο προσκήνιο (Foreground)   και κάνει αναζήτηση
κειμένου στο παρασκήνιο (Background), 3)  Μορφοποίηση κειμένου και γραφικών –
Ανασυνθέτει την αρχική εικόνα χρησιμοποιώντας την Αναγνώριση Κειμένου,
Γραμματοσειράς και γραφικών.

 Επιλέξτε πως θα γίνει η λειτουργία συμπίεσης της εικόνας που διαγράφει
εικονοστοιχεία για να μειώσει το μέγεθος του αρχείου.

 Κάντε κλικ στο ΟΚ  για να τελειώσει η σύλληψη (Paper Capture Settings Window)

 Κάντε κλικ στο ΟΚ  για να ξεκινήσει η μετατροπή

 Αν λάβετε μήνυμα λάθους τότε πιθανόν να φταίει η ποιότητα του σαρωμένου εγγράφου που
δεν είναι αρκετά υψηλή. Για να το αντιμετωπίσετε σαρώστε πάλι την εικόνα κάνοντας χρήση
μεγαλύτερης ανάλυσης

 Αν επιλέξετε την επιλογή μορφοποιημένο κείμενο και γραφικά για το στυλ εξόδου του
εγγράφου PDF θα πρέπει να επανεξετάσετε τις ύποπτες λέξεις.
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 Επιλέξτε  Έγγραφο > Σύλληψη Εγγράφου > Βρείτε όλες τις ύποπτες OCR (Document
> Paper Capture > Find All OCR Suspects )

 Kάντε κλικ  σε κάποια ύποπτη λέξη

 Επιλέξτε Αποδοχή και Εύρεση  για να προσχωρήσετε ή να διορθώσετε τη λέξη

 Όταν η  επανεξέταση ολοκληρωθεί τότε επιλέξτε κλείσιμο.

 Εκτελέστε τον Πλήρη Έλεγχο Προσβασιμότητας

 Κάντε τυχόν πρόσθετες αλλαγές με βάση τα αποτελέσματα της έκθεσης του Ελέγχου
Πρόσβασης

 Ελέγξετε το αρχείο με ένα πρόγραμμα ανάγνωσης οθόνης

 ΓΙΑ ΤΗΝ ΕΚΔΟΣΗ 7.0

 Ανοίξτε το έγγραφο που έχει τη σαρωμένη εικόνα

 Επιλέξτε Έγγραφο > Αναγνώριση κειμένου από OCR > Έναρξη (Document> Recognize Text
using OCR > Start)

 Καθορίστε τις σελίδες που θα μετατραπούν

 Στις Ρυθμίσεις (Settings)  κάντε κλικ στην  Επεξεργασία (Edit) και  :

 Επανεξέτασε  τη γλώσσα του  OCR

 Επανεξετάστε το Στυλ εξόδου του PDF. Έχετε τις ακόλουθες δυνατότητες 1)
Αναζήτηση εικόνας (Exact) , 2) Αναζήτηση εικόνας (Compact) – Αναζήτηση εικόνας
που διατηρεί την αρχική εικόνα στο προσκήνιο (Foreground)   και κάνει αναζήτηση
κειμένου στο παρασκήνιο (Background), 3)  Μορφοποίηση κειμένου και γραφικών –
Ανασυνθέτει την αρχική εικόνα χρησιμοποιώντας την Αναγνώριση Κειμένου,
Γραμματοσειράς και γραφικών

 Επιλέξτε πως θα γίνει η λειτουργία συμπίεσης της εικόνας που διαγράφει
εικονοστοιχεία για να μειώσει το μέγεθος του αρχείου (Downsampling)

 Κάντε κλικ στο ΟΚ 

 Αν δεν σας ζητηθεί να γίνει αυτόματα η επίλυση των ύποπτων λέξεων τότε επιλέξτε Έγγραφο >
Αναγνώριση όλων των ύποπτων OCR  > Αναζήτηση όλων των ύποπτων OCR. ( Documents>
Recognize Text Using  OCR > Find All  OCR Suspects)
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 Βρείτε λύση για όλες τις άγνωστες ή μη αναγνωρίσιμες λέξεις

 Εκτελέστε τον Πλήρη Έλεγχο Προσβασιμότητας (Accessibility  Full Check)

 Επιλύστε τυχόν προβλήματα χρησιμοποιώντας την Έκθεση Προσβασιμότητας (Accessibility
Report). Επαναλάβατε τα προηγούμενα δύο βήματα για να επιλύσετε τυχόν προβλήματα

 Όταν τελειώσετε ελέγξτε το αρχείο σας με ένα πρόγραμμα Ανάγνωσης Οθόνης

6.2.3 Φόρμες Adobe PDF

Κάθε πεδίο του PDF θα πρέπει να διαβάζεται με τη σωστή σειρά και να περιλαμβάνει όλες τις
πληροφορίες σχετικά με το πεδίο εισαγωγής (input field) ώστε οι αναγνώστες οθόνης να
παρουσιάζουν αυτές τις  πληροφορίες στους χρήστες.
Αν  το αρχείο PDF περιέχει ετικέτες ή ηλεκτρονικά πεδία φόρμας (electronic form fields) τότε
παραλείψτε τα βήματα που προσθέτουν Συμβουλές Ιδιοτήτων Εργαλείου (Tooltips) στο έγγραφο .Θα
πρέπει να συλλαμβάνεται  η φόρμα του PDF  αν έχει σαρωθεί,  (need to capture) ακολουθώντας τις
διαδικασίες που αφορούν τα σαρωμένα έγγραφα.
Εκτός από το πρόγραμμα  Adobe  Professional (6.0 / 7.0)  υπάρχουν και δυο ακόμη προϊόντα για τη
δημιουργία αρχείων με προσβασιμότητα μορφής PDF. Το Acrobat Capture Agent Pack για έντυπα
Adobe PDF και το Adobe Designer που σχεδιάζει φόρμες. Εμείς θα ασχοληθούμε μόνο με το
πρόγραμμα Adobe Acrobat Professional.
Σημείωση : Επειδή πολλές φόρμες έχουν σύνθετη γραφική παρουσίαση εξόδου (graphically  complex
layout) αφιερώστε κάποιο χρόνο για τη δομή και τα πεδία. Ελέγξετε τη Σειρά Ανάγνωσης με ένα
πρόγραμμα ανάγνωσης οθόνης.
Τα αρχεία φορμών PDF με δυνατότητες πρόσβασης   δημιουργήθηκαν με την προϋπόθεση ότι τα
πεδία φόρμας έχουν ετικέτες , σωστή σειρά ανάγνωσης και έχουν  πληροφορίες περιγραφής μέσω
της Συμβουλής Ιδιότητας Εργαλείου (Tooltip).

ΠΩΣ ΔΗΜΙΟΥΡΓΏ ΦΌΡΜΕΣ PDF ΜΕ ΕΤΙΚΈΤΕΣ

 Ανοίξτε την PDF φόρμα με το πρόγραμμα Acrobat Professional

 Επιλέξτε  Για  Προχωρημένους > Προσβασιμότητα > Προσθήκη ετικετών στο
έγγραφο ( Advanced > Accessibility >  Add Tags to Document)
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ΠΡΟΣΘΈΤΟΝΤΑΣ ΠΕΔΊΑ ΣΤΗ ΦΌΡΜΑ

 Επιλέξτε Προβολή > Ετικέτες  Πλοήγησης > Ετικέτες για το άνοιγμα της καρτέλας
Ετικετών   (View > Navigation Tabs > Tags to open the Tags tab)

 Επιλέξτε Επισήμανση Περιεχομένου (Highlight Content) από  το μενού Επιλογές
(Options)  και την καρτέλα Ετικέτες (Tags Tab)

 Επιλέξτε Σχολιασμός Ετικέτας (Tag Annotation) από το μενού Επιλογές (Options
menu)

 Επιλέξτε το στοιχείο από το  δένδρο των  ετικετών  πριν  δημιουργήσετε το πεδίο.
Με τη προσθήκη του πεδίου, στο δένδρο των ετικετών το πεδίο φόρμας θα μπει στη
θέση  του αυτόματα .

 Επιλέξτε Εργαλεία > Προχωρημένη επεξεργασία > Φόρμες > Εμφάνιση εργαλείων
φόρμας (Tools> Advanced Editing > Forms > Show Forms Toolbar)

 Επιλέξτε το τύπο πεδίου  από τη γραμμή των εργαλείων

 Δημιουργήστε πεδίο με το δείκτη του σταυρού (cross-hair pointer) στο μέγεθος και
στη θέση της φόρμας που επιθυμείτε. Όταν ελευθερώσετε το κουμπί του ποντικιού
θα εμφανιστεί ένα πλαίσιο διαλόγου με τις  ιδιότητες του πεδίου

ΠΡΟΣΘΈΤΟΝΤΑΣ  ΕΙΚΟΝΊΔΙΑ ΕΡΓΑΛΕΊΩΝ ΣΕ ΦΌΡΜΑ

  Επιλέξτε Εργαλεία > Προχωρημένη Επεξεργασία > Φόρμες > Εργαλεία Φορμών
(Tools > Advanced Editing >  Forms > Show Forms Toolbar)

 Επιλέξτε το κατάλληλο τύπο πεδίου (για παράδειγμα  αν θέλετε να  επεξεργαστείτε
τη Συμβουλή Ιδιότητας Εργαλείου (tooltip) ενός Πλαισίου Ελέγχου (checkbox)  ,
επιλέξτε   το  στοιχείο)

  Κάντε διπλό κλικ στο πεδίο της φόρμας (ή δεξί κλικ και επιλέξτε Ιδιότητες)

 Στο  παράθυρο διαλόγου Ιδιότητες , κάντε κλικ στη καρτέλα Γενικά (General tab)

 Πληκτρολογήστε το κείμενο των οδηγιών  στο πλαίσιο του εργαλείου (Tooltip box)

 Κάντε κλικ στο κουμπί Κλείσιμο (Close)

ΚΆΝΟΝΤΑΣ ΕΠΕΞΕΡΓΑΣΊΑ ΤΩΝ TAB ΚΑΙ ΤΗ ΣΕΙΡΆ ΑΝΆΓΝΩΣΗΣ ΤΗΣ ΈΚΔΟΣΗΣ 6.0
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  Κάντε κλικ στη καρτέλα Σελίδες (Pages tab) του παραθύρου περιήγησης (navigation
pane)

  Επιλέξτε τη μικρογραφία  της σελίδας (page thumbnail) και τις Ιδιότητες Σελίδας
(Page Properties) από το μενού Επιλογές (Options)

  Κάντε κλικ στη καρτέλα Διάταξη (Tab Order) και επιλέξτε μια  από τις ακόλουθες
εντολές της καρτέλας . α) Kάντε χρήση  της Διάταξης γραμμής (Row Order)  για  να
βάλετε στις γραμμές tab  από τα αριστερά προς τα δεξιά β)  Κάντε χρήση της
Διάταξης Στήλης (Column Order) για να βάλετε στις στήλες tab από αριστερά προς
τα δεξιά και από πάνω προς τα κάτω γ) Κάντε χρήση  της Δομής εγγράφου από το
δένδρο της  δομής (structure tree)

 Κάντε κλικ στο κουμπί Κλείσιμο (Close)

 Επιλέξτε Επεξεργασία > Προτιμήσεις ( Edit > Preferences)

  Επισημάνετε το κείμενο ανάγνωσης (Highlight Reading)

  Να επιλέξτε να συναγάγει τη σειρά ανάγνωσης (Infer Reading Order)  για να
αποδώσετε τις λέξεις σύμφωνα με την (deliver words according) επιλεγμένη σειρά
ετικετών . Αυτό συνίσταται

 Κάντε κλικ στο κουμπί  ΟΚ

Τώρα πλέον το PDF έγγραφο σας  έχει ετικέτες και διατηρεί τη δομή και το περιεχόμενο του. Ακόμη
μπορούν να υπάρχουν διαθέσιμες συμβουλές εργαλείων(Tooltips)  σε όλα τα πεδία της φόρμας.
Επιστροφή  Μετατρέποντας υπάρχοντα αρχεία σε  αρχεία μορφής PDF με προσβασιμότητα

6.3 Έλεγχοι Προσβασιμότητας
Η  Προσβασιμότητα μπορεί να ελεγχθεί  είτε με το Γρήγορο Έλεγχο  είτε με το Πλήρη Έλεγχο. Ο
Γρήγορος Έλεγχος θα επιστρέψει μια σύντομη δήλωση αφού ελεγχθούν η δομή και οι ετικέτες του
εγγράφου. Ο Πλήρης Έλεγχος επιστρέφει μια έκθεση  των στοιχείων που δεν έχουν προσβασιμότητα
καθώς και εισηγήσεις για τη διόρθωση  των  λαθών.
Αν κάνουνε Πλήρη Έλεγχο σε μεγάλα αρχεία PDF μπορεί να μας πάρει πολύ ώρα. Σταματάμε τον
Πλήρη Έλεγχο με  το πλήκτρο ESC αν δούμε ότι διαρκεί πολύ. Να εκτελείτε  την έκθεση  Ελέγχου σε
μικρότερη περιοχή σελίδων.

6.3.1 Πως εκτελώ το  Γρήγορο Έλεγχο Προσβασιμότητας

Για να εκτελέσετε τον Γρήγορο Έλεγχο Προσβασιμότητας επιλέξτε Για Προχωρημένους >
Προσβασιμότητα > Γρήγορος Έλεγχος ( Advanced > Accessibility > Quick Check. Ο Γρήγορος
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Έλεγχος θα επιστρέψει ένα από τα πέντε αποτελέσματα  που παρουσιάζονται  στον  παρακάτω
πίνακα.

Πίνακας 12  Μηνύματα Λάθους του Γρήγορου Ελέγχου
Μήνυμα Λάθους Σημασία / Δράση
Το έγγραφο έχει λογική δομή αλλά δεν
είναι αρχείο PDF με ετικέτες. Κάποιες
πληροφορίες προσβασιμότητας
ενδέχεται να λείπουν

Με το Adobe Reader θα ελέγξετε τη Σειρά Ανάγνωσης
χωρίς να χρειαστεί  να αναλυθεί ολόκληρο το έγγραφο. Θα
πρέπει να ρυθμίσετε τη σειρά ανάγνωσης στη περίπτωση
που   δεν υπάρχει  λογική για τη Υποστηρικτική Τεχνολογία
και  το Διάβασμα Φωνακτά (Read Out Loud)  τότε 

Το έγγραφο δεν έχει δομή και η σειρά
ανάγνωσης δεν είναι σωστή

Ο Γρήγορος Έλεγχος διαπίστωσε ότι το έγγραφο δεν  έχει
δομή. Όταν ο Αναγνώστης Οθόνης προσπαθήσει να το
διαβάσει τότε οι σελίδες  του εγγράφου δεν θα διαβαστούν
σωστά. Τo ίδιο θα γίνει και στη περίπτωση που το  έγγραφο
σας διαβαστεί φωνακτά (Read Out Loud)

Δεν εντοπίστηκαν προβλήματα
προσβασιμότητας στον γρήγορο έλεγχο

Ο Γρήγορος Έλεγχος διαπίστωσε ότι το έγγραφο PDF έχει
ετικέτες και βασική δομή. Όμως δεν έχει τις ρυθμίσεις
ασφαλείας (no security settings) και απαγορεύει την
πρόσβαση στον Αναγνώστη Οθόνης. Για να εξετάσετε τα
λάθη πιο προσεκτικά κάντε  στο Πλήρη Έλεγχο. 

Οι ρυθμίσεις ασφαλείας εμποδίζουν τους
Αναγνώστες  Οθόνης να έχουν
πρόσβαση στο έγγραφο

Το έγγραφο PDF  έχει τέτοιες ρυθμίσεις ασφαλείας που
απαγορεύει την πρόσβαση στους Αναγνώστες Οθόνης

Το έγγραφο φαίνεται να μην περιέχει
κείμενο. Μπορεί να είναι σαρωμένη
εικόνα

Το έγγραφο  PDF είναι γραφικό. Δεν υπάρχει η δυνατότητα
επεξεργασίας του κειμένου και έτσι  δεν διαβάζεται από τη
Υποστηρικτική Τεχνολογία (Assistive Technology)

6.3.2 Πως εκτελώ το Πλήρη  Έλεγχο Προσβασιμότητας

Η εκτέλεση του Πλήρη Ελέγχου Προσβασιμότητας περιλαμβάνει κατά σειρά  τα παρακάτω βήματα :
 Να επιλέξτε Για Προχωρημένους > Προσβασιμότητα > Πλήρης Έλεγχος ( Advanced >

Accessibility > Full Check)

 Στην ενότητα  Έκθεση και Επιλογές Σχόλιου  ( Report and Comment Options)  να :

 επιλέξετε την επιλογή για τη Δημιουργία Αναφοράς Προσβασιμότητας (Create
Accessibility Report  box)
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 κάνετε κλικ στο κουμπί Αναζήτηση για να καθορίσετε που θα σωθεί η αναφορά
προσβασιμότητας (customize location)

 επιλέξετε την  περίληψη με  τις υποδείξεις επισκευής  της  Αναφοράς
Προσβασιμότητας 

 Στην ενότητα Επιλογές Ελέγχου (Checking Options)  να  :

 επιλέξετε τις Εναλλακτικές Περιγραφές (Alternative descriptions)

 επιλέξετε τη Γλώσσα κειμένου (Text language)

  επιλέξετε  την Αξιόπιστη Κωδικοποίηση χαρακτήρων (Reliable character encoding)

 επιλέξετε  το περιεχόμενο που περιέχεται στο πλαίσιο της δομής του εγγράφου 

 επιλέξετε  όλα τα πεδία της φόρμας που έχουν πλαίσιο περιγραφής

 επιλέξετε  τη λίστα και το πίνακα δομής (table structure)  να έχουν  σωστό πλαίσιο

 επιλέξετε τη διάταξη Tab να είναι ακόλουθη με τη διάταξη δομής του πλαισίου,
ειδικά  για την έκδοση 7.0

 Κάντε κλικ στο κουμπί Έναρξη Ελέγχου (Start Checking)

Στη συνέχεια  θα εμφανιστεί η έκθεση με  τη λίστα των λαθών  που θα παρέχει υποδείξεις  για τη
διόρθωση τους. Είναι σημαντικό να εξετάσετε όλες τις αναφορές λαθών και να τις διορθώσετε  ή να
τις θεωρήσετε σαν κανόνες  λαθών. Ορισμένα στοιχεία της έκθεσης μπορεί να μη καθοριστούν .
Τέλος είναι απαραίτητο να γίνει ένα εγχειρίδιο Ελέγχου.
Επιστροφή Έλεγχοι προσβασιμότητας

6.4 Ετικέτες και Φτιάξιμο της Σειράς Ανάγνωσης
Αυτή η ενότητα σας πληροφορεί σχετικά με τη δημιουργία, τη προβολή (viewing) και την επεξεργασία
ετικετών που είναι απαραίτητες στη προσβασιμότητα. Θα μάθετε για τη χρήση της παλέτας των
ετικετών της έκδοσης 6.0 και για τα εργαλεία του Φτιαξίματος της Διάταξης Σειράς Ανάγνωσης
(TouchUp Reading Order)  της έκδοσης 7.0.

6.4.1 Φτιάξιμο της Σειράς Ανάγνωσης για την έκδοση 6.0

 Βεβαιωθείτε ότι όλες οι εικόνες έχουν εναλλακτικό κείμενο. Για να προσθέσετε εναλλακτικό
κείμενο σε εικόνα ακολουθείστε τα βήματα :

 Επιλέξτε Προβολή > Πλοήγηση στις Καρτέλες > Ετικέτες . Επιλέξτε τη καρτέλα
Ετικέτες για να εμφανιστεί το δένδρο της δομής (View > Navigation Tags > Tags)
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 Kάντε κλικ στο εικονίδιο  ενός στοιχείου  για να επεκτείνετε τη δομή του δένδρου και
να επιλέξετε την ετικέτα της  εικόνας 

 Επιλέξτε ιδιότητες από το μενού επιλογές

 Επιλέξτε τη καρτέλα Ετικέτα στο παράθυρο  διαλόγου των Ιδιοτήτων του
Φτιαξίματος Σειράς Ανάγνωσης (Touchup properties window)

 Πληκτρολογήστε το εναλλακτικό κείμενο της εικόνας

 Κάντε κλικ στο Κλείσιμο

 Βεβαιωθείτε ότι έχει ορισθεί μια γλώσσα κειμένου. Για να γίνει αυτό κάντε κατά σειρά :

 Επιλέξτε  Προβολή > Πλοήγηση  στις Ετικέτες > Ετικέτες (View > Navigation Tags >
Tags)

 Αναπτύξτε τη δομή του δένδρου εκεί που χρειάζεται

 Επιλέξτε το κείμενο του στοιχείου που περιέχεται στη δομή του δένδρου. Όλα τα
στοιχεία που βρίσκονται κάτω από το επιλεγμένο στοιχείο θα έχουν τις ίδιες ιδιότητες
Γλώσσας

 Επιλέξτε Ιδιότητες από το μενού Επιλογές

 Επιλέξτε την καρτέλα  Ετικέτα στο παράθυρο Διαλόγου των Ιδιοτήτων Φτιαξίματος
(Touchup properties window)

 Επιλέξτε τη Γλώσσα από το μενού Γλώσσα (Language menu)

 Κάντε κλικ στο Κλείσιμο

6.4.2 Φτιάξιμο Σειράς Ανάγνωσης  για την έκδοση 7.0

 Αν δεν είναι ανοικτό το έγγραφο , ανοίξτε το με το Adobe Acrobat Professional

 Χρησιμοποιήστε μια από τις παρακάτω επιλογές για να ανοίξετε το παράθυρο του
Φτιαξίματος Σειράς  Ανάγνωσης(ΤouchUp Reading  Order)  

 Κάντε δεξί κλικ στο έγγραφο και στη συνέχεια επιλέξτε την εμφάνιση της Διάταξης
Ανάγνωσης  (Show Reading Order)

 Επιλέξτε Προβολή > Περιήγηση στις Ετικέτες > Διάταξη (View > Navigation Tabs >
Order). Επιλέξτε την Εμφάνιση  Σειράς Ανάγνωσης (Show Reading Order) από τη
καρτέλα Επιλογές (Options Tab)
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 Επιλέξτε Επεξεργασία > Προτιμήσεις (Edit > Preferences). Επιλέξτε τη κατηγορία
Γενικά (General) και επιλέξτε την επιλογή «Χρησιμοποιήστε το Απλό-Κλειδί στους
Επιταχυντές» (Use Single-Key Accelerators) . Κάντε κλικ ΟΚ. Πατήστε τον
συνδυασμό των πλήκτρων Alt+v,n,o

 Το παράθυρο Φτιαξίματος  Σειράς Ανάγνωσης θα ανοίξει

 Επιλέξτε  Εμφάνιση Διάταξης Περιεχομένου (Show Page Content Order)

 Ελέγξετε τη Σειρά Ανάγνωσης  Κειμένου για κάθε περιοχή

 Ελέγξετε τη σειρά αρίθμησης όλων των περιοχών. Αν υπάρχουν περιοχές εκτός σειράς πρέπει
να τις αναδιατάξετε στη καρτέλα Διάταξη(Order Tab). Για να αλλάξετε τη σειρά ανάγνωσης
ακολουθήστε τα παρακάτω  βήματα :

 Περιηγηθείτε για να δείτε τη λίστα των τονισμένων περιοχών (highlighted regions)

 Επιλέξετε  το εικονίδιο ετικέτας μιας τονισμένης περιοχής και σύρετε αυτό στη θέση
που θέλετε. Καθώς θα κάνετε το σύρσιμο θα φανεί η γραμμή της δυναμικής θέσης
του. Ένα εικονίδιο σφάλματος με ένα κύκλο και μια γραμμή θα φανερώσει τις θέσεις
στις οποίες δεν μεταφέρεται η ετικέτα. Μπορείτε να κάνετε πολλαπλή επιλογή και
μετακίνηση ετικετών ταυτόχρονα σε παρακείμενες θέσεις.

 Βεβαιωθείτε ότι όλα τα στοιχεία έχουν ετικέτες. Για να αλλάξετε τον τύπο της ετικέτας
ακολουθήστε τα βήματα :

 Επιλέξτε το εργαλείο του Φτιαξίματος  Σειράς Ανάγνωσης

 Βεβαιωθείτε ότι είναι επιλεγμένη η Εμφάνιση Διάταξης Περιεχομένου (Show Page
Content Order) στο πλαίσιο του Φτιαξίματος Σειράς  Ανάγνωσης

 Επιλέξτε μια τονισμένη περιοχή  με το σύρσιμο  επάνω της ή κάντε κλικ στον αριθμό
της τονισμένης περιοχής

 Κάντε κλικ στο επιθυμητό κουμπί  της ετικέτας που έχει η τονισμένη περιοχή

 Βεβαιωθείτε ότι οι ετικέτες του πίνακα(table tags) είναι σωστές . Για να αλλάξετε μια ετικέτα
πίνακα κάνετε τα ακόλουθα :

 Επιλέξτε το εργαλείο Φτιαξίματος Σειράς  Ανάγνωσης

 Βεβαιωθείτε ότι η επιλογή Εμφάνιση  Πινάκων  και Εικόνων  (Show Tables and
Figures) είναι επιλεγμένη στο πλαίσιο του παραθύρου Φτιαξίματος Σειράς
Ανάγνωσης
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 Επιλέξτε την επιλογή Εμφάνιση  των Κελιών των Πινάκων  (Show Tables Cells) για να
δείτε ότι τα κελιά έχουν σωστές  ετικέτες

 Αν ο πίνακας δεν έχει  ετικέτα , σύρετε πάνω του το  ποντίκι για να τον επιλέξετε και
κάντε κλικ στο κουμπί Πίνακα (Table Button)

 Αν τα κελιά του πίνακα έχουν  συνδυασθεί με λάθος τρόπο  (incorrectly combined),
επιλέξτε μια περιοχή κελιού και κάντε κλικ  στο κουμπί Κελί (Cell Button)

 Για να προσθέσετε εναλλακτικό κείμενο  σε πίνακα  κάντε δεξί κλικ στον πίνακα και
επιλέξτε Επεξεργασία Εναλλακτικού Κείμενου (Edit Alternate  Text).

 Πληκτρολογήστε τη περιγραφή στο πλαίσιο διαλόγου του Εναλλακτικού Κειμένου.

 Κάντε κλικ στο  ΟΚ

 Βεβαιωθείτε ότι οι ετικέτες των εικόνων είναι σωστές. Για να αλλάξετε την ετικέτα μιας
εικόνας κάνετε τα παρακάτω :

 Επιλέξτε το εργαλείο του   Φτιαξίματος Σειράς  Ανάγνωσης (Touchup Reading Order)

 Βεβαιωθείτε ότι η επιλογή Εμφάνιση Πινάκων και Εικόνες (Show Tables and Figures)
είναι επιλεγμένη στο πλαίσιο διαλόγου του Φτιαξίματος Σειράς  Ανάγνωσης (Touchup
Reading Order)

 Αν η εικόνα δεν έχει ετικέτα , επιλέξτε την εικόνα  και στη συνέχεια επιλέξτε το
κουμπί της επιλογής Εικόνα ή Εικόνα / Σχόλιο (Figure or Figure / Caption) 

 Για να κάνετε αφαίρεση του κειμένου μιας εικόνας  , σύρετε πάνω του για το
επιλέξετε (drag to select)  και στη συνέχεια επιλέξτε το κουμπί Κείμενο (Text button)

 Για να προσθέσετε εναλλακτικό κείμενο σε εικόνα κάντε δεξί κλικ στην εικόνα και
επιλέξτε Επεξεργασία Εναλλακτικού Κείμενου. Στο πλαίσιο της επιλογής ,
πληκτρολογήστε τη περιγραφή και στο τέλος πατήστε ΟΚ

 Βεβαιωθείτε ότι έχουν εντοπιστεί τα περιεχόμενα μιας σελίδας που σχετίζονται τα στοιχεία
της. Οι εικόνες υπόβαθρου (Background images) και τα στοιχεία  που έχουν προστεθεί στο
σωρό με τη διάταξη του εγγράφου πρέπει να φύγουν αν δεν  χρειάζεται η πληροφορία τους.
Για τα καταργήσετε ακολουθήστε τα παρακάτω βήματα :

 Επιλέξτε το εργαλείο του Φτιαξίματος Σειράς Ανάγνωσης

 Βεβαιωθείτε ότι η επιλογή Εμφάνιση Πινάκων και Εικόνων είναι επιλεγμένη
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 Για να βάλετε την ετικέτα Υπόβαθρου σε μια εικόνα , επιλέξτε το στοιχείο και κάντε
κλικ στην επιλογή Υπόβαθρο (Background)

 Για να διαγράψετε μια ετικέτα εντελώς , επιλέξτε το στοιχείο της σελίδας  από τη
καρτέλα της Διάταξης (Order Tab) και πατήστε Διαγραφή.

Μπορείτε να επιλέξετε τις επιλογές του Ρετουσαρίσματος Διάταξης Ανάγνωσης από το αναδυόμενο
μενού που εμφανίζεται όταν κάνετε δεξί κλικ σε μια τονισμένη περιοχή ή από το μενού Επιλογές στη
καρτέλα Διάταξης (Order tab). Το εργαλείο Ρετουσαρίσματος Διάταξης Ανάγνωσης έχει τις
ακόλουθες επιλογές για τις εκδόσεις 6.0 και 7.0.

Πίνακας 13  Διαφορές Φτιαξίματος Σειράς  των εκδόσεων 6.0 και 7.0
Επιλογές Φτιαξίματος Σειράς Ανάγνωσης
(Touchup Reading Order Option)

Περιγραφή Version  6.0 Version 7.0

Κείμενο Καθορίζει το
κείμενο

Ναι Ναι

Εικόνα Καθορίζει τις
εικόνες

Όχι Ναι

Πεδίο Φόρμας Καθορίζει τα
Πεδία της
Φόρμας

Όχι Ναι

Εικόνα / Λεζάντα - Σχόλιο Καθορίζει το
σχήμα και τη
λεζάντα σε απλή
ετικέτα

Όχι Ναι

Επικεφαλίδες 1 , 2, 3 Καθορίζει τα
επίπεδα   1, 2, 3
τ ω ν
επικεφαλίδων

Όχι Ναι

Πίνακας Καθορίζει τους
πίνακες και  τη
θέση των
επ ικεφαλ ίδων
,των γραμμών
και των στηλών

Όχι Ναι

Κελί Καθορίζει  τις
ε π ι κ ε φ α λ ί δ ε ς
των κελιών του
πίνακα

Όχι Ναι
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Τύπος ( Formula ) Καθορίζει τους
τύπους και
παρέχει τη
δυνατότητα να
π ρ ο σ θ έ σ ε τ ε
Ε ν α λ λ α κ τ ι κ ό
Κείμενο

Όχι Ναι

Υπόβαθρο (Background) Καθορίζει τα
στοιχεία του
φόντου

Όχι Ναι

Εμφάνιση Διάταξης Περιεχομένου Σελίδας
(Show Page Content Order)

Τονίζει τις
περιοχές που
είναι έχουν
α ρ ί θ μ η σ η
σύμφωνα με τη
σ ε ι ρ ά
ανάγνωσης

Όχι Ναι

Εμφάνιση Κελιών Πίνακα
(Show Table Cells)

Τονίζει τα
π ε ρ ι ε χ ό μ ε ν α
τ ω ν
μεμονωμένων
κελιών του
πίνακα

Όχι Ναι

Εμφάνιση  Πινάκων και Εικόνων
(Show Tables and Figures)

Περιγράφει τον
πίνακα και  την
ε ι κ ό ν α
υποδεικνύοντας
αν το στοιχείο
έχει εναλλακτικό
κείμενο

Όχι Ναι

Καθαρισμός Δομής Σελίδας
(Clear Page Structure)

Καθαρίζει όλες
τις ετικέτες της
σελίδας για να
αρχίσετε από τη
πάνω πλευρά
της σελίδας

Όχι Ναι

Εμφάνιση της  Διάταξης των Ετικετών
(Show Order Tab)

Ανοίγει τη
κ α ρ τ έ λ α

Όχι Ναι
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Διάταξης και
επιτρέπει την
αναδιάταξη του
τ ο ν ι σ μ έ ν ο υ
περιεχομένου

Επεξεργασία Εναλλακτικού Κείμενου
(Edit Alternate Text)

Επιτρέπει την
επεξεργασία της
π ε ρ ι γ ρ α φ ή ς
μιας εικόνας

Όχι Ναι

Επεξεργασία του Πεδίου Κείμενου της Φόρμας
(Edit Form Field Text)

Δίνει την
δ υ ν α τ ό τ η τ α
επεξεργασ ίας
της  περιγραφής
του κειμένου
συμβουλής του
πεδίου της
φόρμας

Όχι Ναι

Επιστροφή Ετικέτες και Φτιάξιμο Σειράς Ανάγνωσης
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7 Συμβουλές για την προσβασιμότητα των αρχείων στο Ms Word
Πίνακας 14  Πίνακας Συμβουλών για τη προσβασιμότητα στο Ms Word

Τι να κάνετε Τι να  μην κάνετε Γιατί
Να δομείτε τα  έγγραφα με
τη χρήση των Στυλ της
παλέτας μορφοποίησης

Μην «παίζετε» με τα
μεγέθη των γραμμάτων
και τα χρώματα  που
αποδίδουν τη σημασία των
εννοιών.

Μόνο οι Επικεφαλίδες  των επιπέδων 1, 2,
3 , τα έντονα γράμματα,  το διευρυμένο
(enlarged)  κείμενο ή το κείμενο με
στοίχιση    θα γίνει κατανοητό από τα
μέσα της Υποστηρικτικής  Τεχνολογίας

Να χρησιμοποιείτε τις
κουκκίδες του Ms Word και
τα στυλ αρίθμησης για να
ορίσετε τις λίστες του
κειμένου

Μην  προσθέτετε έναν
αριθμό ή μια τελεία σε
παράγραφο για να μοιάσει
με λίστα

Οι σωστές Λίστες θα γίνουν κατανοητές
από τα μέσα βοηθητικής τεχνολογίας

Να χρησιμοποιείτε τις
δυνατότητες της Στήλης για
να προσθέσετε κείμενο σ
αυτή

Μην χρησιμοποιείτε το
πλήκτρο Tab

Οι στήλες  μπορούν να μεταφέρουν
νοήματα και έννοιες στα μέσα της
Υποστηρικτικής  Τεχνολογίας

Να εισάγετε εναλλακτικό
κείμενο σε εικόνες και τα
γραφικά

Μην ξεχνάτε να εισάγετε
εναλλακτικό κείμενο

Η μη ύπαρξη εναλλακτικού κείμενου
κάνει τις εικόνες να μην μπορούν να
διαβαστούν από  τα μέσα Υποστηρικτικής
 Τεχνολογίας

Να επιβεβαιώσετε ότι η
διάταξη διαβάσματος (read
order) στο πλαίσιο κειμένου
είναι σωστή και έχει λογική
(logical)

Μην εισάγετε πλαίσια
κειμένου ή άλλα στοιχεία
σε περιοχή μη ορισθείσα

Η Υποστηρικτικής  Τεχνολογίας δεν
ανιχνεύει πάντοτε τα πλαίσια κειμένου. Η
διάταξη διαβάσματος των περιεχομένων
των πλαισίων κειμένου  εξαρτάται από
την εισαγωγή τους και από το αν η
εισαγωγή τους  έχει νόημα

Να απλοποιήσετε τα
διαγράμματα, τα
γραφήματα  και  τους
πίνακες

Μην εισάγετε σύνθετα
διαγράμματα, γραφήματα
, πίνακες ή περιττά
γραφικά

Οι χρήστες με θέματα αναπηρίας δεν
είναι ικανοί να ερμηνεύσουν δεδομένα
χωρίς να εισάγουν κάποια άλλη
εφαρμογή. Είναι δύσκολο να
δημιουργηθούν πολύπλοκα  διαγράμματα
και πίνακες με δυνατότητες  πρόσβασης

Να έχει κάθε  πίνακας  μια
γραμμή ως επικεφαλίδα

Μην χρησιμοποιείτε
μεγάλα γράμματα, με
έντονη γραφή και
διαφορετικό χρώμα για να

Οι επικεφαλίδες θα δώσουν στους
χρήστες με  ειδικές ανάγκες τη
δυνατότητα να περιηγηθούν στους
πίνακες χωρίς να χαθούν
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αποδώσετε επικεφαλίδα
Να χρησιμοποιείτε χρώμα
και τονισμό (highlighting)
για ενίσχυση του κειμένου

Μην χρησιμοποιείτε το
χρώμα ως τη μόνη μέθοδο
για τη μετάδοση
πληροφορίας

Οι χρήστες με χαμηλή όραση και
αχρωματοψία δεν θα μπορούν να
διαχωρίσουν τις πληροφορίες

Να υπάρχει επαρκής
χρωματική αντίθεση στο
κείμενο, στα γραφήματα και
στις εικόνες

Μην επιλέξετε τα χρώματα
κειμένου και του φόντου
με μικρή αντίθεση  το ίδιο
και στις εικόνες που
μεταδίδουν απαραίτητα
νοήματα

Οι χρήστες με χαμηλή όραση και
αχρωματοψία δεν θα μπορούν να
διαβάσουν το έγγραφο

Επιλέξτε μια γραμματοσειρά
που είναι εύκολο να
διαβαστεί όπως τη
γραμματοσειρά Arial ή
Helvetica

Μην σκιάζεται (shadowed)
ή σκιαγραφείτε το κείμενο

Οι χρήστες με χαμηλή όραση
δυσκολεύονται να διαβάσουν  τις
γραμματοσειρές με σκίαση

Να υπάρχει περιορισμός
των κινούμενων εικόνων
(animation)

Μην συμπεριλαμβάνετε
περιττές κινούμενες
εικόνες GIF

Οι κινούμενες εικόνες αποσπούν τη
προσοχή σε κάποιους χρήστες

Να μειώσετε το μέγεθος του
αρχείου εισάγοντας εικόνες
που έχουν αλλάξει μέγεθος

Μην εισάγετε μεγάλες
εικόνες και μετά τις
μ ο ρ φ ο π ο ι ε ί τ ε
συρρικνώνοντας τις

Το κατέβασμα και η χρήση μεγάλων
αρχείων είναι δύσκολο για όλους τους
χρήστες. Μειώστε το μέγεθος του αρχείου
με την εισαγωγή κατάλληλων εικόνων
αντί να  τις αλλάξετε μέγεθος με το Ms
Word

Να χρησιμοποιείτε  «καλό»
κείμενο στην υπερσύνδεση
(link text)

Μην γράφετε «κάντε κλικ
εδώ»

Οι φράσεις των υπερσυνδέσεων όπως
«κάντε κλικ εδώ» προκαλούν σύγχυση
στους χρήστες που χρησιμοποιούν τα
προγράμματα οθόνης. Κάνετε την
υπερσύνδεση περιγραφική 

Να κάνετε την αποθήκευση
του αρχείου Ms Word  σε
πολλές μορφές πρόσβασης
ώστε να δώσετε τη
δυνατότητα στους χρήστες
να έχουν τη καλύτερη
μορφή με προσβασιμότητα.

Μην θεωρήσετε ότι «ένα
μέγεθος είναι για όλους»
(one size fits all)

Κάποιοι χρήστες δεν έχουν το Ms Word.
Να δώσετε τις συνδέσεις των κατάλληλων
βοηθητικών προγραμμάτων (plug-ins)
όπως του  δωρεάν Ms Word Viewer  ή μια
προσιτή έκδοση HTML για οn-line
επικοινωνία
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7.4.1 Χρησιμοποιώντας  Δομημένη Μορφοποίηση στο Ms Word

Η δόμηση του κειμένου  αποτελεί ουσιαστικό στοιχείο του ψηφιακού αρχείου με πρόσβαση.
Περιγράφει το σκοπό του κειμένου , επιτρέπει στους αναγνώστες να σαρώσουν το κείμενο, να
προσδιορίσουν το περιεχόμενο του και να κατανοήσουν τι θέλει να πει ο συγγραφέας. Ένα μη
μορφοποιημένο έγγραφο είναι ένα έγγραφο κειμένου πολλών σελίδων  ενός μεγάλου μπλοκ.

Εικόνα 76. Σχηματική παρουσίαση
του τρόπου  δόμησης εγγράφου

Τα έγγραφα που έχουν δομή, είναι πιο
προσιτά σε όλους τους  αναγνώστες και  ειδικά στα άτομα με ειδικές ανάγκες. Όλοι οι τύποι των
τεχνολογιών όπως και οι μηχανές αναζήτησης έχουν πρόσβαση  στα δομημένα έγγραφα του Ms
Word  . Η προσβασιμότητα τους είναι μεγαλύτερη όταν μετατραπούν σε μορφή HTML ή PDF.

7.4.2 Στυλ Επιλογών Μορφοποίησης στο Ms Word

Στο Ms Word οι επιλογές Μορφοποίησης είναι διαθέσιμες στα Στυλ της παλέτας Μορφοποίηση
Μορφή > Εργαλεία > Μορφοποίηση (View >Toolbars>Formatting)
 Η παλέτα  Μορφοποίησης θα είναι ορατή  αν είναι επιλεγμένη  η Μορφοποίηση
Θυμηθείτε : Να αποφεύγετε να χρησιμοποιείτε τις επιλογές των Στυλ των Γραμματοσειρών (Font
styling Options) για να κάνετε το κείμενο Επικεφαλίδες. Αντί αυτού  να  χρησιμοποιήστε την επιλογή
Στυλ (Styles) για να εφαρμόσετε τις κατάλληλες διαρθρωτικές μορφοποιήσεις. Χρησιμοποιείστε
Μορφή > Στυλ  ( Format > Styles)  για να αλλάξετε την εμφάνιση των δομικών στοιχείων σύμφωνα με
τις προτιμήσεις σας. Το εργαλείο της Μορφοποίησης μπορεί να βρίσκεται στη κορυφή της βασικής
γραμμής εργαλείων  ή να ίπταται πλευρικά με μορφή παλέτας.

Εικόνα 77. Γραμμή  των βασικών εργαλείων του Ms Word

Content

|

Structure

|

Then Make It Pretty!
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Εικόνα 78. Καρτέλα των εργαλείων μορφοποίησης του Ms Word

7.4.3 Προσθήκη Εναλλακτικού Κείμενου σε Εικόνες

Το Εναλλακτικό κείμενο είναι ένα ισοδύναμο κείμενο  λέξεων για ένα
στοιχείο μη κειμένου.  Πρέπει να είναι συνεπές, σαφές, σημαντικό και χρήσιμο. Όταν μια εικόνα
αναπαριστά το περιεχόμενο μιας σελίδας , η εικόνα πρέπει να έχει ισοδύναμη περιγραφή κειμένου
στο εναλλακτικό χαρακτηριστικό της (alt attribute) που να εξηγεί την εικόνα. Αυτή  μπορεί να
περιλάβει σύνθετα γραφικά, διαγράμματα και άλλα.
Στο Ms Word  για Mac (2004)  δεν μπορείτε να προσθέσετε εναλλακτικό  κείμενο. Η νέα έκδοση του
Ms Word για Mac (2008) ενδέχεται να επιλύσει το πρόβλημα του εναλλακτικού κειμένου .Όμως το
Ms Word  δεν αντιμετωπίζει τέτοια προβλήματα δηλ. μπορείτε να προσθέτετε εναλλακτικό κείμενο
στις εικόνες των εγγράφων του. Κάντε Δεξί κλικ στην εικόνα και επιλέξτε Μορφοποίηση Εικόνας (ή
Μορφή > Εικόνα από τη γραμμή του μενού). Θα εμφανιστεί το παράθυρο Μορφοποίησης. Κάντε κλικ
στην καρτέλα Wed και προσθέστε εναλλακτικό κείμενο.

Εικόνα 79. Παράθυρο Μορφοποίησης Εικόνας για την εισαγωγή εναλλακτικού κείμενου
Επιστροφή Συμβουλές για την προσβασιμότητα στο Word
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8 Συμβουλές για τη προσβασιμότητα  των παρουσιάσεων στο Ms
Powerpoint

Πίνακας 15  Πίνακας Συμβουλών για τη προσβασιμότητα στο Ms Powerpoint
Τι να κάνετε Τι να μην κάνετε Γιατί
Πάντα να χρησιμοποιείται
τη παλέτα Μορφοποίησης
και τα εργαλεία  Διάταξης
Διαφάνειας για να επιλέξετε
τη σωστή  διάταξη για τη
παρουσίαση σας

Μην εισάγετε πλαίσια
κειμένου ή άλλα στοιχεία
σε περιοχή που δεν έχει
οριστεί

Τα μέσα της Υποστηρικτικής  Τεχνολογίας
δεν μπορούν πάντα να ανιχνεύσουν τα
εισαγόμενα πλαίσια κειμένου (inserted
text boxes). Η Διάταξη Σειράς των
περιεχομένων στα  εισαγόμενα πλαίσια
κειμένου δεν έχει νόημα

Επιλέξετε τη κατάλληλη
διάταξη διαφάνειας με
βάση τη σημαντικότητα
(semantics) των
περιεχομένων

Μην «παίζετε» με το
μέγεθος και το χρώμα της
γραμματοσειράς για να
αποδώσετε τη
σημασιολογία μιας έννοιας

Μόνο πραγματικές επικεφαλίδες, τίτλοι,
παράγραφοι και λίστες θα μεταφέρουν το
νόημα στις συσκευές βοηθητικής
τεχνολογίας

Να απλοποιήσετε όλα τα
διαγράμματα και τους
πίνακες

Μην  εισάγετε σύνθετα
γραφήματα ή πίνακες ή
χρησιμοποιείτε περιττά
γραφικά για τα
γραφήματα

Μπορεί οι ανάπηροι χρήστες να μην είναι
σε θέση να ερμηνεύσουν τα δεδομένα
χωρίς  να τα εισάγουν σε άλλη εφαρμογή.
Είναι δύσκολο να δημιουργήσεις
πολύπλοκα γραφήματα και πίνακες με
δυνατότητες πρόσβασης

Να διατηρήσετε μεγάλο το
μέγεθος των γραμμάτων της
γραμματοσειράς

Μην βάζετε πολύ
περιεχόμενο σε μια
διαφάνεια και   μειώνετε
το μέγεθος των
γραμμάτων

Οι χρήστες με μειωμένη όραση δεν είναι
σε θέση να αλλάξουν το μέγεθος της
μικρής γραμματοσειράς σε ευανάγνωστο
μέγεθος

Να επιλέξετε τα χρώματα
του κείμενου  και του
υπόβαθρου ώστε να έχουν
υψηλή χρωματική αντίθεση
και φωτεινότητα

Μην  επιλέγετε χρώματα
με μικρή αντίθεση μεταξύ
κειμένου και φόντου  και ή
σε εικόνες που αποδίδουν
σημαντικά νοήματα

Οι χρήστες με χαμηλή όραση και
αχρωματοψία δεν θα είναι σε θέση να
διαβάσουν τις διαφάνειες

Να περιορίσετε τη χρήση
εικόνων με κίνηση

Μην περιλαμβάνεται
περιττές κινούμενες
εικόνες GIF

Οι κινούμενες εικόνες αποσπούν τη
προσοχή ορισμένων χρηστών και μπορεί
να κάνουν κάποια μηχανήματα
ανάγνωσης να διαβάζουν τη διαφάνεια
πάλι και πάλι
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Να περιορίσετε τη χρήση
των μεταβάσεων μεταξύ
των στοιχείων μιας
διαφάνειας όπως για
παράδειγμα με σφαιρίδια
(bullet point) που ίπτανται ή
ξεθωριάζουν και
επανέρχονται  (fade in and
fade out). Για τις
μεταβάσεις χρησιμοποιήστε
κάτι απλό όπως το
ξεθώριασμα (Fade)

Μην κάνετε μη
απαραίτητες μεταβάσεις
μεταξύ των στοιχείων.
Μην χρησιμοποιείτε
σύνθετες μεταβάσεις όπως
 τη μορφή Σκακιέρας ή του
Τροχού (Checkerboard or
Wheel)

Οι μεταβάσεις μπορούν να αποσπούν τη
προσοχή μερικών χρηστών και να κάνει
τους αναγνώστες οθόνης να διαβάζουν
πάλι και πάλι τη διαφάνεια

Να μειώσετε το μέγεθος του
αρχείου μειώνοντας σωστά
το μέγεθος των εικόνων

Μην εισάγετε μεγάλες
εικόνες και τις
μ ο ρ φ ο π ο ι ε ί τ ε
συρρικνώνοντας τις

Τα μεγάλα αρχεία σε μέγεθος
δυσκολεύουν το κατέβασμα και τη χρήση
τους

Να αποδώσετε  εναλλακτικό
κείμενο σε όλες τις εικόνες
και γραφήματα

Μην ξεχάσετε να
προσθέσετε εναλλακτικό
κείμενο

Χωρίς εναλλακτικό κείμενο το
περιεχόμενο μιας εικόνας είναι  αόρατο
για τους χρήστες της Υποστηρικτικής
Τεχνολογίας

Να βεβαιωθείτε ότι όλα τα
αρχεία βίντεο και ήχων
έχουν υπότιτλους πριν  τα
ενσωματώσετε στο Ms
Powerpoint . Όταν κρίνετε
σκόπιμο να συμπεριλάβετε
αντίγραφο

Μην εισάγετε αρχεία
βίντεο και ήχου χωρίς
υπότιτλους αν δεν υπάρχει
ένα τρόπος εναλλακτικής
πρόσβασης

Οι λεζάντες πρέπει να συγχρονίζονται  για
τους  χρήστες με προβλήματα ακοής ή με
νοητικές αναπηρίες. Θα πρέπει οι
χρήστες αυτοί να έχουν την δυνατότητα
πρόσβασης να  κατανοήσουν το
περιεχόμενο τους. Αυτά υποστηρίζονται
από διαφορετικούς τρόπους μάθησης
(learning styles)

Να χρησιμοποιήσετε το
πεδίο της Σημείωσης για να
γράψετε το σενάριο της
κάθε διαφάνειας

Μην κάνετε την υπόθεση
ότι η παρουσίαση έχει
νόημα για τους χρήστες
που δεν ακούν για το ό,τι
λέει ο παρουσιαστής

Το  περίγραμμα (outline style) της
παρουσίασης στο Ms Powerpoint δεν έχει
νόημα αν δεν γνωρίζουμε για το τι λέει ο
αφηγητής. Οι σημειώσεις βοηθούν τους
σπουδαστές να επανεξετάσουν το
περιεχόμενο της διάλεξης. Όταν κάνετε
τη χρήση της εγγεγραμμένης αφήγησης
(Record Narration) το περιεχόμενο του
πεδίου σημειώσεων μπορεί  να
χρησιμοποιηθεί για τη δημιουργία
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συγχρονισμένων λεζάντων
Να κάνετε αποθήκευση του
αρχείου  Ms Powerpoint με
πρόσβαση σε πολλές
μορφές (multiple formats)
για να μπορούν οι χρήστες
να το χρησιμοποιήσουν την
καλύτερα

Μην υποθέσετε ότι «ένα
μέγεθος κάνει για όλους»
(one size fits all)

Η αποθήκευση της παρουσίασης σας σε
πολλές μορφές μπορεί να στηρίξει
μαθητές με διαφορετικές ανάγκες στο
τρόπο μάθησης. Αν κάνετε αυτές
διαθέσιμες θα βοηθούν να
προετοιμαστούν για τη τάξη

8.1 Παλέτα Μορφοποίησης Διαφανειών

Εικόνα 80. Καρτέλα Μορφοποίησης  του Ms Powerpoint

Εικόνα 81. Παράθυρο  διαλόγου για τη
δημιουργία νέας διαφάνειας

8.1.1 Για τους χρήστες των Windows
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Δεξί κλικ στη εικόνα, επιλέξτε Μορφοποίηση Εικόνας (Format Picture) ή επιλέξτε Μορφή > Εικόνα
από τη γραμμή του μενού (Format > Picture). Κάντε  κλικ στη καρτέλα Web και πληκτρολογήστε το
κείμενο στο πλαίσιο με την ετικέτα Εναλλακτικό κείμενο.

Εικόνα 82. Παράθυρο διαλόγου Μορφοποίησης
Αντικειμένου

8.1.2 Για τους χρήστες των Mac

Δεν υπάρχει τρόπος για τη δημιουργία εναλλακτικού  κείμενου σε εικόνα στο MS Office για Mac. Αυτό
θα χρειαστεί να γίνει με Office των Windows ή θα πρέπει να το διορθώσετε ή να το μετατρέψετε  σε

αρχείο PTT με τη χρήση ενός  3ου εργαλείου (3rd party tool)

8.2 Τα εργαλεία μετατροπής LecShare και LecShare Pro των HTML, DOC, PTT
Μετατρέπει  το  PPT σε αρχείο μορφών  HTML , DOC και PPT  με πρόσβαση . Επίσης η έκδοση PRO
αποθηκεύει το PTT  σε  QuickTime ή σε  MPEG-4 και σε έκδοση PTT.  Ηχογραφεί  τον ήχο, την
αφήγηση και μετατρέπει τα πεδία των σημειώσεων κειμένου  σε συγχρονισμένες λεζάντες . Είναι πολύ
απλό στη χρήση. Επισκεφτείτε τη διεύθυνση http://www.lecshare.com/products.htm . Διατίθεται για
Windows και Mac.

8.3 Εργαλείο Προσβασιμότητας Web Δημοσίευσης Illionois 
Για τη  μετατροπή PPT  σε αρχείο με πρόσβαση μορφής HTML μην επισκεφτείτε τη διεύθυνση
http://www.accessiblewizards.uiuc.edu/index.php  και τη διεύθυνση http://www.virtual508.com/ .
Διατίθεται για Windows.

8.4 Περισσότερες Υπερσυνδέσεις για τη προσβασιμότητα του Ms Powerpoint
 SSU Πρωτοβουλία Τεχνολογίας για Προσβασιμότητα (SSU Accessible Technology Initiave) –

Παιδαγωγικά

http://www.lecshare.com/products.htm
http://www.accessiblewizards.uiuc.edu/index.php
http://www.virtual508.com/
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 http://webaim.org/techniques/powerpoint/ Διδακτικό βοήθημα Web για τη
προσβασιμότητα στο Ms PowerPoint ( WebAIM Ms Powerpoint Accessibility tutorial)

 http://www.adobe.com/macromedia/accessibility/features/breeze/building.html
Adobe's Building Accessible Ms Powerpoint- Δεν είναι  διαθέσιμη

 http://www.cew.wisc.edu/accessibility/tutorials/pptmain.htm Για τη δημιουργία
παρουσιάσεων στο Ms Powerpoint με προσβασιμότητα στο Web (Web Accessibility
for All- Creating Accessible Ms Powerpoint Presentations)

 http://ncdae.org/tools/factsheets/powerpoint.cfm  Για συμβουλές ΝCDAE και
εργαλεία όπως  Microsoft Ms Powerpoint Factsheet (NCDAE Tips and Tools:
Microsoft Ms Powerpoint Factsheet)

Επιστροφή Συμβουλές για τη προσβασιμότητα στο PowerPoint

http://webaim.org/techniques/powerpoint/
http://www.webaim.org/techniques/powerpoint/
http://www.adobe.com/macromedia/accessibility/features/breeze/building.html
http://www.adobe.com/macromedia/accessibility/features/breeze/building.html
http://www.cew.wisc.edu/accessibility/tutorials/pptmain.htm
http://www.cew.wisc.edu/accessibility/tutorials/pptmain.htm
http://ncdae.org/tools/factsheets/powerpoint.cfm
http://ncdae.org/tools/factsheets/powerpoint.cfm
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9 Τι πρέπει να κάνετε και τι δεν πρέπει να κάνετε στη προσβασιμότητα
μιας  παρουσίασης  στο Ms  PowerPoint

9.1 Διάταξη

9.1.1  Τι πρέπει να κάνεις στη   Διάταξη

Εικόνα 83. Παλέτα Μορφοποίησης της Διάταξης  των διαφανειών
 Να χρησιμοποιείτε πάντα τη παλέτα μορφοποίησης για να επιλέξτε τη μορφή της

διάταξης των διαφανειών

 Να επιλέγετε τη μορφή της διάταξης των  διαφανειών με βάση  το περιεχόμενο της
παρουσίασης

Να χρησιμοποιείτε τη παλέτα  Μορφοποίησης και το εργαλείο Προσθήκη Αντικειμένου (Add Object)
για να προσθέστε με τη σωστή σειρά διάταξης τις νέες  διαφάνειες . Αυτό  εξασφαλίζει ότι το κείμενο
θα έχει τη σωστή διάρθρωση και σημασιολογική σήμανση. Για παράδειγμα , αν η διαφάνεια έχει έναν
τίτλο και  μια λίστα με κουκκίδες τότε όλο το κείμενο εμφανίζεται στο παράθυρο διάρθρωσης (Outline
pane) . Το κείμενο θα έχει προσβασιμότητα από τα βοηθητικά μέσα τεχνολογίας  και θα διαβάζεται
με τη σωστή σειρά. Το Στυλ της γραμματοσειράς και οι ευθυγραμμίσεις (alignments) θα είναι σε
συμφωνία. Αν θελήσετε να αλλάξετε τη Διάταξη τότε θα χρησιμοποιήσετε πάλι τη παλέτα
Μορφοποίησης και το εργαλείο της Αλλαγής Διαφανειών (Change Slides tool). Αν σχεδιάζετε να
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εξάγετε τις διαφάνειες σε μορφή HTML τότε  κάθε διαφάνεια  πρέπει  να έχει τίτλο. Ο τίτλος
χρειάζεται για να δημιουργηθεί η λίστα με τους  συνδέσμους της κάθε διαφάνειας.

9.1.2  Τι δεν πρέπει να κάνεις στη   Διάταξη

Εικόνα 84.  Παράθυρο διαλόγου Εισαγωγής  Πλαισίου Κειμένου

Εικόνα 85. Μπάρα  εργαλείων σχεδίασης
  Μην εισάγετε πλαίσια κειμένου ή άλλα στοιχεία σε περιοχή που δεν είναι

προκαθορισμένη

Μην κάνετε
κλικ στο μενού
Text Box

Μείνετε μακριά από τα
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  Μην «παίζετε» με τα γράμματα της  γραμματοσειράς και  τα εργαλεία σχεδίασης για
να γράψετε το περιεχόμενο

Μην κάνετε χρήση εντολής  Εισαγωγής Πλαισίου Κειμένου ( Insert Textbox) για να θέσετε το κείμενο
σε περιοχές που δεν έχουν προκαθοριστεί. Θα παρατηρήσετε ότι το περιεχόμενο του Πλαισίου
Κειμένου (Textbox) δεν εμφανίζεται στο παράθυρο διάρθρωσης , με αποτέλεσμα να μην εμφανίζετε
στο εκτυπώσιμο περίγραμμα και να μην είναι ορατό από τους αναγνώστες οθόνης.  Αξίζει να πούμε
ότι τα μέσα  τεχνολογικής υποστήριξης όταν βλέπουν το περιεχόμενο του πλαισίου κειμένου  δεν το
διαβάζουν πάντα με τη σειρά που θα επιθυμούσατε. Η Σειρά Ανάγνωσης βασίζεται στη διάταξη των
πλαισίων κειμένου όταν δημιουργούνται και όχι όπως εμφανίζονται στη διαφάνεια. Η σημασιολογία
του περιεχομένου δεν έχει προσβασιμότητα από τα μέσα της τεχνολογικής υποστήριξης.

9.2 Διαγράμματα και Πίνακες

9.2.1  Τι πρέπει να κάνεις στα Διαγράμματα και στους Πίνακες

 Να απλοποιήσετε όλα τα διαγράμματα και τους πίνακες

 Να βάλετε σε ξεχωριστή διαφάνεια ή σε  ξεχωριστό αρχείο τα δεδομένα των
γραφημάτων, το κείμενο των διαφανειών, το πεδίο των σημειώσεων  ως πίνακα

 Οι πίνακες να  έχουν προσβασιμότητα

Εικόνα 86.  Γράφημα τριών μπαρών
Οι σύνθετοι πίνακες και  τα πολύπλοκα διαγράμματα είναι πολύ δύσκολο να διαβαστούν.
Προσπαθήστε να τα απλοποιήσετε όσο περισσότερο γίνεται. Αντί να εισάγετε εντυπωσιακά
διαγράμματα θα ήταν προτιμότερο να εισάγετε τα δεδομένα μόνα τους ή να  δώσετε στα δεδομένα
τη σύνδεση που θα έχει προσβασιμότητα  .
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9.2.2  Τι δεν πρέπει να κάνεις στα Διαγράμματα και στους Πίνακες

Εικόνα 87. Πολύπλοκο γράφημα τριών διαστάσεων
 Μην κάνατε πολύπλοκα διαγράμματα και πίνακες. Μην κάνετε υπερβολική χρήση

των γραφικών στα γραφήματα

Το εργαλείο Γραφήματος (Chart tool) προσφέρει πολλούς πειρασμούς. Αποφύγετε να κάνετε
υπερβολικά πολύπλοκα γραφήματα. Μην εισάγετε γραφικά εκεί που δεν είναι απαραίτητα. Η
προσβασιμότητα σε ένα περίπλοκο γράφημα είναι δύσκολη. Θα ήταν  πιο εύκολο ένας απλούστερος
τρόπος παρουσίασης των πληροφοριών.

9.3 Γραμματοσειρές

9.3.1  Τι πρέπει να κάνεις στις Γραμματοσειρές

 Οι γραμματοσειρές να έχουν μεγάλο μέγεθος

 Αν το περιεχόμενο δεν χωράει ή δεν  ταιριάζει σε μια διαφάνεια τότε δημιουργήστε
μια  δεύτερη διαφάνεια

Είναι καλύτερο τα μεγέθη των γραμματοσειρών να είναι μεγάλα. Έτσι θα μπορούν να διαβαστούν
από το ακροατήριο που βρίσκεται στη πίσω σειρά σε μεγάλη αίθουσα. Οι άνθρωποι με χαμηλή όραση
όπου και αν κάθονται θα έχουν πρόβλημα με τα γράμματα της παρουσίασης αν είναι μικρά. Το
πρόγραμμα του Ms Powerpoint  θα διαχειριστεί το μέγεθος των γραμμάτων μόνο του , αυτόματα, αν
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χρειαστεί να προσθέσετε  κείμενο σε διαφάνεια. Αν έχετε πολύ κείμενο σε μια διαφάνεια τότε πρέπει
να δημιουργήσετε μια δεύτερη διαφάνεια με  το «Μέρος 2»

9.3.2  Τι δεν πρέπει να κάνεις στις Γραμματοσειρές

  Μην «παίζετε» με το μέγεθος της γραμματοσειράς

 Μην αποδίδετε  τη έννοια  ενός κειμένου με  χρησιμοποιώντας το μέγεθος των
γραμμάτων

Εικόνα 88. Παλέτα Μορφοποίησης με  απαγορευμένα τα εικονίδια μορφοποίησης του κειμένου
Δεν χρειάζεται, αν δεν είναι απαραίτητο, να «παίξετε» με το μέγεθος των γραμμάτων της
γραμματοσειράς. Προσπαθήστε να κρατήσετε τα πίσω μέλη ενός ακροατηρίου ενεργά. Μην
προσπαθήσετε να αποδώσετε νοήματα με τη βοήθεια του μεγέθους των γραμμάτων της
γραμματοσειράς. Αν δεν υπάρχει μεγάλη διαφορά στις  κουκίδες (bullet points) μίας λίστας  τότε οι
αναγνώστες που βλέπουν θα το προσλάβουν ότι κάτι θέλει να πει ο εισηγητής ενώ  τα άτομα που
χρησιμοποιούν τη βοηθητική τεχνολογία δεν  θα καταλάβουν τη μικρή αυτή διαφορά.

9.4  Τι πρέπει και τι δεν  πρέπει να κάνετε με τα χρώματα
 Το χρώμα  και η  φωτεινότητα  κειμένου  -  φόντου να  έχουν αντίθεση

 Βεβαιωθείτε ότι έχετε κάποιο άλλο τρόπο  για να αποδώσετε τη σημασία του
κειμένου εκτός του χρώματος  του

 Να επιλέγετε χρώματα με χαμηλή αντίθεση
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 Να υποδηλώνεται  η   σημασία  μόνο με  χρώμα 

Είναι  σημαντικό να χρησιμοποιείτε τα χρώματα με σύνεση. Ένα κλασσικό λάθος είναι  να μην υπάρχει
καλή αντίθεση μεταξύ του κειμένου και του φόντου οπότε οι αναγνώστες με προβλήματα όρασης ή
με το πρόβλημα της αχρωματοψίας δεν θα είναι σε θέση να διαβάσουν το περιεχόμενο. Αν
χρησιμοποιείτε το χρώμα για να υποδηλώσετε τη σημασία περιεχομένου θα πρέπει να υπάρχει μια
άλλη μέθοδο επικοινωνίας  για αυτό. Οι άνθρωποι που δεν μπορούν να διακρίνουν τα χρώματα
κόκκινο και πράσινο πιθανότατα θα αντιληφθούν  ότι γράφεται με  κόκκινο να  μην γίνεται και ότι
γράφεται με πράσινο να γίνεται ενώ οι αναγνώστες με αχρωματοψία δεν θα καταλάβουν τη διαφορά.
Θα πρέπει οι αναγνώστες να είναι ενήμεροι για την αντίθεση των χρωμάτων  όταν επιλέγουν μια
διαφάνεια. Να επιλέγετε τα σχέδια των  διαφανειών να είναι σαφή με απλά γραφικά και στυλ
γραμμάτων.

9.5 Εναλλαγή Διαφανειών και Κίνηση

9.5.1  Τι πρέπει να κάνεις με την εναλλαγή των Διαφανειών και τη Κίνηση

  Περιορίστε τη χρήση κινουμένων εικόνων

 Περιορίστε τη χρήση εναλλαγής διαφανειών

 Περιορίστε τη χρήση κινουμένων εικόνων μεταξύ των στοιχείων μιας διαφάνειας

 Αν χρησιμοποιείτε την εναλλαγή των διαφανειών , επιλέξτε ένα απλό τρόπο
εναλλαγής όπως το Ξεθώριασμα (Fade)

Οι Κινήσεις (Animations) και οι μεταβάσεις (transitions) συμβάλλουν ώστε η παρουσίαση να μην
γίνεται βαρετή. Ωστόσο οι κινούμενες εικόνες και οι εναλλαγές διασπούν την προσοχή των χρηστών
και ειδικά αυτών που έχουν προβλήματα  γνωστικών διαταραχών.

9.5.2  Τι δεν πρέπει να κάνεις με την εναλλαγή των Διαφανειών και τη Κίνηση

 Μην συμπεριλαμβάνετε περιττές κινούμενες εικόνες μορφής  GIF

 Μην χρησιμοποιείτε σύνθετες μεταβάσεις μεταξύ των στοιχείων

 Μην χρησιμοποιείτε κινούμενες εικόνες για να αποδώσετε τη σημασία

 Κάντε τη παρουσίαση σας  ευχάριστη  με ηχητικά εφέ
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Εικόνα 89. Παράδειγμα κίνησης αντικειμένου
Βεβαιωθείτε ότι το περιεχόμενο είναι κείμενο (text). Τα
άτομα με αναπηρία δεν είναι σε θέση να αντιληφθούν τη
σημασία ενός περιεχομένου που γίνεται με κίνηση
(animation). Οι μεταβάσεις στα στοιχεία μιας διαφάνειας με
τη μορφή σφαιρών που ίπτανται (bullets flying) ή με το εφέ
του λέιζερ (laser text effect) δεν αποσπούν την προσοχή
αλλά αναγκάζουν τους αναγνώστες οθόνης να
επαναλαμβάνουν το διάβασμα της διαφάνειας από την
αρχή. Αν θέλετε να κάνετε την αποθήκευση της

παρουσίασης PTT σε μορφή  HTML , PDF ή QuickTime τότε  δεν θα γίνει 
στα περισσότερα από αυτά.

9.6 Εικόνες

9.6.1  Τι πρέπει να κάνεις με τις Εικόνες

  Να αποδοθεί  εναλλακτικό κείμενο σε όλες τις εικόνες και τις γραφικές παραστάσεις

 Για τα Windows : Μορφή > Εικόνα κάντε κλικ στη καρτέλα Web

  Για  το  Mac να χρησιμοποιήσετε ένα 3ου   εργαλείου  για να προσθέσετε
εναλλακτικό κείμενο 

 Να αλλάξετε το μέγεθος της εικόνας πριν την τοποθετήσετε

Εικόνα 90. Παράθυρο διαλόγου μορφοποίησης αντικειμένου με ενεργή τη καρτέλα Web
Όλες οι εικόνες και τα διαγράμματα πρέπει να έχουν εναλλακτικό κείμενο γιατί θα διαβαστεί αυτό
αντί της εικόνας. Πρέπει να είναι κατάλληλο και να αποδίδει το νόημα της εικόνας. Για να εισάγετε
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στα Windows  εναλλακτικό κείμενο , ανοίξτε το μενού Μορφή (Format)  και επιλέξτε Εικόνα(Picture).
Στη καρτέλα Web γράψτε το εναλλακτικό κείμενο. Στον Mac Os (Office 2004) δεν υπάρχει μέθοδος
για την εισαγωγή εναλλακτικού κειμένου. Οι χρήστες του Mac θα χρειαστεί να κάνουν χρήση  ενός
τρίτου εργαλείου όπως το LecShare για να προσθέσουν εναλλακτικό κείμενο. Αν δεν έχετε τη
δυνατότητα ενός τρίτου εργαλείου τότε να συμπεριλάβετε το νόημα που θα μεταφέρετε σε κείμενο
διαφάνειας ή σε ένα πεδίο σημείωσης (Note field). Πριν εισάγετε μεγάλες εικόνες  στο  Ms
Powerpoint προσαρμόστε το μέγεθος  με κάποιο πρόγραμμα όπως το Photoshop. Αυτό θα μειώσει το
μέγεθος της παρουσίασης και θα κάνει τη λήψη (download) της πιο γρήγορη.

9.6.2  Τι δεν πρέπει να κάνεις με τις Εικόνες

Εικόνα 91. Συμβουλή για να μην ξεχνάτε το εναλλακτικό κείμενο
Μην ξεχνάτε το εναλλακτικό κείμενο (ALT). Εικόνες χωρίς εναλλακτικό κείμενο είναι αόρατες στις
συσκευές υποβοήθησης.

9.7 Ήχος και Βίντεο

9.7.1  Τι πρέπει να κάνεις στον  Ήχο και στο Βίντεο

 Όλα τα ηχητικά αρχεία να υπάρχουν σε αντίγραφα

 Να υπάρχει συγχρονισμός των λεζάντων σε όλα τα βίντεο

 Η  περιγραφή του βίντεο πρέπει  να  είναι  κατάλληλη

Ο Ήχος και το Βίντεο πρέπει να έχουν εναλλακτικό κείμενο. Οι χρήστες με προβλήματα ακοής ή
νοητικές αναπηρίες χρειάζονται να  ακούν και να βλέπουν το βίντεο με  συγχρονισμένες τις λεζάντες
και τον ήχο. Σε μερικές περιπτώσεις η περιγραφή είναι πιο κατάλληλη από τις λεζάντες (captions) ή
τις μεταγραφές (transcripts). Να είστε προσεκτικοί με τα μεγάλα αρχεία ήχου (AV files). Θα ήταν πιο
φιλικό να γίνετε η σύνδεση των μεγάλων αρχείων ήχου AV  με το διαδίκτυο.
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Εικόνα 92. Παράθυρο  διαλόγου εκμάθησης του προγράμματος  Dreamweaver

9.7.2  Τι δεν πρέπει να κάνεις στον  Ήχο και στο Βίντεο

  Μην εισάγετε αρχεία AV χωρίς λεζάντες εκτός αν παρέχεται εναλλακτικό κείμενο για
προσβασιμότητα

Ειδικότερα αν το βίντεο πρόκειται να δημοσιευθεί η προσθήκη λεζάντων στο βίντεο να μην είναι
χρονοβόρα. Αν δεν έχετε τις λεζάντες  σκεφτείτε ένα τρόπο για να δοθεί το περιεχόμενο του βίντεο σε
όσους το θελήσουν. Και να θυμάστε ότι η επικαιρότητα είναι ένα μέρος της προσβασιμότητας. Το
περιεχόμενο με προσβασιμότητα πρέπει να είναι διαθέσιμο την ίδια στιγμή με το αντίστοιχο του χωρίς
προσβασιμότητα. Αν δημοσιεύσετε τη παρουσίαση σας στο WebCt, πρέπει να φροντίσετε  να είναι
διαθέσιμη  πριν το μάθημα. Αν χρειάζεται ένας μαθητής να  περιμένει  τότε δεν  ικανοποιεί το 508.

9.8 Τι πρέπει και τι δεν πρέπει να κάνετε με τις Σημειώσεις
  Μην  νομίζετε ότι οι χρήστες που δεν ακούν καταλαβαίνουν τι λέει ο παρουσιαστής

όταν μιλά δυνατά

 Να χρησιμοποιείτε το πεδίο Σημειώσεων (Notes Field) για  λεπτομέρειες πέρα της
μορφής του κειμένου με κουκίδες (bulleted text)

 Αν χρησιμοποιείτε την εγγραφή της αφήγησης τότε στο πεδίο Σημειώσεις να γράψετε
το σενάριο

Πόσες φορές έχετε κατεβάσει μια παρουσίαση την έχετε διαβάσει και ξέρετε τι έχει πει ο
παρουσιαστής της ;  Το περίγραμμα με κουκίδες μιας παρουσίασης δεν έχει νόημα αν δεν έχουμε
ακούσει τι έχει πει ο παρουσιαστής της. Το πεδίο των Σημειώσεων είναι ιδανικό μέρος για να γράψατε
αυτά που λέει ο παρουσιαστής. Χρησιμοποιήστε το πεδίο των Σημειώσεων για γράψετε τι θέλει θα
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λεχθεί στη κάθε διαφάνεια. Αν εκτυπωθούν οι Σημειώσεις της παρουσίασης τότε θα μπορούν οι
ακροατές να αναθεωρήσουν κάποια σημεία του περιεχομένου της. Αν κάνετε εγγραφή της αφήγησης
της παρουσίασης τότε οι σημειώσεις μπορούν να χρησιμοποιηθούν ως συγχρονισμένες  λεζάντες.

9.9 Συμπερασματικά και όχι μόνο
  Μην νομίζετε ότι μπορεί να γίνει το ίδιο σε  όλες τις παρουσιάσεις (Don’t assume

one size fits all)

 Να κάνετε την αποθήκευση του αρχείου  Ms Powerpoint σε πολλούς τύπους αρχείων
με δυνατότητα  προσβασιμότητας (multiple formats)

 Υπάρχει το εκπαιδευτικό υλικό LecShare

Εικόνα 93. Εικονίδια   προγραμμάτων  προσβασιμότητας
Μην έχετε το ίδιο  μέτρο για όλους. Αποθηκεύοντας τη παρουσίαση σε διαφορετικές μορφές
στηρίζετε τους ακροατές που έχουν διαφορετικές ανάγκες και τους διαφορετικούς τρόπους
μάθησης. Αν έχετε διαθέσιμη τη παρουσίαση στο ακροατήριο  από πριν θα το βοηθήσετε στη
προετοιμασία του. Το αρχείο PTT είναι ωραίο ως παρουσίαση  αλλά θα πρέπει οι ακροατές να έχουν
το πρόγραμμα Ms Powerpoint για να τη δουν. Η  αποθήκευση Web Page λειτουργεί για μερικές
παρουσιάσεις. Δεν είναι όλες οι μορφές κατάλληλες για προσβασιμότητα. Η μορφή PDF θα σας δώσει
πολλές επιλογές μορφοποίησης στις σημειώσεις, τα slides  και το περίγραμμα. Αποφεύγεται την
επιλογή Κάνε ταινία (Make Move) γιατί η ταινία δεν έχει προσβασιμότητα.  
Επιστροφή Τι πρέπει να κάνετε και τι δε πρέπει να κάνετε στη προσβασιμότητα στο PowerPoint


